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PLEASE CAREFULLY READ THIS LICENSE AGREEMENT BEFORE INSTALLING THE
SOFTWARE. BY INSTALLING THE SOFTWARE YOU AGREE TO THE TERMS OF
THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THE TERMS OF THIS
LICENSE AGREEMENT, YOU MAY OBTAIN A FULL REFUND OF YOUR PURCHASE
PRICE BY RETURNING THE SOFTWARE, THE USER GUIDE AND ALL PACKAGING
AND RELATED MATERIALS, TOGETHER WITH YOUR DATED PROOF OF
PURCHASE, WITHIN FIVE DAYS AFTER YOUR DATE OF PURCHASE TO THE
PARTY FROM WHOM YOU PURCHASED THIS SOFTWARE.
LICENSE AGREEMENT
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License. Gravic, Inc. ("Gravic") grants to you a non-exclusive license
(“License”) of each licensed copy of the Remark tm brand software
("Software") and User‟s Guide and related materials ("Documentation")
subject to the following conditions. This License continues until any violation
by you of any of the following conditions, in which event this License will
automatically terminate without notice from Gravic, and you will return to
Gravic or destroy all copies of the Software and Documentation. While you
own the physical disks and materials on which the Software and
Documentation are located, Gravic retains exclusive copyright, title and
ownership to and the right to periodically modify the Software and
Documentation. You agree to take all reasonable actions to protect the
confidentiality and Gravic's ownership of the Software and Documentation,
even after termination of this License. If you have licensed the Software and
Documentation on a Multiple License Basis as expressly provided by Gravic
on the Serial Number and Authentication Code Card (“Card”) which
accompanies delivery of the Software and Documentation, you may use the
Software disk to install up to the number of copies of the Software and
Documentation set forth on the Card and this License Agreement shall apply
independently to each licensed copy of the Software and Documentation. If
a Multiple License Basis is not expressly provided by Gravic on the Card, this
License Agreement shall apply to only one licensed copy of the Software and
Documentation.
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Permitted Uses. You may:
Use each licensed copy of the Software on a single personal computer at
a single location.
Use the Software and Documentation for your own personal or business
needs.
Make one backup copy of the Software (for your own protection) that
includes Gravic's copyright notice.
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Transfer each licensed copy of the Software to a single hard disk drive or
other permanent storage device for your own use.
Allow any one employee at any one time to use each licensed copy of the
Software and Documentation in your business.
Transfer all licensed copies of the Software and Documentation
(including all updates and all disks) to another individual or entity,
provided you retain no copies and the other party registers in advance
with Gravic as a user subject to the terms of this License Agreement.
Use the disks for the Software as provided above.
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Prohibitions. You may not:
Modify, adapt or alter the Software or Documentation.
Reverse engineer, disassemble, decompile, create derivative works or
merge the Software or Documentation into another software product.
Translate the Software or Documentation into another language or
format.
Operate each licensed copy of the Software at any one time on more
than one computer or allow use at any one time by more than one
individual.
Make the Software or Documentation available to anyone other than an
employee as provided under Permitted Uses.
Copy the Software or Documentation except to make one backup copy of
the Software and to transfer the Software to a single hard disk drive or
other permanent storage device.
License, sublicense, sell, transfer, distribute, publish, rent, lease, lend,
electronically transfer or communicate, use in a network, timesharing,
hosting or service bureau arrangement, interactive cable television,
computer service business, multiple central processing unit or multiple
user arrangement or otherwise make available or grant rights in the
Software or Documentation, except as expressly provided under
Permitted Uses.
Remove, alter or obstruct Gravic's copyright notices or trademarks on
the Software and Documentation.
Transfer the Software or Documentation in violation of this License
Agreement or applicable laws.

Use any trade secrets or proprietary information of Gravic contained in
the Software or Documentation, except for the Permitted Uses set forth
above.
4

Services. Subject to available resources, Gravic may provide maintenance
and support services (“Services”) without charge during the initial 30 day
period of this License, and thereafter upon request and payment of any
applicable fees by Licensee. All Services will be provided in accordance with
Gravic‟s standard policies and procedures.
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Limited Warranty. For a period of 30 days after your purchase of this
License, Gravic warrants that the Software disks and the Documentation
materials will be free from material physical defects under normal use, and
that the Software will perform in substantial conformity with the
Documentation. For a period of 30 days after performance of Services,
Gravic warrants that the Services have been performed in a professional
manner. Gravic does not warrant that the Software, Documentation or
Services will be error-free or that any error or non-conformity can be
remedied. The Software is not fault-tolerant and is not designed,
manufactured or intended for use with on-line control equipment or in
hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, aircraft navigation or communication systems,
air traffic control, life support machines, or weapons systems, in which the
failure of the Software could lead directly to death, personal injury, or
severe physical or environmental damage ("High Risk Activities"). Gravic
specifically disclaims any express or implied warranty of fitness for High Risk
Activities. THE ABOVE WARRANTIES ARE EXCLUSIVE. GRAVIC MAKES NO
OTHER WARRANTIES, ORAL OR WRITTEN, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
CONCERNING THE SOFTWARE, DOCUMENTATION OR SERVICES. ANY
WARRANTIES IMPLIED BY LAW SHALL BE LIMITED TO A PERIOD OF 30
DAYS AFTER PURCHASE OF THIS LICENSE OR AFTER PERFORMANCE OF
SERVICES, AS APPLICABLE. THIS LIMITED WARRANTY IS VOID IN THE
EVENT OF ANY VIOLATION OF THIS LICENSE AGREEMENT OR ACCIDENT,
ABUSE OR MISUSE OF THE SOFTWARE. Upon request by Licensee, Gravic
may provide Licensee with hardware and software manufactured or
developed by entities other than Gravic. Gravic makes no representations
or warranties with respect to such third party products and will have no
liability with respect to such products, but Gravic will assign to Licensee any
warranties made by the respective manufacturer or developer to the enduser of such products.
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Remedies. In the event of any failure of warranty as provided above within
the applicable warranty period, Gravic without charge will replace any
Software disk or Documentation materials having a material physical defect,
use its best efforts to correct any substantial non-conformity of the Software
with the Documentation, use its best efforts to re-perform any deficient
Services, or at Gravic's option, refund the purchase price for the Software
and Documentation or for the Services, as applicable. To receive the benefit
of these warranties for the Software and Documentation, you must submit
dated proof of purchase and the defective items to Gravic with a description
of the defect, and you must register your product with Gravic. THE ABOVE
REMEDIES ARE EXCLUSIVE. IN NO EVENT SHALL GRAVIC BE LIABLE FOR
ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES,
INCLUDING CLAIMS FOR LOSS OF DATA, USE OR REVENUES, WHETHER
ACTION IS BASED ON TORT, CONTRACT, STRICT LIABILITY, OR ANY OTHER
THEORY, EVEN IF GRAVIC HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN NO EVENT SHALL GRAVIC'S AGGREGATE LIABILITY
EXCEED THE PURCHASE PRICE FOR THIS COPY OF THE SOFTWARE AND
DOCUMENTATION OR FOR THE SERVICES, AS APPLICABLE.
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Other Rights. The above warranties give you specific legal rights, and you
may have other rights that vary from state to state. Some states do not
allow the exclusion or limitation of duration of implied warranties or the
exclusion of liability for incidental or consequential damages, so some of the
above exclusions and limitations may not apply to you.
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Registration. To receive the benefit of Gravic's warranty and user
announcement programs, you must register your product with Gravic to
confirm your agreement with the terms of this License Agreement.
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U.S. Government Restricted Rights. The Software and Documentation are
provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the
Government is subject to restrictions as set forth in subparagraph (c) (1)(ii)
of The Rights in Technical Data and Computer Software clause at 52.2277013. Contractor/manufacturer is Gravic, Inc. 301 Lindenwood Drive, Suite
100, Malvern, PA 19355 USA.

10 Governing Law. This License Agreement is governed by the laws of the

Commonwealth of Pennsylvania, and Licensee consents to the jurisdiction of
the federal and state courts located in Pennsylvania.
11 Entire Agreement. This License Agreement constitutes the complete

agreement between you and Gravic regarding the Software, Documentation
and Services. No other information, whether supplied by Gravic or its
dealers, distributors or representatives, may be relied upon, and any such
information is not a part of our agreement regarding the Software,

Documentation and Services. This License Agreement can be modified,
supplemented or amended only by a written instrument signed by you and
Gravic. If any provision of this License Agreement is unenforceable or
unlawful, the remaining provisions shall continue to be valid and
enforceable.
Should you have any questions concerning this License Agreement, or if you
wish to contact Gravic for any reason, please write: Gravic, Inc., 17 General
Warren Blvd., Malvern, PA 19355 USA.
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Disclaimer
The information contained in this document is subject to change without notice
and should not be construed as a commitment by Gravic, Inc., who assumes no
responsibility for any errors or omissions. Gravic, Inc. reserves the right to
revise this document and to make changes to the products described herein for
the purpose of product improvement at any time, without obligation to notify
any person of such revisions or changes.
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Notice
The information contained in this document is the exclusive property of Gravic,
Inc. This work is protected under United States Copyright Law and other
international copyright treaties and conventions. No part of this work may be
reproduced or transmitted in any form or by any means, electronic or
mechanical, including photocopying and recording, or by any information
storage or retrieval system, except as expressly permitted in writing by
Principia Products. All requests should be sent to: Gravic, Inc., 317 General
Warren Blvd., Malvern, PA 19355 USA. Attention: Product Manager.

Trademarks
Remark Web Survey, Remark Office OMR, Remark Classic OMR, Remark Quick
Stats, Gravic, Remark and Principia are registered trademarks and Remark
Live Stats is a trademark of Gravic, Inc. Other products mentioned are
trademarks of their respective holders.

Copyright
Copyright © 2015 Gravic, Inc. All Rights Reserved. Specifications subject to
change without notice.

About Gravic, Inc.
Gravic, Inc. is a world leader in providing innovative data collection, transformation,
and distribution solutions. For over 35 years, our software product groups have
produced technologically advanced solutions that improve the businesses and personal
lives of our over 75,000 customers and tens of thousands of OEM end-user licensees.
Gravic is a privately-held corporation located in Malvern, PA, near Philadelphia, PA USA.
Remark Products Group History
The Remark Products Group of Gravic, Inc. was founded as Principia® Products in
1991. We have worked in the area of image processing and pattern recognition since
the early 1980’s. Our early work in OCR and ICR sold thousands of licenses. In 1991,
we began to focus on OMR (optical mark recognition) with image scanners (Remark
Office OMR® 1.0 release). Our strength is in our ability to innovate and develop
solutions for common problems, while maintaining easy-to-use and affordable software.
In 2001, we renamed Principia Products, Inc. to Gravic, Inc. and began a merger of our
other entities (ITI and Compucon Services). We completed the merger in 2003 and now
all product groups are run by common management.
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Remark Web Survey Overview
Chapter 1

Remark Web Survey is a web form design program that allows you to create
web forms without needing to know HTML. The software runs on your own PC
and web server, giving you complete control over the creation, distribution and
collection of data for your web forms.
Using the Remark Web Survey software can be broken down into the following
procedures:
Creating a Remark Web Survey web form from scratch, or converting a
Remark Office OMR /Remark Classic OMR template into a Remark Web
Survey web form.
Modifying the web form until it meets desired needs.
Publishing the web form on your web server.
Collecting the data.
Analyzing the data in Remark Quick Stats , or optionally exporting the
data to the analysis package of your choice.

1.1 Remark Web Survey Components
The Remark Web Survey software has three components: a Designer
component, a Server component and Remark Quick Stats, an analysis
component. The Designer component is used to create the web forms, while the
Server component is a set of CGI scripts and Perl modules used to receive web
form responses and administer web forms. This user‟s guide focuses on the
Designer and Server components. Remark Quick Stats is covered in a separate
user‟s guide located in Start|Programs|Remark Web Survey 5|Documentation.

1.1.1 Designer Component Overview
Once the Remark Web Survey Designer component is installed, you may begin
creating web forms. You will prepare the web forms in the Designer component
so that they can be published on your web server. When creating web forms in
1
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the Designer component, we refer to the interface as the “design window.” The
Designer component contains three areas for displaying a web form.
1.1.1.a Tree View
The left side of the design window provides a tree view that displays the various
parts of a web form in a tree (pages, sections, questions, images, lines). These
parts of the tree are called elements. It is in this window where form elements
are added, deleted and modified.
1.1.1.b HTML Display
The right side of the design window displays the web form as it will appear in a
web browser. As changes are made to the form using the tree view in the
design window, the HTML Display updates to show the changes.
1.1.1.c Data Viewer
The Data Viewer contains a spreadsheet style grid for displaying the data
collected from the web form. You can automatically download data from your
web server or open a data file from this window. Remark Web Survey can then
analyze the data or you may export it to the analysis package of your choice.

1.1.2 Server Component Overview
A web server is a computer that is used to provide HTML files to a web browser.
Remark Web Survey runs on your own web server, which is set up
independently. Once a web form is created in the Designer component, the web
form is published to the web server with the Gravic-supplied server CGI scripts,
which comprise the Server component. The Server component provides a
control panel where you can set certain attributes on your web server, such as
where to store web forms, as well as view, download or remove data.
1.1.2.a Data Collection
The data collected from web forms are saved directly on your web server in a
proprietary format (.rwd). This data file can then be downloaded and exported
to other formats within Remark Web Survey. The data file contains one row of
data for each web form that is submitted. Each time a web form is completed
and submitted by a respondent, a row (record) is added to the data file. The
data can then be downloaded for the purpose of viewing and analyzing the
results. When downloading data, you are given the option to download the
entire data set, to download only the new submissions since the last download
or to download incomplete submissions. Data on the web server can be deleted
at any time in order to begin a new data file.
2
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1.1.3 General Information
There are two versions of Remark Web Survey 5: Standard and Professional.
The features from both versions are outlined in this user‟s guide. Features that
are only available in the Professional version of the software are designated as
follows:
(*Professional Version Only*)
If you have purchased the Standard version and are interested in upgrading to
the Professional version, you may contact our sales department (contact
information is on the back of this user‟s guide).
For clarification purposes, menu items and names of items taken directly from
the software interface are in bold throughout the user‟s guide whenever they
are used in an instructional context. In addition, there are tips throughout the
guide to assist you in with using the software. These tips are highlighted in
gray. We encourage you to perform the tutorial that you can find under the
Help icon in the software to get an overview of how the software works and
what it can do for you.

1.2 What is Included with your Software
Each purchase of Remark Web Survey includes the following:
One copy of the software on CD-ROM
One printed user‟s guide (*Professional Version Only*)
The user‟s guide is also available in PDF format from the Start menu
Two additional user‟s guides in PDF format (install with the software)
o

Remark Quick Stats user‟s guide

o

Remark Web Survey 5 Supported File Formats user‟s guide

30 days of free technical support from the date of purchase (see Section
1.5 for further details regarding technical support)

3
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1.3 New Features in this Version
Remark Web Survey 5 has many new features. The following list provides an
overview of what is new in this version. The specific sections of this user's guide
corresponding to the feature are listed in parentheses.
Email updates. Several updates were made to the email functionality:
o

Embed passwords in email. You can embed the respondents‟
passwords into the web survey invitation URL when using the
Remark Web Survey Email Center. Or, you can insert the
password, along with the respondents‟ name and/or username
into the body of the email (valid if the name/username is entered
in the Password List Builder). (Section 9.8)

o

Email templates. You can create and save email templates to
customize outgoing emails quickly and easily. (*Professional
Version Only*) (Section 9.8.1)

o

Email import. You can import email addresses that are stored in
a variety of database file formats, making it easier to pull in email
addresses in order to send invitations. (*Professional Version
Only*) (Section 9.8)

o

Canceling emails. You can cancel an email job once it has
begun.

Download incomplete submissions. You may download responses
even if the respondent did not complete the web form (e.g., partial
responses). (*Professional Version Only*) (Section 10.3.1)
Query parameters. You can specify a hidden textbox question as a
Query Parameter so that when you send invitations to take a survey, you
can insert a value that will be passed down to the data behind the
scenes. For example, if sending out a course evaluation, you can use
Query Parameters to insert the instructor‟s name into the email
invitation URL. When the web form is submitted, the instructor‟s name
will be included in the data set. (*Professional Version Only*) (Section
5.7.5.b)
Multimedia support. You can embed multimedia in a web form in the
following formats: avi, .mpg, .mpeg, .wmv, .wav, .asf, .mp3
(WindowsMedia), .mov (QuickTime), .ram, .rm (RealMedia), .swf
(ShockwaveFlash (*Professional Version Only*) (Section 5.6)

4
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Send response submissions based on responses. You can specify
web form submission email recipients based on how questions are
answered. For example, if on a survey about customer service a
respondent answers a question that s/he was dissatisfied, the customer
service manager could receive an email with that respondent‟s form
submission. (*Professional Version Only*) (Section 4.2.1)
Email responses to respondents. When responding to a web form,
respondents can enter an email address and have their responses sent
to them. (*Professional Version Only*) (Section 4.2.1)
Graphics as answer items. You can now use a graphic (JPG or GIF) as
an answer choice in the HTML Display portion of the answers (the part
the respondent sees). (Section 5.7.6.a)
Password protection updates. The following enhancements have been
made to password protection:
o

Stronger security has been added to the web server file
containing encrypted passwords.

o

You may automatically generate random passwords for
respondents in the Password List Builder. (Section 4.9)

o

A second question on the login page has been added to allow you
to enter a username along with a password. (Section 4.9)

Input patterns. You can specify an input pattern for a textbox question.
For example, if collecting US phone numbers, you could specify a pattern
of XXX-XXX-XXXX. When the page is submitted, the pattern entered will
be validated against the pattern defined for the question. Appropriate
error messages can be customized. (Section 5.7)
Data archive. When publishing a web form that already exists on the
web server, if you choose to overwrite the existing data file, a backup
copy will be created on the web server (you can control whether you
want this backup created in the Remark Web Survey control panel.)
(Section 9.5.1)
Question branching updates. (*Professional Version Only*) The
question branching feature (skipping questions based on previous
questions‟ answers) has been updated to include the following:
o

The "CONTAINS", "BEGINS WITH" and "ENDS WITH" conditions
have been added when creating question branches.

5
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o

The page number of the questions is visible in the list of
questions when creating question branches, making it easier to
select questions.

o

A branching validator has been added that will check the form for
branching problems, such as branches to deleted pages, circular
branching, etc. (Section 8.4)

o

A branch visualizer has been added to show branch patterns in a
more user-friendly interface, allowing you to quickly see where
each branch leads. (Section 8.5)

Mobile device preview. An option to preview the web form on various
mobile devices has been added, allowing you to better cater to the
handheld device user. (Section 3.1.2)
Control Panel overhaul. The Control Panel has been completely
recreated with a more user friendly appearance. It also includes a
Diagnostics section to help you troubleshoot server side problems.
(Section 9.3)
Control Panel Accounts. As part of the Control Panel overhaul, user
accounts were added. There are three levels: Administrator (full control),
Standard (access to Remark Live Stats and data) and Restricted (access
to Remark Live Stats and data for particular web forms) (Section 2.4.8)
Duration field. A duration field has been added to the web form data
grid so that you can see how long a respondent took to complete a web
form. It calculates the time when the respondent first accesses the web
form to the time when the web form is submitted (paused time is
included if applicable). In addition, a report was added to Remark Live
Stats™ to view the duration. (Section 11.3)
Email server updates. Several enhancements have been made to the
server settings, including:
o

Support to specify a local web server has been added. The Local
Machine settings are used to set up email transfers that originate
from the Remark Web Survey software, such as email invitations
and reminders. (Section 2.4.9)

o

The ability to use custom credentials when sending emails
through the local server. (Section 2.4.9)

o

Local emails are sent on a separate thread, allowing them to be
sent in the background while you continue using your computer.
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o

A throttle rate was added to determine how long to pause before
sending the next email in the queue, putting less strain on the
email server. (Section 2.4.9)

Completion percentage tolerance. You can filter data based on a
completion percentage in order to only analyze records that are X%
completed. This feature is used in conjunction with downloading
incomplete data submissions. (*Professional Version Only*) (Section
10.2.2.a)
IP tracking. You can choose whether to track IP addresses of web form
recipients in the log file in the Remark Web Survey control panel. When
tracking is turned off, the responses are truly anonymous. (Section 4.2)
Answer piping updates. (*Professional Version Only*) The following
enhancements have been made to answer piping (using a respondent‟s
previous answer in a subsequent label, question or answer):
o

You may use the respondent‟s name, username and email as
pipes throughout the web form (if these items are present in the
Password List Builder of the Login page). (Section 5.7.5.a)

o

You can add piping to the HTML Display portion of answer choices
(the part of the answer that the respondent sees when filling out
the web form). (Section 5.7.6.b)

o

You can update existing pipes when designing forms by clicking
anywhere within the pipe.

o

When creating answer pipes during web form design, the question
text will appear in the pipe structure, making it easier to read for
the web form designer.

Remark Quick Stats® updates. The following enhancements have
been made to Remark Quick Stats (same features as in Remark Office
OMR 7). See the Remark Quick Stats User‟s Guide.pdf file for further
details.
o

The ability to print, export and generate multiple reports has
been added to Remark Quick Stats in the form of a Report Batch
Wizard. Reports can be exported to a single combined file or
individually to separate files. Report batches can be saved and
reloaded.

o

The ability to auto-filter reports has been integrated into the new
Report Batch Wizard in Remark Quick Stats. You can select up to
three separate fields by which to break down data into separate
7
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reports. For each unique set of records, a new report set will be
generated automatically. For example, if you process course
evaluations, Remark Quick Stats can automatically separate each
instructor‟s results into individual reports.
o

Learning objectives/Analysis group names can be imported from a
database or spreadsheet format into the Grade Wizard/Survey
Wizard.

o

On the Crosstab Report, the correct answer is marked with an
asterisk when grading.

o

On the Item Statistics Report, you may sort the statistics by
question difficulty.

o

On the Condensed and Detailed Item Analysis Reports, you may
sort the results based on frequency.

o

Support for extra credit questions has been added through the
Grade Wizard. Extra credit questions do not count toward the
total points possible for the test, so any points scored on extra
credit questions are in fact "extra" and make it possible to score
over 100% on a test.

o

Report headers are now much more flexible and can be tied to
individual tests or surveys. You can now define report headers
within the Grade or Survey Wizard, allowing you to create and
reuse specific report headers that will always be used with that
particular test or survey.

New web form window. A new web form window was added to specify
details about the web form (number of pages, which special pages to
add, etc.) so that the entire web form framework is created at the
beginning of web form creation. (Section 3.1.4.a)
General formatting updates. The following updates have been made
to make formatting more flexible (many of these items can be found in
Chapter 7 by reviewing a list of the style properties by element):
o

Images used as buttons can be resized and their color can be
adjusted.

o

You may place vertical lines between section columns. (Section
5.2)

o

Textbox questions‟ answers utilize the style properties such as
backcolor, font color, etc., set up in the textbox attributes.

o

You can set a transparent color for rich text.
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o

Answers to questions can have line breaks within them to put the
answer text on more than one line. This feature is great for
anchoring answer scales.

o

Answers and questions can behave as hyperlinks. (Sections 5.7.5
and 5.7.6)

o

When setting up a hyperlink in a label on a Web Form Complete
or Popup Info page, you can specify whether to open the page in
the same window or a new window.

Table updates. Question tables have been updated to include the
following (see Chapter 7):
o

Entire tables can be left, center or right aligned.

o

Table border width and color can be adjusted.

o

Columns of questions in tables with more than one set of answers
can have separate background colors.

o

Table layouts can be reversed, with answer groups down the side
and questions across the top.

Drop-down lists. Drop-down lists have been updated to allow them to
be required so that pages cannot be submitted unless an answer is
chosen. In addition, a default answer choice can be selected so that
drop-down lists can truly be blank. (Section ).
Data saving options. The following updates have been made to data
saving:
o

The ability to open and save data to the Access and Excel 2007
formats has been added. (Section 10.12)

o

Remark Web Survey can save data directly to the SQL or Oracle
formats without having to go through an ODBC connection.
(Section 10.12)

o

You can save multiple data grids to a single data file. (Section
10.12)

Database lookup automatic reconnection. You can now reconnect a
web form to a database if the database is moved or renamed after
setting up database linking, eliminating the need to set up the entire
connection again. (Section 5.75)
Missing values. You can set a missing value designator at the question
level. (Section 5.7.5)
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Respondent detection. You can utilize more than one data grid when
running a Respondent Detection operation to determine who has filled
out your form. (Section 10.8)
Popup Info Pages. You can place Popup Info pages on Web Form
Complete pages in order to provide additional information or redirect
respondents.
Image enhancements. Tile, Center, Left and Right attributes are now
supported for images. You may also control the color used for an image
border. (Chapter 7)
“Other” textboxes can be required. When appending an “other”
textbox to a question, you can have the “other” textbox be required
when the answer choice for “other” is selected. (Section 5.7.6)
Integration with other Remark products. The integration with
Remark Office OMR and Remark Classic OMR has been improved:
o

When converting paper forms with multiple-choice questions in a
single OMR region/field, they will be converted into a table in
Remark Web Survey.

o

When using Database Linking, including the original lookup field is
now optional, just as in Remark Office OMR.

o

More seamless integration when opening data files generated
from one Remark product into a different Remark product.

1.4 Remark Office OMR and Remark Classic OMR
One of Remark Web Survey‟s unique features is its ability to work in conjunction
with Remark Office OMR and Remark Classic OMR. These software packages are
forms processing applications that transform information from paper-based
forms into data using scanners. Remark Office OMR and Remark Classic OMR
recognize filled in optical marks, such as bubbles and checkboxes, as well as
barcodes. The software uses template files to obtain information about a form,
including the areas of the form to be recognized and the output that should be
obtained from that form. The completed forms are then processed with a
scanner according to the template file. Data are collected from the forms and
displayed in a spreadsheet style grid. Once the data are collected and reviewed
for possible exceptions, the data can be exported to a database, survey design
or statistical package, or the Remark software can be used to tabulate or grade
the results.
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The Remark Web Survey software can convert Remark Office OMR and Remark
Classic OMR templates into Remark Web Survey forms so that the equivalent
paper-based form can be published on a website, allowing you to collect the
same data from two sources. After the data have been collected, they can be
combined in any Remark product and analyzed. See Appendix A for more
detailed information about using multiple Remark products together.

1.5 Technical Support
Remark Web Survey includes a user‟s guide and online help. You will also find a
knowledgebase on the Gravic website where you will find the answers to
frequently asked questions (see the back of this user's guide for the web
address). In addition, there is a tutorial available from the Help menu
,
which we strongly recommend you perform before using the software for your
web forms. Most questions can be answered by consulting these reference
materials.
If a problem with Remark Web Survey arises that cannot be solved using the
materials above, customers may contact Gravic‟s technical support.
Note: Gravic makes support available only to registered users of
the Remark Web Survey software who hold a valid support
agreement. If you are past your 30 days of free technical support
(starts from date of purchase), and need information about
purchasing a support agreement, please go to our website (address
provided on back of this user's guide).
Before contacting technical support, please gather the following information:
The version and serial number of the Remark Web Survey software
(you can find this information by opening a web form and then
looking at the HTML Display portion of the window while the web
form name is selected in the tree, or in the software‟s program
options, accessed from the Application Button
. In addition, if you
are using the Professional version of the software, the serial number
is listed on the back of your user‟s guide).
The steps required to reproduce the problem.
The type of web server on which the scripts are installed, if
applicable.
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If the issue is related to the Server component (e.g., the
administration of web forms or set up of the Server component),
access to the Remark Web Survey Control Panel (rwsad5.pl script) in
order to view the diagnostics information provided.
Gravic‟s technical support team provides product support to customers with
valid support agreements via email, phone, website and fax. Please see the
back of this user‟s guide for current contact information.

Installing the Software
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Chapter 2

This chapter provides the necessary instructions for installing Remark Web
Survey. The software consists of two components: the Designer component and
the Server component. The Designer component will run on Windows 2000 or
later (see below). It is installed on a Windows-based PC and is used to create
web forms. The Server component is comprised of six Perl scripts/modules and
an html folder for collecting data and administering forms, which are installed
on the web server. Installing the software involves the following steps (each
step is outlined in detail in this chapter):
1. Verify system requirements
2. Install the Designer component
3. Install the Server component scripts
4. Set/verify permissions on the server scripts
5. Set location for configuration files (optional)
6. Test script installation
7. Set up default form directory for storage of web forms
8. Setup user accounts
9. Set up server information in Designer component

2.1 System Requirements
2.1.1 Minimum System Requirements- Designer Component
The following section outlines the minimum system configuration for running
the Remark Web Survey Designer component. The designer portion of the
software can be installed on a Windows-based PC meeting the following
requirements.
Personal Computer with 1 GHz or faster processor
32-bit versions of Windows 2000 SP4, XP SP3, Server 2003 or Vista
Internet Explorer 6 or later (used for viewing forms as they are
created in the Designer component). Internet Explorer does not need
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to be your default web browser; it need only be installed and
configured for use on the system.
1 GB RAM
1 GB free fixed disk space
CD-ROM drive (for installation purposes)
Screen/monitor resolution of 1024x768 or higher and at least 32-bit
color
Mouse or other pointing device
Internet connection required for automatic form publishing and data
downloads

2.1.2 Minimum System Requirements- Server Component
The following section outlines the minimum system configuration for running
the Remark Web Survey Server component on Windows and Unix/Linux based
web servers.
A Unix, Linux or Windows based web server capable of running Perl
CGI scripts.
Perl 5.6.2 or later. (See www.perl.com or www.activestate.com for
information on obtaining a copy of Perl.) Version 5.8 is necessary if
you plan to use SMTP authentication when sending emails.
A qualified website administrator with root/admin access to the web
server.

2.2 Installing the Designer Component
To use Remark Web Survey, you must first install the Designer component on a
fixed drive containing a minimum of 1 GB of free disk space. The CD-ROM
contains the Remark Web Survey installation program.
To fully take advantage of Remark Web Survey‟s features, you need to have
Microsoft Internet Explorer 6 or later installed on your computer. Remark Web
Survey utilizes Internet Explorer to provide an HTML Display window as you
design web forms. This HTML Display window allows you to view your web form
as you are creating it, just as it would appear in a web browser. If you do not
currently have Microsoft Internet Explorer 6 or later installed, you will need to
install this program before installing Remark Web Survey. Note that
respondents submitting your web forms are not limited to using Internet
Explorer nor does it have to be your default web browser.
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To install the Remark Web Survey Designer component
Note: The Remark Web Survey CD-ROM contains an autorun
feature so that when it is inserted into your CD-ROM drive, the
installation will begin automatically. This feature is only available if
your CD-ROM drive‟s autorun feature is enabled.
1

Insert the Remark Web Survey CD-ROM into your CD-ROM drive.

2

Click Start on the Taskbar, click Settings and then click Control Panel.

3

Double click Add or Remove Programs.
Note: Accessing Add or Remove Programs may vary slightly based
on the Windows operating system you are using.

4

Click Install and then follow the on-screen instructions to install the
software.

5

When prompted, enter your serial number and authentication code for the
software. You can find these items on the registration card included with the
software or on the back of the user‟s guide (*Professional Only*).

6

After entering your serial number and authentication code, click the Next
button and follow the remaining on-screen instructions to complete the
installation.

2.3 Running Remark Web Survey
Use the following procedures to start and exit Remark Web Survey:

To start Remark Web Survey
1

If you chose to install a shortcut on your desktop during installation, double
click this shortcut. Otherwise, select Start from the taskbar.

2

Highlight Programs, highlight Remark Web Survey 5 and then click
Remark Web Survey 5 again.
Note: Accessing the installed programs may vary slightly based on
the version of Windows you are running.
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The About Remark Web Survey window displays. This informational window
remains for a few seconds while the program loads. When complete, the main
Remark Web Survey window displays.
The first time you run the software, it will check to see that the program options
have been updated to include pertinent web server information, including the
paths to the Server component scripts. These scripts are necessary to
administer web forms. Without this information, you will not be able to
successfully publish web forms or download data. We strongly recommend
entering all of the web server information into the Designer component‟s
program options before beginning to create web forms. See Section 2.4.9 for
more information.

2.4 Installing the Server Component
The following files make up the Remark Web Survey Server component. The
script files are written in Perl, which is a popular scripting language for CGI
scripts.
Script Name

Function

rwsad5.pl (administration
script)

Used to administer web forms, which
includes installing forms, downloading data
and resetting data. Also known as the
Admin Control Panel.

rws5.pl (data collection script)

Used to collect the data each time a web
form is submitted.

rwstest5.pl (test script)

Used to provide diagnostic information
about the web server running Remark Web
Survey.

rwsimg5.pl (image script)

Used to serve the web form‟s images onto
the HTML pages.

rwsutils5.pm (utilities script)

Contains the functions that the rwsad5.pl
and rws5.pl scripts use.

rwsem5.pm (encryption script)

Used for encryption of passwords on
password protected forms.
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Script Name

Function

rwsdir5.cfg

Used to change the default location of
script configuration files that are stored on
the web server.

html

Folder that resides on the web server and
contains supporting HTML files for the
Control Panel.

Warning: The rwstest5.pl script is only used for diagnostic
purposes. It should not be installed permanently on your web
server, as this poses a security risk should someone unintended be
able to access it. Only install the rwstest5.pl script when
troubleshooting the Server component or working with Gravic
support to resolve support issues. Remove the file from your web
server once the issues have been resolved.
During the installation of the Designer component, the Server component
scripts are installed to a Scripts folder in the Remark Web Survey installation
folder (e.g., C:\Program Files\Gravic\Remark Web Survey 5\Scripts). Your
website administrator will need access to these scripts in order to upload them
to the web server. Because each web server is different, it is very important
that someone with knowledge of your web server installs the Server component
scripts on the web server.
Installing the scripts involves uploading them to your web server‟s CGI
directory. A CGI directory is a standard directory on a web server that holds
scripts. Scripts are used to execute commands on the web server. In the case
of Remark Web Survey, scripts are used to administer web forms and collect
data from those same forms. Common names for CGI directories are cgi-bin,
cgi-local and scripts. However, you are not limited to these naming conventions.
The CGI directory should always be in a secure location on your web server that
is not publicly accessible.
Before installing the Remark Web Survey scripts on your web server, you need
to install the Perl scripting language version 5.6.2 or later. We recommend
installing the latest stable version of Perl (you will often find a stable release
version and a beta version). Note that Perl is a free download from
www.perl.com or www.activestate.com. When installing Perl, install the entire
package, including optional modules.
Once you have set up the CGI directory on your website and installed Perl, you
may continue with the installation of the scripts.
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The directions provided in this user‟s guide apply to in-house web servers as
well as hosted solutions. If you use an Internet Service Provider (ISP) to host
your website, they must have Perl installed and configured, as indicated in our
minimum system requirements, and you must have a CGI directory for
placement of the Remark Web Survey scripts. You will need to upload the
scripts to your CGI directory. You may need to get your hosting company
involved in order to set up the scripts properly for your web server‟s
configuration.
Tip: It is recommended that you perform all of the steps through
section 2.4.9 before users begin creating web forms.
Important Note: Web servers can be configured in different ways,
and IIS and Linux/Unix change periodically. These instructions are
current as of the time of the writing of this user‟s guide. Please note
that specifications may change over time. The instructions below
should be used as a guideline, keeping in mind that your setup may
vary slightly.

2.4.1 Upgrading from Previous Versions of Remark Web
Survey
If you are upgrading from a previous version of Remark Web Survey, you may
put the scripts in a new folder or in the folder with the existing scripts. The
benefit of using the existing folder is that you know the proper permissions are
set. If you use the same folder as previous versions, use caution when placing
the scripts. Do not overwrite any existing scripts. You may need to migrate web
forms over to the new version over time. Do not remove old scripts until you
have completely migrated over all web forms to the new version.
In addition, Remark Web Survey 4 and 5 use an HTML subfolder, which contains
files used by the Remark Web Survey Control Panel. The HTML folder must
reside in the same directory as the scripts. The HTML folders for the two
versions should be separate. When Remark Web Survey 5 is installed, the
scripts unpack to the scripts folder of the installation directory (e.g.,
C:\Program Files\Gravic\Remark Web Survey 5\Scripts) using the
recommended format for the web server: html\5. We suggest maintaining the
html\5 folder structure on the web server within the scripts/CGI directory to
keep the two sets of HTML files separate.
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2.4.2 Installing the Scripts on Windows Based Web Servers
(IIS)
At the time of this writing, there are three major Windows server options: IIS
5.0 (typically Windows Server 2000), IIS 6.0 (typically Windows Server 2003)
and IIS 7.0 (typically Windows Server 2008). To install the scripts on Internet
Information Services, you will need to first upload the scripts to the web server
and then set up appropriate permissions so that the scripts execute correctly.
These steps vary slightly depending on your version of IIS and are detailed in
the following sections.
2.4.2.a Installing the Scripts on Windows Server 2000 (IIS 5.0)
Installing the server scripts on IIS 5.0 involves placing the scripts on the web
server and then setting appropriate permissions.
Note: Using IIS 5.0 can vary slightly depending on the operating
system (screens, prompts, etc.). These directions apply to Server
2000.

To install the scripts on the web server
1

Upload the scripts (rwsad5.pl, rws5.pl, rwsimg5.pl, rwsem5.pm and
rwsutils5.pm) and html folder to the CGI directory on your web server in
ASCII format (not binary). Or place the files on the web server if you have
access to it internally.
Note: The logo.png file in the html folder should be uploaded in
Binary format if using an FTP program.

To configure the scripts directory
In order for Remark Web Survey to function correctly on your web server, your
web server‟s permissions need to be set correctly. Permissions must be set in
two locations: within the web server folders (e.g., C:\Inetpub\Scripts) and in
Internet Information Services. The permissions allow the software to install
the web forms you want your respondents to access and allow you to collect
and manage the data that you need.
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1

Open the Windows Control Panel (e.g., Start|Settings|Control Panel).

2

Select Administrative Tools, then Computer Management, then
System Tools, then Local Users and Groups and finally Users.

3

In Users, locate the name of the Internet Guest Account. The Internet
Guest account is the username under which the Remark Web Survey scripts
run.

4

Using Windows Explorer or My Computer, go to the folder containing the
scripts on the web server (e.g., C:\Inetpub\Scripts).

5

Right click the folder and choose Properties.

6

Click the Security tab.

7

Select the Internet Guest Account from the list.

8

If the Internet Guest Account is not present, use the Add button to add
the user using the information from Step 3; Windows provides you with
syntax examples. Select Check Names to ensure you have the correct
syntax.

9

Give the Internet Guest Account Modify, Read & Execute, List Folder
Contents, Read and Write permissions to the scripts directory (everything
except Full Control).

10 Click the OK button.

To set up Internet Information Services
You will also need to set up Internet Information Services (IIS) with the proper
permissions, which involves creating virtual directories. Please note that there
may be small differences in the names of items based on the version of IIS that
you are using.

1

From the Windows Control Panel, go to Administrative Tools|Internet
Information Services.

2

Locate and highlight the location of the web server. Within the folder select
the website on which you will be installing the Remark Web Survey scripts
(e.g., Default Website).

3

Right click on website name from Step 2 and select New|Virtual
Directory. The Virtual Directory Creation Wizard opens.
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4

Click the Next button to continue.

5

Provide a name for the new virtual
directory, giving it an Alias. Typically
you will use the same name as the
actual folder (e.g., scripts, cgi-bin,
etc.).

6

Click the Next button to continue.

7

In the Website Content Directory
window, click the Browse button to
locate the folder in which the scripts
are located.

8

Click the Next button.

9

Mark the options for Read, Run
scripts and Execute.

10 Click the Next button.
11 Click the Finish button. IIS is now

properly set up to run the Remark Web
Survey scripts.
Note: The config directory, which is controlled by the rwsdir5.cfg
file, must have permission to create and delete files in the scripts
folder. Please see Section 2.4.4 for more information about the
config directory and uploading the rwsdir5.cfg file.
You may skip to section 2.4.5 for further information about setting up the
Server component.

2.4.2.b Installing the Scripts on Windows Server 2003 (IIS 6.0)
If you are using Windows Server 2003 for the Server component of Remark
Web Survey, you will first need to install the scripts on the web server,
configure permissions and then set special parameters for Server 2003.
Note: Using IIS 6.0 can vary slightly depending on the operating
system (screens, prompts, etc.). These directions apply to Server
2003.

21

Remark Web Survey User’s Guide

To install the scripts on the web server
1

Upload the scripts (rwsad5.pl, rws5.pl, rwsimg5.pl, rwsem5.pm and
rwsutils5.pm) and html folder to the CGI directory on your web server in
ASCII format (not binary). Or place the files on the web server if you have
access to it internally.
Note: The logo.png file in the html folder should be uploaded in
Binary format if using an FTP program.

To configure the scripts directory
In order for Remark Web Survey to function correctly on your web server, your
web server‟s permissions need to be set correctly. Permissions must be set in
two locations: within the web server folders (e.g., C:\Inetpub\Scripts) and in
Internet Information Services. The permissions allow the software to install
the web forms you want your respondents to access and allow you to collect
and manage the data that you need.

1

Open the Windows Control Panel (e.g., Start|Settings|Control Panel).

2

Select Administrative Tools, then Computer Management, then
System Tools, then Local Users and Groups and finally Users.

3

In Users, locate the name of the Internet Guest Account. The Internet
Guest account is the username under which the Remark Web Survey scripts
run. If you do not see this user account, check with your network
administrator. IIS may need to be reinstalled.

4

Using Windows Explorer or My Computer, go to the folder containing the
scripts on the web server (e.g., C:\Inetpub\Scripts).

5

Right click the folder and choose Properties.

6

Click the Security tab.

7

Select the Internet Guest Account from the list.

8

If the Internet Guest Account is not present, use the Add button to add
the user using the information from Step 3; Windows provides you with
syntax examples. Select Check Names to ensure you have the correct
syntax.
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9

Give the Internet Guest Account Modify, Read & Execute, List Folder
Contents, Read and Write permissions (everything except Full Control
and Special Permissions).

10 Click the OK button.

To set up Internet Information Services 6.0
You will also need to set up Internet Information Services (IIS) with the proper
permissions, which involves creating virtual directories. Please note that there
may be small differences in the names of items based on the version of IIS that
you are using.

1

From the Windows Control Panel, go to Administrative Tools|Internet
Information Services.

2

Locate and highlight the location of the web server. Within the folder select
the website on which you will be installing the Remark Web Survey scripts
(e.g., Default Website).

3

Right click on website name from Step 2 and select New|Virtual
Directory. The Virtual Directory Creation Wizard opens.

4

Click the Next button to continue.

5

Provide a name for the new virtual
directory, giving it an Alias. Typically
you will use the same name as the
actual folder (e.g., scripts, cgi-bin,
etc.).

6

Click the Next button to continue.

7

In the Website Content Directory
window, click the Browse button to
locate the folder in which the scripts
are located.

8

Click the Next button.

9

Mark the options for Read, Run scripts and Execute.

10 Click the Next button.
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11 Click the Finish button. IIS is now

properly set up to run the Remark Web
Survey scripts.
Note: The config directory,
which is controlled by the
rwsdir5.cfg file, must have
permission to create and delete
files in the scripts directory.
Please see Section 2.4.4 for
more information about the
config directory and uploading
the rwsdir5.cfg file.

To set up special permissions for Windows Server 2003
1

Give the IWAM_<server name> account permissions. Using Windows
Explorer, add the IWAM_<server name> account to the CGI and Config
folders you have set up for Remark Web Survey. For the CGI folder, you will
need to set up Read access. For the Config folder you will need to set up
Modify permissions. Use the same methods as in To configure the scripts
directory on pages 22-23.

2

Create a new application pool. Create a new application pool named RWS
Scripts in the IIS administration panel.
To create the application pool, right
click Application Pools under the
website name in IIS and choose New,
then Application Pool.
On the Identity tab, change the
current RWS5 Scripts Application
Pool to IWAM_<server name>
under Configurable.

3

Allow Perl CGI extensions. In the Web
Services Extensions setup, allow Perl
CGI extensions.

After completing these steps, you should be able to run the Remark Web Survey
scripts. You may skip to section 2.4.5 for further information about setting up
the Server component.
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2.4.2.c Installing the Scripts on Windows Server 2008 (IIS 7.0)
If you are using Windows Server 2008 for the Server component of Remark
Web Survey, you will first need to install the scripts on the web server,
configure permissions and then set special parameters for Server 2008.
Note: Using IIS 7.0 can vary slightly depending on the operating
system (screens, prompts, etc.). These directions apply to Server
2008.

To install the scripts on the web server
1

Upload the scripts (rwsad5.pl, rws5.pl, rwsimg5.pl, rwsem5.pm and
rwsutils5.pm) and html folder to the CGI directory on your web server in
ASCII format (not binary). Or place the files on the web server if you have
access to it internally.
Note: The logo.png file in the html folder should be uploaded in
Binary format if using an FTP program.

To configure the scripts directory
In order for Remark Web Survey to function correctly on your web server, your
web server‟s permissions need to be set correctly. Permissions must be set in
two locations: within the web server folders (e.g., C:\Inetpub\Scripts) and in
Internet Information Services. The permissions allow the software to install
the web forms you want your respondents to access and allow you to collect
and manage the data that you need.

1

Open the Windows Control Panel (e.g., Start|Settings|Control Panel).

2

Select Administrative Tools, then Computer Management, then
System Tools, then Local Users and Groups and finally Users.

3

In Users, locate the name of the Internet Guest Account. The Internet
Guest account is the user name under which the Remark Web Survey scripts
run. Also locate and note the name of the IIS_USRS Group. If you do not
see this user account or group, check with your network administrator. IIS
may need to be reinstalled.

4

Using Windows Explorer or My Computer, go to the folder containing the
scripts on the web server (e.g., C:\Inetpub\scripts).
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5

Right click the folder and choose Properties.

6

Click the Security tab.

7

Select the Internet Guest Account from the list.

8

If the Internet Guest Account or IIS Users Group are not present, use
the Add button to add the user and group using the information from Step
3; Windows provides you with syntax examples. Select Check Names to
ensure you have the correct syntax.

9

Give the Internet Guest Account Modify, Read & Execute, List Folder
Contents, Read and Write permissions (everything except Full Control
and Special Permissions).

10 Click the OK button.

To set up Internet Information Services 7.0
You will also need to set up Internet Information Services (IIS) with the proper
permissions, which involves creating virtual directories. Please ensure that IIS is
installed with all CGI and ISAPI components.

1

From the Windows Control Panel, go to Administrative Tools|Internet
Information Services.

2

Locate and highlight the location of the web server. Within the folder select
the website on which you will be installing the Remark Web Survey scripts
(e.g., Default Website).

3

Right click on the website name from
Step 2 and select Add Virtual
Directory.

4

Provide a name for the new virtual
directory in the Alias box. Typically
you will use the same name as the
actual folder (e.g., scripts, cgi-bin,
etc.).

5

In the Physical Path window, click
the ellipsis (…) to locate the folder in
which the scripts are located.

6

Once you have the folder selected,
click the OK button.
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Note: The config directory, which is controlled by the rwsdir5.cfg
file, must have permission to create and delete files in the CGI
directory. Please see Section 2.4.4 for more information about the
config directory and uploading the rwsdir5.cfg file.

To set up special permissions for Windows Server 2008
1

Create a new application pool. Create a new application pool named RWS5
Scripts in the IIS administration
panel.
To add an application pool, right click
Application Pools and then click
Add Application Pool.
Enter RWS5 Scripts for the Name
and leave the rest of the default
options.
Set the new application pool as the
default for the website: Click the
website and then click Advanced
Settings in the right panel. Under
Application Pool, choose
RWS5 Scripts and then click
the OK button.

2

Allow Perl CGI extensions. In the
Web Services Extensions setup,
allow Perl CGI extensions. Select
the web site and then open ISAPI
and CGI Restrictions. You will
likely see three Perl options (which
may be untitled): double click each
one and then set the permissions to
Allowed.

After completing these steps, you should be able to run the Remark Web Survey
scripts. You may skip to section 2.4.5 for further information about setting up
the Server component.
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2.4.3 Installing the Scripts on Unix/Linux Based Web
Servers
To install the scripts on Unix/Linux web servers, you must have root admin
rights to the server. First upload the scripts and then set the appropriate
permissions.

1

Open the rwsad5.pl, rws5.pl and rwsimg5.pl scripts in a text editor such as
Notepad (one at a time).

2

If the location of the Perl compiler on your web server differs from the
default location pre-entered in the scripts, modify the first line of each script
to point to the location of the Perl compiler on your web server (e.g.,
#!/usr/bin/perl).

3

Save and close the scripts. Do not change the file extension from .pl when
saving the files.
Note: You may change the Perl scripts to a .cgi extension if your
web server associates this extension with Perl instead of .pl.
However, do not change any other part of the script name.

4

Upload the scripts and Perl modules (rwsad5.pl, rws5.pl, rwsimg5.pl,
rwsem5.pm and rwsutils5.pm), and the html folder to the CGI directory on
your web server in ASCII format (not binary). Or place the files on the web
server if you have access to it internally.
Note: The logo.png file in the html folder should be uploaded in
Binary format if using an FTP program.
Note: The config directory, which is controlled by the rwsdir5.cfg
file, must have permission to create and delete files. Please see
Section 2.4.4 for more information about the config directory and
uploading the rwsdir5.cfg file.

5

Set the appropriate file permissions for the scripts. The scripts require read,
write and execute permissions by the file owner, and read and execute
permissions for both the group and world levels. Often you can set these
permissions using an FTP program, or you can set them through the Unix
“chmod” command (e.g., “chmod 0755 rwsad5.pl rws5.pl rwsimg5.pl”).

6

Set the appropriate user for the scripts. The scripts should be owned by the
same username set up to execute scripts on your web server. In common
setups, this will already be the case, but it may be necessary to use the Unix
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“chown” command to change the file ownership (e.g., “chown userid
rwsad5.pl rws5.pl rwsimg5.pl”).
7

Set the appropriate group for the scripts. The scripts group should be the
same group name set up to execute scripts on your web server. In common
setups, this will already be the case, but it may be necessary to use the Unix
“chgrp” command to change the file‟s group (e.g., “chgrp groupid rwsad5.pl
rws5.pl rwsimg5.pl”).
Note: It is the website administrator‟s responsibility to secure the
directory in which the Server component scripts are installed
against unwanted access.

2.4.4 Configuration Files
The Remark Web Survey scripts store information in separate configuration files
in order to ensure proper security. The rwsad5.pl script (administration script)
writes information to a file called rwsad5.cfg. This file contains stored
information about your admin defaults and each installed web form. In addition,
the user information is stored in two files called rws5.cfg and rwsem5.cfg. These
configuration files are stored in the CGI directory of your website by default.
However, we recommend changing this location for maximum security. Keep in
mind that the new config directory should be a non-public directory. Note that
when you select a directory to use for the storage of config files, the scripts
must have permission to create and delete files as well as read and write access
to this directory.
The location of the configuration files is stored in a file called rwsdir5.cfg. It is
best to modify the configuration file that is located in the local Remark Web
Survey installation directory and then upload it to your web server.
Tip: If you forget the password for the Administrator account, you
can delete the rwsem5.cfg file from the scripts directory. This will
restore the Remark Web Survey Control Panel to its original
installation state, allowing you to set up a new password for the
Administrator account. Use the default password of rws when
prompted to select a password for the Administrator account.

To modify the location of the configuration files (optional)
1

Locate the rwsdir5.cfg configuration file in the Scripts folder of your Remark
Web Survey Designer software installation directory (e.g., C:\Program
Files\Gravic\Remark Web Survey 5\Scripts).
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2

Open the rwsdir5.cfg file in a text editor such as Notepad.

3

Enter the location of the directory in which you would like the configuration
files stored. Be sure to include the trailing slash (e.g., C:\Inetpub\config\ or
/web/www/config/).

4

Save the file. When saving the file, be sure to maintain its .cfg extension.

5

Upload or place the modified file in the CGI directory of your web server (the
same directory in which the scripts are installed).

The rwsad5.cfg and rws5.cfg files will now be created in the new directory.

2.4.5 Verifying the Script Installation
Once the scripts are installed on the server, you should test them to make sure
they are working properly.

1

Open a web browser and enter the location of the administration script as
the address (e.g., http://www.example.com/cgi-bin/rwsad5.pl). This is the
Remark Web Survey Control Panel.

2

The Remark Web Survey Remark Web Survey 5 Control Panel Setup
window appears. You use this window
to set up the password for the default
user, Administrator. Enter the
default password in the Password
box: rws.

3

Choose a new password and enter it
in the New Password box.

4

Re-enter the new password in the
Confirm Password box for
confirmation.

5

Click the Change button to change
the password.

6

You will receive a message that the
password was successfully changed,
indicating that the administration
script is functioning properly. Click
the OK button to return to the login
screen and then login with your new
administrator account. The initial
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login is for the “administrator.” You can also create other access accounts
(See Section 2.4.7). For the purposes of verifying script information, login
with the user name “Administrator” and the password you set in Step 3
above.
If you receive any other messages, the scripts are not installed properly. Please
verify that you have set the proper permissions for the scripts and the CGI
directory. Ensure that the scripts were uploaded to the web server in ASCII
format and that you inserted the path to the Perl compiler in the first line of
each script (for Unix/Linux servers only). See the next section for more
information about using Remark Web Survey‟s diagnostic test script for
troubleshooting.

2.4.5.a Remark Web Survey Diagnostics
If you encounter problems when installing/running the Remark Web Survey
Server scripts, you can run the diagnostics in the Remark Web Survey Control
Panel and/or the diagnostic test script called rwstest5.pl. These diagnostics
provide pertinent information about your web server setup, the Perl installation
and the script information.

To run the Control Panel diagnostics
1

Open the Remark Web Survey
Control Panel in a web browser
(rwsad5.pl) by entering its URL in
the address bar of the browser.

2

Login using the Administrator
account (or another account with
administrator privileges).

3

Select the Diagnostics tab.

4

Review the information provided
about the scripts in the first section.
Any errors/problems found will be
highlighted for you. You can also test
email functionality using the SMTP test area toward the bottom of the script.
If you need assistance interpreting the information provided, we recommend
you contact Gravic support, providing the URL to your rwsad5.pl script along
with a login so we can review the results.
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To run the Remark Web Survey test script
1

Open the Remark Web Survey Control Panel in a web browser (rwsad5.pl)
by entering its URL in the address bar of the browser.

2

Login using the Administrator account (or another account with
administrator privileges).

3

Select the Diagnostics tab.

4

Scroll to the bottom and click the button titled Access Test Script.

5

If Perl is installed and configured correctly, the script should execute and
display a wealth of information about your web server and the Remark Web
Survey scripts. Go to the end of the script to locate the Problem Report. In
addition, any problem areas are highlighted in red throughout the script.
Tip: An alternate way to run the test script is after installing the
Remark Web Survey Server component, enter the URL to the
rwstest5.pl script in a web browser (e.g.,
http://www.example.com/cgi-bin/rwstest5.pl). The test script
(rwstest5.pl) must be installed with the other scripts in your CGI
directory to perform this troubleshooting.
Note: If you need to contact the Gravic technical support group to
troubleshoot Server component issues, please have the Remark
Web Survey test script installed and be prepared to provide the URL
to support personnel if it is publicly available, or alternatively the
test script output if the URL is not publicly available.

2.4.6 Changing the Script Names
Some web servers require scripts to have a CGI extension (.cgi) instead of
Perl‟s standard .pl extension. If this is a requirement of your web server,
rename the scripts with a .cgi extension before posting them to your web
server. Do not change any portion of the name prior to the .pl extension.
Caution: Do not change any files that have .pm extensions.

2.4.7 Setting Up the Default Form Directory
Every time a web form is published to the web server, a folder is placed in the
Default form directory. This folder contains the HTML, images, multimedia
files, passwords, data, log and configuration files for the web form. The benefit
to this approach is that each web form has its own folder for storage of all files
related to that web form. For example, if the default form directory is
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C:\Inetpub\forms, each time a web form is published, a new folder will be
created in the C:\Inetpub\forms folder. In this example, if a web form is called
“satisfaction_survey” a folder called satisfaction_survey will be created in the
forms folder. The satisfaction_survey folder will contain the HTML pages of the
web form, any related image files, multimedia files, password information,
configuration file, the data and log files and, as the form is submitted, the
unique IDs of each respondent.
You should set up the default form directory before beginning to create and
administer web forms. Note that the data (rws5.pl) script will need to be able to
write data to this directory each time a form is submitted. Therefore, the default
form directory should be set up with permissions that allow the data script to
read, create, write and delete information. (Note: For IIS, the data script
typically runs under the Internet Guest Account.)
Caution: The Default form directory should be a non-public
directory for optimum security. The Remark Web Survey scripts
must be able to read and write information to and from this
directory.

To set up the Default form directory
1

Login to the Remark Web Survey
Control Panel (rwsad5.pl) using a
web browser and an account with
administrator privileges.

2

In the Server Setup window, in the
box titled Default form directory,
enter the path of the folder where
you would like all web forms to be
published. You have full control over
the path you choose. It can be any
location on your web server as long
as the Remark Web Survey scripts can read, write, modify and delete files in
this folder.

3

Click the Update button to save the new Default form directory.

The web server is now ready to begin accepting published web forms.
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2.4.8 Configuring User Accounts
Remark Web Survey 5 allows you to set up three different Server component
account types:
Administrator: This account has full control over the Server component
(can change settings, publish forms, download data, view logs, view
statistics, edit users, etc.). The default account is the Administrator
account and there can only be one account named Administrator. You
may, however, create different user accounts with administrator
privileges.
Standard User: This account only allows the user to view Remark Live
Stats and web form data when they login to the Remark Web Survey
Control Panel (rwsad5.pl script). In addition you can choose whether to
allow automatic form publishing and data downloading from the Designer
component for this account. If automatic form publishing and data
downloading are enabled, they can use these features for any web form
within the Designer component. In addition, if automatic data
downloading is enabled, the user will be able to download data from the
Control Panel.
Restricted User: This account only allows the user to view Remark Live
Stats information and web form data for specific forms when they login
to the Remark Web Survey Control Panel (rwsad5.pl script). In addition
you can choose whether to allow automatic form publishing and data
downloading from the Designer component for the specified forms for
this account. If automatic form publishing is enabled, the user can
publish any web form from the Designer component. If automatic data
downloading is enabled, the user can only download data from the
Designer component for the forms specified in their user account. The
user can also download data from the Control Panel for the specified
forms. Note that after a new web form is published, an administrator will
need to add that web form to the list of available web forms for the
restricted user.

To set up a new user
1

Login to the Remark Web Survey Control Panel (rwsad5.pl) using a web
browser and an administrator account.

2

Select the Users tab.

3

Click the Add User button.
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4

Enter the desired Username and
Password for the new user.

5

Determine the level of permissions
you want to grant to the user (see
description above): Administrator,
Standard User, Restricted User.

6

Once you choose a permission level,
determine whether you want the user
to be able to automatically publish
web forms and download data from
the Designer component. Mark the
Allow automatic publishing from
the Designer component and/or Allow automatic data downloading
from the Designer component checkboxes to grant this permission. If
users do not have these permissions, they will have to rely on another user
to publish web forms and download data.

7

Click the OK button to add the new user.
Note: Once users are added their username becomes lower case
text when you view it in the Control Panel. This is to create
compatibility with both Windows and Unix/Linux web servers. When
users login, the username is not case sensitive. However, the
password is case sensitive.

To edit a user
1

Login to the Remark Web Survey Control Panel (rwsad5.pl) using a web
browser and an administrator account.

2

Select the Users tab.

3

Select a user from the Users dropdown list.

4

Click the Edit User button.

5

[Optional] If you wish to change the
user‟s password, mark the checkbox
for Change Password. Then enter a
new password in the New Password
box.
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6

[Optional] If you wish to change the user‟s level of permissions, select the
appropriate level: (see description above): Administrator, Standard User,
Restricted User.

7

[Optional] If you wish to change the user‟s permissions for publishing web
forms and downloading data from the Designer component, check or
uncheck the Allow automatic publishing from the Designer
component and/or Allow automatic data downloading from the
Designer component checkboxes. If users do not have these permissions,
they will have to rely on another user to publish web forms and download
data.

8

Click the OK button to save the changes.

2.4.9 Setting up Server Information in the Designer
Component
Once the Server component is functional, you should enter the Admin and Data
Script URLs in the program options of the Remark Web Survey Designer
component. Once these URLs are entered, any new web forms that are created
will automatically include the proper URLs for form administration. This will
ensure proper form publishing and data downloading. If you plan to use the
email functionality of the software, it is also recommended that you set up the
email server settings in the Designer component.
Note: If this information is not entered into the Designer
component, the first time the software is run, you will be prompted
to enter the information. Please obtain the relevant information
from your website administrator (or the person who installed the
scripts).

To enter the script URLs in the Designer
Component
1

In the Remark Web Survey Designer
component, select the Application
Button
and then click the Web
Survey Options button.

2

Under Server details, enter the Admin
script URL and the Data script URL.
Both URLs must be fully qualified URLs.
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A fully qualified URL includes the http:// or https:// syntax (e.g.,
http://www.example.com/cgi-bin/rwsad5.pl).

To set up email settings in the Designer Component
In Remark Web Survey, emails can be used for three different functions: 1) the
built-in email client that is used to send web form invitations and reminders, 2)
submission notification emails that are sent every time a web form is completed
by a respondent, or 3) session pause page reminders to resume a web form
once it is started and stopped. You can use an SMTP server or a Sendmail
server to send emails from Remark Web Survey. These two types of setup are
simply different methods of sending email.
Note: The built-in email client for sending invitations and reminders
will only work with an SMTP mail server.
If your web server is configured to use a local Sendmail server, Remark Web
Survey can utilize the Sendmail server for sending submission emails or for
sending session pause page email reminders to respondents who have paused a
form in progress.
Setting up and configuring email servers is independent of Remark Web Survey.
Once you have determined the type of email method to use and verified your
server is working, you can configure Remark Web Survey to use it.

1

Continuing from Step 2 above, click the link titled Email settings.

2

Enter the Admin email address. This email address is often the webmaster
of the website, but can be any email
address of your choosing.

3

Under Email method and settings, first
select the Web Server tab. The Web
Server settings are used to set up email
transfers that originate on the web
server, such as pause page reminder
emails and respondent submission
emails.

4

Choose the type of email configuration
you are using: SMTP server or
Sendmail.
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5

If using SMTP, enter the SMTP server and the SMTP port. The SMTP port
is usually 25 but may vary with your email server. If authentication is
required, enter the Username and Password.

6

If using Sendmail, enter the Server path (e.g., /usr/sbin/sendmail).

7

Next, configure the local email settings. Under Email method and
settings, select the Local Machine tab. The Local Machine settings are
used to set up email transfers that originate from the Remark Web Survey
software, such as email invitations and reminders. Sendmail is not available
for Local Machine settings.

8

Enter the SMTP server and the SMTP
port. The SMTP port is usually 25 but
may vary with your email server.

9

[Optional] If desired, use a secure
connection by marking the checkbox for
Enable a secured (SSL) connection.
SSL encrypts data as it is transmitted.
Your SMTP server must be configured to
use SSL in order for this feature to work.

10 [Optional] If you need to use

authentication, you can enter credentials
or use those of the user. Mark the Use
the default credentials of the
currently logged in user checkbox to utilize the user‟s credentials (e.g.,
the person logged in when sending the emails from the Remark Web Survey
Designer component). Otherwise, continue to the next step to enter specific
credentials.
11 [Optional] If authentication is required, enter the Username and

Password.
12 Select the Throttle rate. The throttle rate adds a delay while sending

emails. The default setting is 500ms, meaning that one email will be sent
every 500 ms (in other words, two emails are sent per second). Throttling
emails keeps the SMTP server from being overloaded when sending large
numbers of emails.
13 Click the OK button to save the options.
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2.4.9.1 Email Server Authentication
Remark Web Survey can interact with email servers that have authentication
policies. The following information explains the various types of authentication
supported in Remark Web Survey and the requirements needed.
Important Note: Any of these types of authentication will only
work with mail servers set up properly to support them. You must
set up an SMTP server to accept the desired authentication before
that authentication will work with it. Setting up email servers and
authentication is outside the realm of Remark Web Survey.
2.4.9.1a CRAM-MD5
CRAM-MD5 authentication is an authentication algorithm using a challengebased MD5 encryption. The mail server issues a ticket when contacted, and the
relay uses the ticket to encrypt the password using an MD5 encryption. Then
the relay encodes the username and encrypted password into a base64
hexadecimal format.
This form of authentication requires the Digest:MD5 Perl module and the
MIME:Base64 Perl module, both standard in Perl 5.8.
2.4.9.1b Login
Login authentication is an authentication algorithm that uses base64 encoding.
The mail server prompts for both the username and the password, and they are
sent to the server encoded in a base64 hexadecimal format.
This form of authentication requires the MIME:Base64 Perl module, standard in
Perl 5.8.
2.4.9.1c Plain
Plain authentication is also an authentication algorithm that uses base64
encoding. The username and password are combined and encoded in a base64
hexadecimal format and then are sent to the mail server.
This form of authentication requires the MIME:Base64 Perl module, standard in
Perl 5.8.
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2.5 Uninstalling the Software
If you need to uninstall the software for any reason, use the Windows Control
Panel|Add or Remove Programs function.

To uninstall Remark Web Survey
1

Select the Start menu, click Settings and then click Control Panel.
Note: Accessing the control panel may vary slightly based on the
version of Windows you are running.

2

Select the Add or Remove Programs option.

3

Select Remark Web Survey 5 from the list and then click Remove.

4

Follow the on-screen instructions to complete the de-installation.
Note: When uninstalling the software, all program and default files
will be removed. Files that you have created will remain on the
system. However, it is recommended that you backup any forms,
data files, reports, etc., that you wish to keep prior to uninstalling
the software.

If you wish to uninstall the Server component, you may manually remove the
scripts and forms from the web server. Note that once web form files are
removed from the server, they are permanently removed. Removing individual
forms once they have run their course is covered in Section 9.7.
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Chapter 3

3.1 Understanding Remark Web Survey Windows
The Remark Web Survey
Designer component
interface consists of a split
window with a tree view on
the left side and an HTML
Preview on the right side . Tree View
The tree view displays the
elements of the web form
and is used to make
modifications to the web
form. The HTML Preview
window displays the form as
it will appear in a web
browser.
The HTML Preview panel can
be toggled with a Data
Viewer panel. The Data
Viewer panel displays a
spreadsheet style grid used
to view and analyze the
collected data. This chapter
will cover the tree view and
HTML Preview windows; the
Data Viewer tab will be
covered in Chapter 10:
Collecting Data.

HTML Preview

Data Viewer

Admin Control Panel Access

The bottom of the window
displays the Admin Control Panel Access bar. This area is used to login to the
administration script (rwsad5.pl) in order to publish web forms and download
data.
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3.1.1 Using the Application Button
The Application Button is the round button in the uppermost left hand corner of
the Remark Web Survey designer:
. It contains the Application Menu, which
consists of commonly used functions in the software. The following functions are
available by clicking the Application Button:
Function

Description

New

Starts a new web form. You may have multiple web forms
open at one time.

Open

Opens an existing web form or data, depending on whether
you are currently viewing the HTML Preview or Data Viewer
window.

Save

Saves the active web form or data, depending on whether
you are currently viewing the HTML Preview or Data Viewer
window. If the file already exists, it will automatically be
overwritten with what you see on the screen.

Save As

Saves the active web form or data, depending on whether
you are currently viewing the HTML Preview or Data Viewer
window, by opening a Save dialog. You may choose a file
name and a location in which to save the file.

Print

Prints the active web form.

Publish

Uploads the active web form to the web server.

Download

Downloads the active web form‟s data from the web server.

Close

Closes the active web form or data, depending on whether
you are currently viewing the HTML Preview or Data Viewer
window.

3.1.2 Using the Ribbon
The Ribbon is the bar across the top of the Remark Web Survey designer that
contains menu options. The Ribbon is segmented into tabs, where controls are
grouped together based on functionality. Click the tab at the top of the Ribbon
to access related functions.
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You can minimize and maximize the Ribbon by right clicking within it and then
choosing the appropriate item. When the Ribbon is maximized (the default),
meaning you can see all of the icons, choose Minimize the Ribbon to hide it.
When the Ribbon is minimized, you will only see the icons when you click a
menu item. The icons will minimize again when you perform another action.
When the Ribbon is minimized, first click a menu item to expand the ribbon
temporarily. Then right click within the Ribbon and select Maximize the
Ribbon.
The following Ribbon options are available:
Note: The following tables contain brief descriptions of each item as
it relates to the Ribbon. Full feature descriptions are found in
subsequent chapters of this user‟s guide.

Tab

Group

Function

Description

Home

Clipboard

Paste

Pastes the contents of the
Windows clipboard after
the current selection.

Cut

Cuts the current selection
to the Windows clipboard.

Copy

Copies the current
selection to the Windows
clipboard.

Delete

Deletes the selected item.

Find

Searches the active web
form‟s data for a word or
phrase.

Replace

Searches the active web
form‟s data for a word or
phrase and then replaces it
with another word or
phrase.

Select

Selects the active item.

Editing
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Tab

Group

Show

Function

Description

Insert Grid Row

Inserts a new grid row in
the Data Viewer.

Delete Grid Row

Deletes the selected grid
row(s) in the Data Viewer.

Auto Column
Width

Resizes the columns in the
Data Viewer so that they
fit the text within the cells.
This feature allows for
better readability of the
text within the data cells.

HTML Preview

Displays the HTML Preview
section of the window. The
HTML Preview displays the
web form as it will appear
in a web browser.

Data Viewer

Displays the Data Viewer
section of the window. The
Data Viewer grid displays
opened or downloaded
data for each web form.

44

Understanding Remark Web Survey Windows

Tab

Group

Function

Description

Formatting

Styles

Applies a style sheet to the
active web form. Click the
main style sheet button to
apply the last selected
style sheet. If you have
multiple style sheets
designed, click the down
arrow on the style sheet
button to choose from a
list of style sheets. To
create a new style sheet,
click the Dialog Box
Launcher in the right
bottom corner of the
Formatting section of the
Ribbon to open the Style
Sheet Editor. The dialog
box launcher looks like
this:

.

Move to Next
Column

Moves the selected item
one column to the right.
The section must have
multiple columns for this
feature to take effect. This
is a shortcut for moving
elements from column to
column.

Move to
Previous
Column

Moves the selected item
one column to the left. The
section must have multiple
columns for this feature to
take effect. This is a
shortcut for moving
elements from column to
column.
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Tab

Group

Function

Description

Insert

Divisions

Page

Inserts a new page on a
web form. Use the dropdown arrow to select a
page type. If you do not
click the arrow, a Standard
page is inserted. The page
is inserted at the bottom
of the expanded node in
the tree view.

Section

Inserts a section on a web
form. The section is
inserted at the bottom of
the expanded node in the
tree view. Sections hold all
of the other elements on
the web form (questions,
answers, labels, buttons,
multimedia, lines and
images).

Label

Inserts a label on the web
form. A label is used to
display user-created text.

Horizontal Line

Inserts a horizontal line on
the web form.

Image

Inserts an image on the
web form. Images can be
in the JPG, GIF or PNG
formats.

Multimedia

Inserts video and audio
files on the web form.
Supported formats
include: MPG, MPEG, AVI,
WMV, MOV, WAV, MP3,
RAM, RM. (*Professional
Version Only*)

Visuals
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Tab

Group

Function

Description

Interaction

Question

Inserts a question on the
web form. Question types
include Textbox/Text Area,
Checkbox (for multiple
responses), Option Button
(for single response
questions) and Drop-Down
Box (for multiple or single
response questions).
Click the down arrow on
the Question button to
insert a Question Table.
Question Tables group like
questions together in table
format.

Answer

Inserts an Answer choice
on the web form.

Button

Inserts a button on the
web form. Buttons can be
text or image based. The
button types are:
Submit/Next, Back, Reset
and Session Pause.

Note: Holding down the Shift key and then clicking any element to insert will
insert the element before the currently selected element. For example, if you
have two questions on your form and have the second question highlighted,
you can hold down Shift, go to the Insert tab and choose Line and the line
is inserted before the second question.
View

Show

Admin Control
Panel Access

47

Displays the Admin
Control Panel Access bar
at the bottom of the
window. This panel allows
you to login to the web
server and perform web
server functions, such as
publishing forms and
downloading data.
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Tab

Group

Function

Description

Show HTML
Layout Borders

Mark the Show HTML
Layout Borders option to
display light gray marks in
the HTML Viewer that
represent the HTML table
borders. As web forms are
built, the elements are
placed into tables behind
the scenes. These borders
will not be visible in your
published web form. Their
purpose is to show you
where elements are
positioned on the web
form. This feature is
particularly useful if you
are placing items in a
section with multiple
columns across the page.

Elements

Properties

Displays the properties for
the active element.

Tree
Representation

Display
Question Text

Displays the questions in
the tree view using the
question text. If your
question text is long, you
may wish to view the
elements by field name.

Display Field
Name

Displays the questions in
the tree view using the
field names.
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Tab

Group

Function

Description

Web

Browser

Refresh

Refreshes the HTML
Preview panel of the
design window so that you
can see changes. Note that
unless the Auto Update
HTML option is not
selected, the HTML
Preview will typically
update automatically.

Stop

Stops the current refresh
action on the HTML
Preview panel of the
design window.

Auto Update
HTML

When selected, the HTML
Preview window will
automatically update to
display changes made to
the web form. If not
selected, you will need to
manually refresh the HTML
window using the Refresh
button.
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Tab

Group

Launch

Function

Description

Scroll Element
into View

When selected, upon
clicking an element in the
tree view, the HTML
Preview will automatically
scroll so that you can see
the element that you have
clicked. In addition, when
clicking an item in the
HTML Preview, the tree
view will automatically
scroll to the same
element. Finally, double
clicking an item in the
HTML Preview will scroll to
the element in the tree
view and open the
properties window for that
element.

Control Panel

Opens the Remark Web
Survey Control Panel
(rwsad5.pl script) in a web
browser. The Control Panel
is used to set up server
side functionality and
administer web forms.
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Tab

Tools

Group

Analysis

Function

Description

Mobile Device
Preview

Allows you to preview a
web form on a mobile
device so that you can
ensure browser
compatibility. The mobile
device must have a web
browser capable of viewing
and submitting web forms.
You may select a device
from the list or create a
custom preview by clicking
Custom, adjusting the size
using the slider bars and
then selecting Preview
Device. Use this preview to
ensure that your web form
will display properly on the
targeted device. You may
need to adjust the width of
the web form to
accommodate mobile
devices.

Easy Survey

Launches Remark Quick
Stats, running an Easy
Survey tabulation.

Survey Wizard

Launches the Survey
Wizard for customized
survey tabulation.

Easy Grade

Launches Remark Quick
Stats, running an Easy
Grade operation.

Grade Wizard

Launches the Grade
Wizard for customized test
grading.
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Tab

Group

Function

Description

Validation

Spelling

Launches the Spell
Checker feature, which
allows you to proof the
web form for spelling
mistakes.

Database
Connections

When using the Database
Link feature to connect to
an external database and
pull information, click the
Database Connections
button to ensure the
connection is still active.
The software will report
any issues with connecting
to any specified databases
throughout the web form.

Branching

Click the Branching icon to
have Remark Web Survey
validate all of the branch
patterns on your web
form. If errors are found, a
report will be provided. In
addition, click the down
arrow on the Branching
icon to launch the Branch
Visualizer. This window
shows you all of the
branch patterns on the
form so that you can
ensure you have set up
your branch patterns
accurately.

Respondent
Detection

Launches the Respondent
Detection window where
you can view who has and
has not submitted your
web form (if using a Login
page).

Respondents
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Tab

Group

Data

Function

Description

Send Invitations

Launches Remark Web
Survey‟s built-in email
client, where you can send
email invitations and
reminders to participate in
your web form.

Sync with
Database

Allows you to locate the
appropriate database for a
question that uses the
Database Link feature.
This feature is useful when
you set up Database Link
but then later move the
linked database to a
different location and
Remark Web Survey can
no longer link to it
automatically.

3.1.3 Quick Access Toolbar
The Quick Access Toolbar provides easy
access to features that you commonly use.
You can add items to the toolbar to
streamline use of the software. The Quick
Access Toolbar is located at the top of the
Remark Web Survey window, next to the
Application Button and above the Ribbon tabs.

To customize the Quick Access Toolbar
1

Click the down arrow on the Quick Access Toolbar.

2

Click Customize Quick Access Toolbar….

3

In the Choose commands from drop-down list, select the group from
which you want to add a command.

4

Select the desired item from the list and then click the Add button.
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5

When you have added all of the desired commands, click the OK button. The
Quick Access Toolbar should now be updated with your selected commands.

3.1.4 Using the Tree View
The Remark Web Survey software provides a design window for creating web
forms. The web forms you create in the design window are broken down into
elements. These elements are represented in the left side of the design window
in a tree structure, often called a tree view. The tree view contains four basic
collections: the form collection, the page collection, the section collection and
the question collection. A collection is a group of items that are related. Each
collection consists of its own specific elements. The collections can be described
as follows:
Collection

Description

Form

Various page types are found in the form collection.
The page types are divided into Standard Pages
(basic web form pages) and Special Pages, which
include login pages, web form complete pages,
confirmation pages, session pause pages, popup info
pages and server error pages.

Page

The page collection contains the section collections,
which hold the remaining elements on the web form.

Section

The section collection contains the question
collections, as well as label elements, line elements,
multimedia and image elements. Buttons are also
stored in sections.

Question

The question collection contains the answer elements,
or the answers to each question on the web form.

Each collection and its respective elements are represented by what is called a
node. A node is a single form element, such as a page, section, question or
answer. Each type of element will be described in full detail in later chapters of
this user‟s guide.
The design window is where you make changes to your web form. You can
insert, delete, cut, copy, paste, drag, view, change or format elements. The
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elements are coded by symbols depicting the type of element: page, section,
label, question, answer, image, multimedia or line.
There are several sample web forms included with the Remark Web Survey
software. Gravic, Inc. recommends that you open a sample web form before
you start creating web forms so that you can better understand the design
window. Single page forms can be opened in the Standard or Professional
version of the software. Multi-page forms can only be opened in the Professional
version of the software.

To open a sample form
1

If not already running, start Remark Web Survey.

2

Select the Application Button
and click Open, or click
. Note that
Remark Web Survey lists any recently used forms as soon as your mouse
goes over Open.

3

In the Look in list, select the Program Files\Remark Web Survey
5\Sample Forms folder.

4

Select one of the sample files.

5

Click the Open button to open the web form.

3.1.4.a Beginning a New Web Form
There are two ways to begin creating a new web form:
1. Upon starting the software, display
the Welcome window (this option is
controlled in the software
preferences, which are accessible by
selecting the Application button,
,
then Web Survey Options and then
Show the welcome window at
startup). In the Welcome window,
mark the first option for Create a
new web form and then click the
OK button. Depending on your
settings, Remark Web Survey will startup with a new web form created,
ready for you to start adding elements (see Section 3.1.4.b) or with the
New Web Form window (see next page) .
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2. If Remark Web Survey is already
running, click the Application button,
, and then click New. Depending
on your program preferences, a new
web form will appear right away, or a
New Web Form window will appear.
If the New Web Form window does
not appear, you can go to section
3.1.4.b to learn how to start adding
elements. If the New Web Form
window does appear, you can set up
parameters for your web form before
it is created. The following options are available:
Option

Description

Web form name

Enter a unique name for the web form in the
Web form name box. Names cannot include
spaces or special characters: &,:/\?*><%|.
Try to keep web form names short, as they
will be part of the URL that you send to
respondents when you invite them to
participate in your web form.

Number of Standard
pages

Enter the number of Standard pages you plan
to include in the web form. Standard pages
hold the questions, images and other
elements of your web form. Type a number in
the box or use the arrows to move up and
down sequentially. (See Section 4.4 for
detailed information about Standard pages.)

Include a login page

Mark the Include a login page checkbox to
add a Login page that will allow you to set up
password protection on the web form. (See
Section 4.5 for detailed information about
Login pages.)
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Option

Description

Include a session pause
page

Mark the Include a session pause page
checkbox to add a Session Pause page that
will allow respondents to pause a live web
form and resume it at a later time without
losing any data. (See Section 4.6 for detailed
information about Session Pause pages.)

Include a response
confirmation page

Mark the Include a response confirmation
page checkbox to add a Response
Confirmation page that will allow respondents
to view or print all of their responses prior to
submitting the web form. (See Section 4.7
for detailed information about Response
Confirmation pages.)

Style

Use the Style drop-down list to select a style
for the web form. Styles are set up using the
Style Properties window (see Chapter 7 for
detailed information about creating styles).

Show this window when
creating a new web form

Mark the Show this window when
creating a new web form checkbox to
always have this window appear when you
select the Application button and then choose
New. If this checkbox is not selected, when a
new web form is created, the software will
automatically create the necessary tree view
structures with one Standard page, one Web
Form Complete page, and the default style,
and you can then begin adding elements to
the web form.

Note: To control whether you see the New Web Form window,
select the Application button, click Web Survey Options and then
mark the checkbox for Show new web form window when
creating a new web form.
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3.1.4.b Inserting and Viewing Elements
Each element included in the web form will be visible in the tree view structure.
Sections are sub-nodes of page nodes, questions are sub-nodes of section
nodes and answers are sub-nodes of question nodes. If there is a white expand
icon located to the left of an element, this designates that there are additional
levels under that particular node. If there is a black collapse icon next to an
element, this designates that the node has been expanded as far as it can go.
You can click the expand icon to open (enlarge) an item and click the collapse
icon to close (shrink) an item.
When you want to insert an element onto your web form, go to the Insert tab
in the Ribbon and then select the item you wish to insert. The item will be
inserted below the currently selected item. If you are on a Section node, the
element will be inserted at the bottom of the section. Alternatively, you may
right click an element in the tree and choose Insert or Insert Before to insert
elements.
You may double click any node to view its properties. Alternatively, right click a
node and then select Properties. Finally, you may highlight a node and then go
to the View tab in the Ribbon and select Properties.
Note: Each element type (e.g., question, answer, image, etc.) is
covered in detail in Chapter 5.)

3.1.5 Viewing the Form
The design window provides an HTML Preview for seeing your web form as it
will appear in a web browser. In order for the HTML Preview window to be
visible, you must have Microsoft Internet Explorer 6 or later installed, as
outlined in the minimum system requirements (see Section 2.1 for further
details). As changes are made using the tree view, the HTML Preview is updated
automatically (you may also click the Refresh button on the Ribbon bar). If you
prefer not to have the HTML Preview update automatically (e.g., if you are
working with a very large form), you may turn it off on the Web tab in the
Ribbon.

To access the HTML Preview
1

With a web form open, go to the status bar, located in the bottom right
corner of Remark Web Survey, which is called View Controls.
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2

Click the
button, HTML
Preview. Alternatively, go to
the Ribbon and select Home.
Click the HTML Preview Ribbon

button

.

The data viewer window will change
to the HTML Preview.

3.1.6 Viewing the Data
The design window provides a Data Viewer to view opened or downloaded data.
The Data Viewer displays the data in a spreadsheet-style grid, where each
column represents a question on your web form and each row represents one
respondent‟s responses to your web form. The column headers are taken from
the field names defined for each question when the questions are created.
Note: When the Data Viewer contains data you may not edit
elements in the tree view.

To access the Data Viewer
1

With a web form open, go to the
bottom right corner of the status
bar, which is called View
Controls.

2

Click the
button, Data
Viewer. Alternatively, go to the
Ribbon and select the Home
tab. Click the Data Viewer

button,

.

The HTML Preview window will change to the Data Viewer.
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3.1.7 Tooltip Text and Descriptions
Most windows in Remark Web Survey employ tooltip text and descriptions. If
you hover your mouse over an item, tooltip text will appear. Or, in some
windows, look at the bottom panel of the window
to see a description of what you have selected
(e.g., the Style Properties window). Additionally,
you will find that some textboxes include
explanatory watermark text to show you the type
of information you are expected to enter. Finally,
use the Web Form Details pane in the design
window to see details about active items. The Web
Form Details area is located underneath the tree
view. The Web Form Details pane also shows you
general details about your web form, such as the
link to take the form and a link to copy the form
URL to the Windows clipboard (this link is useful if
you want to paste the URL into an email, for
example). When a question is selected the Web
form details area will provide pertinent property
information so that you do not have to open the
Properties window to see basic information. You
can optionally close the Web Form Details window by clicking the double arrow
in the upper right corner of the window. When the arrows are pointing down,
you can collapse the window. When the arrows are pointing up, you can expand
the window.

3.1.8 Admin Control Panel Access
The Admin Control Panel Access bar is where you login to the web server to
publish web forms and download data.

If it is not visible, you can view it by either clicking the expandable splitter
at the bottom of the design window or by clicking the View tab in
the Ribbon and checking the box titled Admin Control Panel Access under the
Show options.
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In order to login to the administration script (rwsad5.pl), you will need to have
its URL entered in the web form‟s properties. It is advisable to have this
information entered into the software‟s program options so that you do not
have to keep entering it for every new web form (see Section 2.4.9). You will
also need a username and password for the rwsad5.pl script (also referred to as
the Remark Web Survey Control Panel) that allows you to publish web forms
and/or download data. Your webmaster or the person who installed the Remark
Web Survey scripts should be able to provide this information to you. The
Admin Control Panel is covered in greater contextual detail in Section 9.3 and
creating user accounts is covered in Section 2.4.8.

3.1.9 Printing the Form
You may print web forms from the Designer component. Printing forms can be
useful for proofreading or distributing to others for review prior to publishing.
Note: If you are using Remark Web Survey in conjunction with
Remark Office OMR/Remark Classic OMR and plan to scan paper
forms in addition to publishing them online, printed web forms from
Remark Web Survey are not suitable for scanning. The equivalent
paper form must be created in another package (e.g., a word
processing package). If you already have a printed version of the
form and have created a Remark Office OMR or Remark Classic
OMR template, you may convert the template to a web form in
Remark Web Survey.

To print a form
1

If not already open, open the web form in Remark Web Survey by selecting
the Application Button

, then click Open, or click

.

2

Select the Application Button and then choose Print from the menu.

3

You have options to print the active page or the entire web form.

4

Make the necessary selections from your printer‟s dialog window.
Note: Printers spool pages in different ways. Sometimes smaller
HTML pages will print faster (before) larger pages, even if you sent
the larger page to the printer first. Also, if printing in duplex mode
(both sides of the paper), each HTML page will start on a new page.
If one HTML page spans more than a single side of a sheet of paper,
it will print on the backside.
61

Remark Web Survey User’s Guide

62

Remark Web Survey Form Elements
Chapter 4

4.1 Overview
When you design a web form in Remark Web Survey, you start at the form
level, add pages, add sections and then add elements, such as questions,
answers, labels, images, multimedia and lines.
The highest level of a Remark Web Survey web form is the web form level. This
level is called the form collection. The form collection consists of several
properties related to the overall web form as well as all of the pages on the web
form.

4.2 Web Form Properties
At the web form level, there are many properties that can be set that pertain to
how the overall web form functions. Many features are optional, but allow you
to customize the functionality of your web form.
The web form properties can be accessed in any one of three ways:
Double click the node that reads Web Form – Form Name.
Right click the node that reads Web Form – Form Name and choose
Properties from the menu.
Click the node that reads Web Form – Form Name and choose
Properties from the View tab in the Ribbon.
The web form properties are outlined in the following table:
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Tab

Heading

Name

Description

General

Basic
Settings

Web form
name

A name for the web form. Names
cannot include spaces or special
characters: &,:/\?*><%|@. Try
to keep web form names short,
as they will be part of the URL
that you send to respondents
when you invite them to
participate in your web form.

Admin script
URL

The URL (path) to the Remark
Web Survey Administration
Script (rwsad5.pl). This script is
posted on the web server and is
necessary for web form
administration. Your webmaster
or the person who installed the
scripts should be able to provide
this URL to you. This script is
also referred to as the Control
Panel when it is accessed in a
web browser. The Admin script
URL must be a fully qualified
URL (e.g.,
http://www.example.com/cgibin/rwsad5.pl).

Data script
URL

The URL (path) to the Remark
Web Survey Data Script
(rws5.pl). This script is posted on
the web server and is necessary
for web form data collection.
Your webmaster or the person
who installed the scripts should
be able to provide this URL to
you. The Data script URL must
be a fully qualified URL (e.g.,
http://www.example.com/cgibin/rws5.pl).
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Tab

Heading

HTML
Display

Name

Description

Data file
name

A name for the data file that is
stored on the web server for a
web form. Note that the data
files for each web form are
stored in separate folders for
every published web form.
Therefore, customizing the file
name is optional. The default
data file name is MyData.

Log file
name

A name for the log file that is
stored on the web server for a
web form. Log files track
respondent information, such as
time and date of web form
submission, IP address, login
information, etc. Note that the
log files for each web form are
stored in separate folders for
every published web form.
Therefore, customizing the file
name is optional. The default log
file name is MyLog.

HTML
display
language

The language in which the HTML
is displayed on your published
web forms. The language
selected here is specified in the
HTML source code of web forms
that you create (this is called a
“lang” tag in HTML). Please note
that whether the language‟s
characters display correctly is
dependent upon the character
set specified on the respondents‟
computer.
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Tab

Heading

Progress
indicator
settings
window

Name

Description

Display
progress
indicators on
pages

When selected, a progress
indicator appears on each page
of the web form to show
respondents how much of the
web form they have completed
at any given time. Note that
progress indicators cannot be
used when you are using the
page randomization feature.
(*Professional Version Only*)

Progress
indicator
settings

The Progress indicator
settings link allows you to
customize the look and
positioning of the progress
indicator.

Display
progress
caption

Displays a caption for the
progress indicator (e.g., “50%
complete”).

Horizontal
alignment

Displays the progress indicator
on each page in left, center or
right alignment.

Vertical
alignment

Displays the progress bar at the
bottom or top of each web form
page.

Progress
forecolor

Select a color for the forecolor
(front) of the progress indicator.

Progress
backcolor

Select a color for the backcolor
(background) of the progress
indicator.
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Tab

Heading

Name

Description

Submission
notifications

Send email
notifications
on
respondent
submissions

Mark the Send email
notifications on respondent
submissions checkbox to set up
email notifications every time the
web form is submitted on the
website. The recipient(s) listed
will receive an email message
containing the responses for
each web form submission.

Email
settings

Click the Email settings link to
enter email settings for web form
submission notifications.

Admin email
address

Enter the web form administrator
email address (e.g.,
webmaster@example.com). This
email address will be listed as a
point of contact if a respondent
receives an error when filling in
your web form.

Recipient
addresses

Respondent submissions are sent
to the email addresses entered in
Recipient addresses. Separate
multiple email addresses with a
semi colon (;).

Advanced
Notification
Criteria

Click the Advanced
Notification Criteria link to set
up email alerts based on how
specific questions are answered.
See Section 4.2.1 for more
detailed information.
(*Professional version only*)

Email
settings
window
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Tab

Heading

Name

Description

Web Server

Use SMTP
method to
transport
email
messages

The Web Server settings are
used to set up email transfers
that originate on the web server,
such as pause page reminder
emails and respondent
submission emails. Mark the Use
SMTP method to transport
email messages option to use
Simple Mail Transport Protocol
(SMTP) for sending notification
emails. You need to have a valid
SMTP server set up outside of
Remark Web Survey. Once the
SMTP server is functioning, the
SMTP server information can be
set up in the Remark Web
Survey program options by your
website administrator (see
Section 2.4.9 for further details).
Please note that your website
administrator can advise you on
what email method you are to
use.

SMTP Server

Enter the SMTP server address
(e.g., mail.example.com).

SMTP Port

Enter the SMTP port that email
transfers use (typically port 25).

Username

If using authentication, enter a
valid username.

Password

If using authentication, enter a
valid password for the username
specified.
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Tab

Heading

Name

Description

Use
Sendmail
method to
transfer
email
messages

Mark the Use Sendmail
method to transfer email
messages option to use
Sendmail for sending notification
emails. Sendmail is an open
source email transfer agent. You
need to have Sendmail set up
outside of Remark Web Survey
to use this feature. Once the
Sendmail functionality is
working, the Sendmail
information can be set up in the
Remark Web Survey program
options by your website
administrator (see Section 2.4.9
for further details). Please note
that your website administrator
can advise you on what email
method you are to use.

Server path

Enter the Sendmail Server path
(e.g., /usr/sbin/sendmail).
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Tab

Heading

Name

Description

Local
Machine

Use SMTP
method to
transport
email
messages

The Local Machine settings are
used to set up email transfers
that originate from the Remark
Web Survey software, including
email invitations and reminders.
Sendmail is not available for
Local Machine settings. Mark the
Use SMTP method to
transport email messages
option to use Simple Mail
Transport Protocol (SMTP) for
sending notification emails. You
need to have a valid SMTP server
set up outside of Remark Web
Survey. Once the SMTP server is
functioning, the SMTP server
information can be set up in the
Remark Web Survey program
options by your website
administrator (see Section 2.4.9
for further details). Please note
that your website administrator
can advise you on what email
method you are to use and the
proper settings.

SMTP Server

Enter the SMTP server address
(e.g., mail.example.com).

SMTP Port

Enter the SMTP port that email
transfers use (typically port 25).

Enable a
secured
(SSL)
connection

Mark the Enable a secured
(SSL) connection checkbox to
transmit information over Secure
Sockets Layer (SSL), which
provides security and data
integrity for communications.
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Tab

Heading

Name

Description

Use the
default
credentials
of the
currently
logged in
user

If you need to use
authentication, you can enter
credentials or use those of the
user. Mark the Use the default
credentials of the currently
logged in user checkbox to
utilize the user‟s credentials
(e.g., the person logged in when
sending the emails from the
Remark Web Survey Designer
component). Otherwise, continue
below to enter specific
credentials.

Username

If using authentication, enter a
valid Username.

Password

If using authentication, enter a
valid Password for the
username specified.

Throttle
Rate

The Throttle rate adds a delay
while sending emails. The default
setting is 500ms, meaning that
one email will be sent every 500
ms (in other words, two emails
are sent per second). Throttling
emails keeps the SMTP server
from being overloaded when
sending large numbers of emails.

Synchronize
Settings

Synchronizes the local server
settings with what was defined
for local server settings in the
Remark Web Survey program
options. The program settings
override the web form settings.
This is a quick way to pull down
the settings from the program
options.
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Tab

Heading

Name

Description

Access &
Availability

Session
timeouts
and web
form
availability

Enforce
session
timeouts for
password
protected
web forms
when idle for

Use the Enforce session
timeouts for password
protected web forms when
idle for option to enforce a
timeout when a respondent is
inactive for a specified period of
time. Enter the time in the dropdown list. This feature only
applies to password-protected
forms (those using Login pages).
After the specified time elapses
with no activity, the respondent
is prompted to login to the web
form again in order to continue
filling out the web form.
(*Professional Version Only*)

Specify the
web form‟s
availability
window
(access time
frame)

Use the Specify the web
form’s availability window
(access time frame) option to
specify the dates and times when
the web form is active. If
respondents attempt to access
the web form outside of the
specified time period, they will
receive an appropriate error
message. (*Professional Version
Only*)

Start time

Enter the date and time when
the web form will become active.

End time

Enter the date and time when
the web form will become
inactive. Respondents will not be
able to access the web form after
this date and time.
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Tab

Heading

Name

Description

Respondent
settings

Limit the
accepted
number of
respondent
submissions
to

Set a maximum number of
responses allowed for a web
form. Once the maximum is
reached, respondents will no
longer be able to access the web
form and will receive an
appropriate error message.
(*Professional Version Only*)

Remove
respondent‟s
incomplete
data from
server after

Specify the number of hours or
days that you will allow before
incomplete web form
submissions are removed from
the server. An incomplete web
form submission could be due to
someone starting the web form
and never completing it or
someone pausing the web form
and not returning to complete it.

Base interval
value on the
number of
hours that
incomplete
data resides
on the
server

Mark the Base interval value
on the number of hours that
incomplete data resides on
the server option to use hours
as the measure for removing
incomplete web form
submissions.

Base interval
value on the
number of
days that
incomplete
data resides
on the
server

Mark the Base interval value
on the number of days that
incomplete data resides on
the server option to use days as
the measure for removing
incomplete web form
submissions.
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Tab

Heading

Name

Description

Additional
Data

Display and
tabulation
settings

Display date
submitted
with field
name

Mark the Display date
submitted with field name
option to include the submission
date when downloading data.
You may accept the default field
name of Date or enter your own.
If you wish to include this
information in your analysis,
mark the Tabulate checkbox.

Display time
submitted
with field
name

Mark the Display time
submitted with field name
option to include the submission
time when downloading data.
You may accept the default field
name of Time or enter your own.
If you wish to include this
information in your analysis,
mark the Tabulate checkbox.

Display
respondent‟s
IP address
with field
name

Mark the Display respondent’s
IP address with field name
option to include the
respondent‟s IP address when
downloading data. You may
accept the default field name of
IP Address or enter your own. If
you wish to include this
information in your analysis,
mark the Tabulate checkbox.
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Tab

Heading

Name

Description

Display
respondent‟s
UID with
field name

Mark the Display respondent’s
UID with field name option to
include the respondent‟s UID
when downloading data. The UID
(unique identifier) is used by
Remark Web Survey to track
respondents‟ submissions (e.g.,
so that they may pause and
resume the web form). You may
accept the default field name of
Respondent ID or enter your
own. If you wish to include this
information in your analysis,
mark the Tabulate checkbox.

Display web
form
duration
with field
name

Mark the Display web form
duration with field name
option to include the length of
time it took each respondent to
complete the entire web form.
Please note that this time is from
first login to completion. It does
not remove any time in which
the survey was paused. You may
accept the default field name of
Duration or enter your own. If
you wish to include this
information in your analysis,
mark the Tabulate checkbox. A
report detailing the number of
submissions in a particular time
interval is available in Remark
Live Stats in the Remark Web
Survey Control Panel (see
Section 11.3).
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Tab

Heading

Name

Description

Track the
respondent‟s
IP address

By default, Remark Web Survey
will log each respondent‟s IP
address in the server log. Once
logged, you have the option to
display it in the data grid. If you
do not wish to track the
respondent‟s IP address, turn off
the Track respondent’s IP
address checkbox. This allows
for complete survey anonymity.

4.2.1 Advanced Notification Criteria
(*Professional Version Only*)
The Advanced Notification Criteria feature has two primary purposes:
1. To allow you to generate an email to a recipient based on how a question is
answered.
2. To allow respondents to have their web form responses emailed directly to
them.
Allowing responses to specific questions or sets of questions to be emailed
directly to specific respondents allows instant notification of important
information. Please note that this feature can work in one of two ways:
1. Web Form Level. The specified notifications will only happen once the entire
web form is submitted. Responses can be changed and the notification will
not be triggered until the entire web form has been completed.
2. Page Level. If someone answers the question as identified in the notification,
when the respondent submits the page, the email notification will be sent to
the appropriate email address. If the respondent clicks the back button or at
some other point revisits this question and changes it, the email recipient
will not know this fact. The notification may be triggered again (depending
on whether the criteria was met for the notification).
Note: Advanced notifications rely on an external email server.
There are two places to set up details about your email server: Web
Server and Local Server. Advanced Notification emails use the email
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properties for the Web Server. Entering details in Remark Web
Survey about your email server is covered in Section 4.2.

To use Advanced Notifications to send emails based on how questions
are answered
1

To set up Advanced Notifications at the Web Form Level, double click the top
node in the tree view (Web Form – YourFormName), click Email settings
and then click Advanced Notification Criteria. To set up Advanced
Notifications at the page level, double click any Standard page in the tree
view and then click the Advanced Notification Criteria link to view the
Notification Criteria Builder window.
Tip: Setting up Advanced Notification Criteria is very similar to
setting up Question Branching. You may wish to read Chapter 8,
which describes Question Branching in detail.

The Notification Criteria Builder window consists of the following properties:
Property

Description

Text

Click the Text button to display the question text
for each question on the web form instead of field
names (applies to the Question column of the
branching grid). This setting depends on your
personal preference as to how you would like the
questions displayed when selecting them from the
Question drop-down list. If this setting is not
selected, the questions will be listed by field name
in the Question drop-down list.

Field Name

Click the Field Name button to display the field
name for each question on the web form instead of
question text (applies to the Question column of
the branching grid). This setting depends on your
personal preference as to how you would like the
questions displayed when selecting them from the
Question drop-down list. If this setting is not
selected, the questions will be listed by question
text in the Question drop-down list.
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Property

Description

Insert Statement

Click the Insert Statement button to insert a new
statement within the email notification grid. This
feature is useful if you need to place a statement
within other statements that you have already
defined. Select an insertion point by clicking in a
row first and when you click Insert Statement,
the grid will add a row above your current
selection point. It will initially insert the row as
part of the selected statement. The Rule
Numbers for the statements will update
themselves automatically as you begin to enter the
criteria for the statement. You only need to use
the Insert Statement function to add statements
between other statements. If you are simply
building a notification pattern from start to finish,
use the rows of the email notification grid in
sequence on the screen.

Delete Statement

Click the Delete Statement button to remove a
statement within the email notification grid. Select
an insertion point by clicking in a row first and
when you click Delete Statement, the grid will
remove the selected statement(s).

Group Statements

Use the Group Statement option to group parts
of the email notification pattern together. This
feature is useful when setting up multiple criteria
and notifications on one page. It will allow you to
further customize the criteria that determine the
notification by grouping like statements together
into one action.

Ungroup Statements

Use the Ungroup Statements option to ungroup
parts of the notification criteria. Ungrouping
statements can be accomplished once you have
grouped statements, as described above. You can
use the ungroup option to make changes.

Question

Displays the questions on the entire form. Use the
Question list to select a question on which to base
the email notification. How this question is
answered will trigger the email notification.
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Property

Description

Operator

Displays the available operators for the
notification, which include = (equal to), <> (not
equal to), > (greater than), < (less than), >=
(greater than or equal to) and <= (less than or
equal to). Select the item to which your
notification applies.

Response

Displays the response choices from the selected
question. Select the Response choice that will
trigger the email notification or enter the
appropriate text for a textbox/text area question.
For example, if your choices are Strongly Agree,
Agree, Disagree and Strongly Disagree, and
choosing Strongly Disagree will trigger the email
notification, choose Strongly Disagree from this
list. Or, if it is a textbox style question, enter the
text exactly as you expect your respondents to
enter text in order to trigger the next action.

Action

Allows you to select the next action. Use Email to
set up the email notification when the particular
response choice is selected. You will enter the
email address in the Recipient box (see below).
Use And to continue to set up notification patterns
whereby the next pattern in the sequence must
also be true in order to trigger the notification. Use
Or to continue to set up branch patterns whereby
the next pattern in the sequence may also be true
in order to trigger the notification.

Recipient(s)

Enter the email address to which you want the
notification sent when the criteria specified is met.
You may enter multiple email addresses separated
by a semi-colon (;).

Reset

Resets the current notification pattern, allowing
you to start over. Note that all statements will be
removed when you click the Reset button.
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You will notice that there is a Criteria translation box below the notification
setup area that displays your notification patterns as you build them. You
cannot edit the text in this window, but you may use it to double check your
logic when setting up your
notifications.
2

If desired, select whether to view
the questions in the Questions
column of the notification grid by
Text (question text) or Field
Name.

3

In the Questions column, select
the first question on which to
base the notification.
Note: You may resize
the columns in this grid as you see fit.

4

In the Operator column, select the appropriate operator for the branch
pattern (e.g., Q1 = Yes or Q1 <= 5).

5

In the Response column, select or enter the question‟s response on which
to base the email notification.

6

In the Action column, select the next action. If you want to add more
parameters to the notification, select And or Or, depending on whether the
next criterion must be true (AND) or can be true (OR) in addition to the
previous criterion. If you have completed the setup and are ready to specify
the recipient‟s email address, select Email.

7

If you have selected Email in the Action column, enter the appropriate
email address or addresses. If using multiple email addresses, separate
each one with a semi-colon (;). If you have selected And or Or in the
Action column, leave the Target column blank.

8

If you have completed setup of the notification by entering the email
addresses, click the OK button to save your changes. If you need to add
more statements, continue to Step 9.

9

[Optional] Continue to add notification statements as needed. You will notice
that based on the operators used and other criteria, the row headers in the
grid update with Rule numbers. The Rule numbers provide you with a quick
way to see patterns in your notification criteria.

10 [Optional] If desired, use the Group Statements and Ungroup

Statements buttons to refine the notification patterns. For example, if two
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parts of the pattern belong together, you may select them in the grid and
then click the Group Statements button. Click and drag the row headers to
select items to group together. When statements are grouped, Remark Web
Survey will evaluate them together before going on to the next notification
sequence.
11 Click the OK button to save your changes.

When the web form is published and respondents begin entering answers to the
questions that are part of the notification setup, the emails will be generated to
the appropriate recipients based on how the questions are answered.

To use Advanced Notifications to send emails to a respondent
1

Create a question on the form where respondents can type in their email
address.

2

To set up Advanced Notifications at the Web Form Level, double click the top
node in the tree view (Web Form – YourFormName), click Email settings
and then click Advanced Notification Criteria. To set up Advanced
Notifications at the page level, double click any Standard page in the tree
view and then click the Advanced Notification Criteria link to view the
Notification Criteria Builder window.
Tip: Setting up Advanced Notification Criteria is very similar to
setting up Question Branching. You may wish to read Chapter 8,
which describes Question Branching in detail.

The Advanced Notification Criteria window appears.
3

Locate the line that reads Email responses to the addresses supplied in
question at the bottom of the
window.

4

Use the drop-down list to select
the question that you set up in
Step 1 above. This is the
question in which respondents
will type their email address so
that they can receive an email
containing all of their responses.

5

Click the OK button to save your
changes.
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Once the web form is published, respondents will be able to enter an email
address (or multiple addresses separated by a semi-colon (;)) and have all of
their responses emailed to them once they submit the entire web form or a
single page‟s responses if you have set up the notification on a page by page
basis.

4.2.2 Access & Availability Settings
The Access & Availability settings were mentioned in the general table of web
form level properties but are worthy of further discussion. The Access &
Availability tab of the web form properties window allows you to control web
form availability and respondent limitations. The following sets of instructions
cover the features in the Access & Availability window.

To enforce session timeouts (*Professional Version Only*)
When using a password protected web form, you can enforce a session timeout,
whereby the web form will no longer be available without reentering a valid
password after a certain amount of idle time. The default idle time is ten
minutes, but you may adjust this as you see fit. If respondents are inactive for
the idle time, when they try to submit the current page, they will be required to
login again. Any submitted data will be reloaded.

1

Access the web form properties (see Section 4.2).

2

Click the Access & Availability tab.

3

Mark the checkbox for Enforce
session timeouts for password
protected web forms when idle
for.

4

Set an idle time in the drop-down box.
This time is in minutes.

5

Click the OK button to save the
changes.
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To specify an availability window (*Professional Version Only*)
Each web form you publish can have an availability window, which is the time
when the web form is active. Once the availability window expires, the web
form will no longer be accessible to respondents. If respondents attempt to
access the web form outside of the specified time period, they will receive an
appropriate error message. If the web form availability window expires while a
respondent is submitting responses or has the web form paused, they will not
be able to submit the web form. We suggest that you inform respondents that
the entire web form must be completed within the specified timeframe. Note
that incomplete submissions will still be available for download when
downloading data.

1

Access the web form properties (see Section 4.2).

2

Click the Access & Availability
tab.

3

Mark the checkbox for Specify
the web form’s availability
window.

4

Enter a Start time and an End
time. Use the drop-down arrow to
view a calendar where you can
select a date. You can type the
time in the appropriate location.
This time is in minutes.

5

Click the OK button to save the changes.

To limit the number of respondents (*Professional Version Only*)
You may limit the number of respondents who can submit a web form. Once the
designated number of successful submissions is reached, the web form will no
longer be accessible to respondents and they will receive an appropriate error
message.

1

Access the web form properties (see Section 4.2).

2

Click the Access & Availability tab.
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3

Mark the checkbox for Limit the
accepted number of respondent
submissions to.

4

Enter the number of accepted
submissions in the box. You can
either type a number or use the up
and down arrows to select a number.

5

Click the OK button to save the
changes.

To remove incomplete data
You may remove incomplete web form submissions (data) after a certain
amount of time. As respondents submit pages of a web form, data is stored in
the respondents‟ UID file on the web server, which is a small text file. Once the
entire web form is submitted, the UID file is automatically removed from the
web server. An incomplete submission typically comes from a respondent who
either starts a web form but never completes it, or who pauses the web form
after submitting a portion of the data but never returns to complete the web
form. Be cautious when removing incomplete submissions; once they are
removed, the data is permanently deleted. If you allow respondents to pause
the web form, be sure to advise them of how long they have to come back and
complete the web form before their data will be lost. The scripts will check for
incomplete submissions to remove whenever interaction with the data script
(rws5.pl) and web form occurs.
Note: Remark Web Survey Professional is capable of downloading
incomplete data submissions. If you remove incomplete data from
the web server, you will not
be able to use this feature.
1

Access the web form properties (see
Section 4.2).

2

Click the Access & Availability tab.

3

Mark the checkbox for Remove
respondent’s incomplete data
from server after.

4

Enter the number of days or hours in
the box. You can either type a
84

Remark Web Survey Form Elements

number or use the up and down arrows to select a number.
5

Choose whether the number you entered in Step 4 is days or hours by
selecting the appropriate radio button: Hours: Base interval value on the
number of hours that incomplete data resides on the server, or Days:
Base interval value on the number of days that incomplete data
resides on the server.

6

Click the OK button to save the changes.

4.3 Web Form Pages
Remark Web Survey allows you to create seven types of web form pages (form
elements) when designing a web form.
Name

Description

Standard Page

Web form page containing sections, which in turn contain
elements, such as questions, answers, images,
multimedia and labels. At least one Standard page is
required per web form. Standard pages are those pages
that allow you to ask questions of your respondents.

Popup Info Page

Web form popup page containing static information that
needs to be presented to the respondent. This page does
not have questions on it to be submitted by the
respondent; it is for informational purposes only. You can
set up a label hyperlink to a Popup Info page. Popup Info
pages are optional.

Login Page

Web form page containing an area for respondents to
enter a password to access and submit the form. Login
pages are optional.

Web Form
Complete Page

Success page that is displayed when the respondent
submits the web form (e.g., a thank you page). At least
one Web Form Complete page is required per web form
(you can have more than one and use question branching
to direct respondents to different Web Form Complete
pages). You can build the Web Form Complete page in
Remark Web Survey or point it to an existing page on
your website.
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Name

Description

Response
Confirmation
Page

Web form page displaying all of the submitter‟s
(respondent‟s) responses to each question. Responses
can be changed by clicking the desired question. This
page can be printed so that the respondent has a copy of
his or her responses. Response Confirmation pages are
optional. (*Professional Version Only*)

Session Pause
Page

Web form page that allows respondents to pause the web
form so that they may complete it at another time.
Respondents can enter an email address and an email
reminder will be sent, providing a link to go back to the
web form. Session Pause pages are optional.
(*Professional Version Only*)

Server Error
Page

Web form page that will return customized error
messages to respondents when a server side problem
arises (e.g., the password entered is invalid). Server Error
pages are optional. If not used, Remark Web Survey will
utilize default error messages that are built into the
software when errors occur.

Pages are grouped into two containers in the tree view: Standard Pages and
Special Pages. The Standard Pages container holds only standard pages. The
Special Pages container holds the remaining pages. These groupings make it
easier to navigate the tree view.
The following sections describe the properties of the page types in detail.

4.4 Standard Pages
Standard pages are the basic pages of a web form. They hold the sections of
questions being asked, along with images, lines, multimedia and labels, if
desired. Standard pages are the most common type of page found in a web
form. You must have at least one Standard page in any web form. The following
table lists the properties of Standard pages:
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Section

Property

Description

Basic
settings

Title

Enter the title that will appear on the title
bar when displayed in a web browser.

Header and
Footer

Display the web
form header on
the page

Mark the Display the web form header
on the page checkbox to display the
header you have defined on the selected
web page(s). Headers are created
independently of pages and can be
applied to any page.

Display the web
form footer on the
page

Mark the Display the web form footer
on the page checkbox to display the
footer you have defined on the selected
web page(s). Footers are created
independently of pages and can be
applied to any page.

Branching setup
(*Professional
Version Only*)

Sets up branches on the page so that if a
specific response is selected, the
respondent will be directed to another
page (also known as skip patterns). See
Chapter 8 for a complete description of
branching.

Advanced
Notification
Criteria
(*Professional
Version Only*)

Click the Advanced Email Notifications
link to set up email alerts based on how
specific questions are answered. See
Section 4.2.1 for more detailed
information.

Format

Use the Format button to format the
style of the web page. Formatting is
covered in detail in Chapter 7.

Format
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To insert a standard page in a
web form
1

From the Ribbon, select the
Insert tab and then click Page.
(Note you may also insert pages
by right clicking the tree view and
then clicking Insert or Insert
Before.)

2

Enter settings as desired, as
described previously.

3

Click the OK button. The Standard page is added to the Standard Pages
container automatically. You may now start adding sections (optional) and
other elements to the web form.
Tip: When you want to change properties for all Standard pages at
one time, you may select the entire Standard Pages container and
then adjust the properties (e.g., right click the Standard Pages
container node and then click Properties). This action will change
applicable settings for all Standard pages.

4.5 Popup Info Pages
A Popup Info page contains static information that you want to present to your
respondents. It appears in a separate window, often referred to as a popup
window. The respondents‟ browser typically controls the size of this window.
You may place information on this page that is necessary for your respondents
to read in order to properly fill in your form. For example, if you were
conducting a survey on a specific product, you could use a Popup Info page to
show an image of the product along with a description. The respondents could
use this information to answer questions about the product.
Utilizing Popup Info pages is a two-step process. First you have to create the
Popup Info page containing the static information you want respondents to see.
Once you have created a Popup Info page, you can link to it by adding a label to
the web form. In the label properties window, mark the option for Hyperlink and
then choose the desired Popup Info page from the drop-down list. When
respondents click the label, they will see the Popup Info page.
The following table lists the properties of Popup Info pages:
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Section

Property

Description

Basic
settings

Title

Enter the title that will appear on the title
bar when displayed in a web browser.

Header and
Footer

Display the web
form header on
the page

Mark the Display the web form header
on the page checkbox to display the
header you have defined on the selected
web page(s). Headers are created
independently of pages and can be
applied to any page.

Display the web
form footer on the
page

Mark the Display the web form footer
on the page checkbox to display the
footer you have defined on the selected
web page(s). Footers are created
independently of pages and can be
applied to any page.

Browser
redirection

Redirect browser
to

Mark the Redirect browser to checkbox
to use an existing web page as your
Popup Info page. The respondents‟ web
browser will display this page when the
Popup Info page is launched. (Optional)

Format

Format

Use the Format button to format the
style of the web page. Formatting is
covered in detail in Chapter 7.

To insert a Popup Info page in a web form
1

From the Ribbon, select the
Insert tab, then click the down
arrow on Page to reveal a list of
special pages. (Note you may
also insert pages by right clicking
the tree view and then clicking
Insert or Insert Before.)

2

Select Popup Info.

3

Enter settings as desired, as
described previously.
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4

Click the OK button. The Popup Info page is added to the Special Pages
container automatically.

5

Add a label on a different web form page, mark the checkbox for Hyperlink
in the Label Properties window and then choose the Popup Info page as
your hyperlink.

4.6 Response Confirmation Pages
(*Professional Version Only*)
Response Confirmation pages provide respondents with a listing of all of their
answers to the questions on the web form. The Response Confirmation page
appears as the last page of the web form (prior to the Web Form Complete
page) so that respondents can review the information and then go back and
make changes if desired (a back button is provided by default on the Response
Confirmation page for this purpose). Respondents can also click a link next to
each question on the Response Confirmation page to go to that question in the
web form and adjust their response. The Response Confirmation page can also
be printed (using the web browser‟s print options) so that respondents have a
record of their responses.
When respondents navigate to the Response Confirmation page of the web
form, they will see each question listed and then beneath the question, the
answer choice they selected. The HTML Display portion of the answer choice is
displayed to the respondent. There is also a Change Response link next to the
question that the respondent can click to go directly to the desired question in
the web form. Note that if your web form utilizes complex branching,
respondents may have to navigate through multiple web form pages before
returning to the Response Confirmation page (depending on the answer they
choose).
When building Response Confirmation pages, you may not add additional
questions and answers, but you may add other elements to the page such as
lines, labels, images and multimedia. You may wish to add a label explaining to
respondents what the Response Confirmation page is used for and how to
adjust responses.
The following table lists the properties of Response Confirmation pages:
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Section

Property

Description

Basic
settings

Title

Enter the title that will appear on the title
bar when displayed in a web browser.

Header and
Footer

Display the web
form header on
the page

Mark the Display the web form header
on the page checkbox to display the
header you have defined on the selected
web page(s). Headers are created
independently of pages and can be
applied to any page.

Display the web
form footer on the
page

Mark the Display the web form footer
on the page checkbox to display the
footer you have defined on the selected
web page(s). Footers are created
independently of pages and can be
applied to any page.

Branching setup
(*Professional
Version Only*)

Sets up branches on the page so that if a
specific response is selected, the
respondent will be directed to another
page (also known as skip patterns).
Branching is useful on a Response
Confirmation page when displaying
various Web Form Complete Pages based
on responses to previous questions. See
Chapter 8 for a complete description of
branching.

Format

Use the Format button to format the
style of the web page. Formatting is
covered in detail in Chapter 7.

Format

To insert a Response Confirmation page in a web form
1

From the Ribbon, select the Insert tab and then click the down arrow on
Page to reveal a list of special pages. (Note you may also insert pages by
right clicking the tree view and then clicking Insert or Insert Before.)
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2

Select Response Confirmation.

3

Enter settings as desired, as
described previously.

4

[Optional] Click the Format
button to adjust the text
formatting (see Chapter 7 for
further details about formatting).
Note: Rich text
formatting is not available for Response Confirmation page question
and answer placeholders.

5

Click the OK button. The Response Confirmation page is added to the
Special Pages container automatically.

6

A Question Placeholder and an Answer Placeholder are inserted into
the Response Confirmation page automatically. The Question and Answer
Placeholders represent the formatting of the question listing. They will be
displayed with the text “question
placeholder” and “answer
placeholder” as you build the web
form. When the web form is
published and respondents are
viewing the Response
Confirmation page, the
placeholder text will be replaced
with the actual question and
answer text from the web form.
When you open the properties for
either item, you will see some
descriptive text under Label text.
You may not change the text of
the placeholders; however, you may format the attributes of the
placeholders by adjusting the format options.
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4.7 Session Pause Pages
(*Professional Version Only*)
A Session Pause page provides respondents with the capability of stopping in
the middle of a web form and then continuing from the same point at a later
time. This feature is especially useful for long web forms. When respondents
want to pause the web form, they click a pause button. A page is then displayed
that they can either bookmark for later return or they can enter their email
address. When using the email function, an email reminder will be generated
and sent to them with a hyperlink that will take them back to the web form to
complete it at the time of their choice. When respondents return to the web
form by clicking the hyperlink or bookmark, they will go back to the same page
from which they left. All previously submitted responses will still be stored in
the data file. You may limit the amount of time respondents have to return to
the web form through the removal of incomplete form submissions after a
certain amount of time has passed (be sure to advise them of the available time
to submit the web form in your pause page and/or email text).
Using the option to email a link to the respondent relies upon the email server
setting in the web form properties. Session Pause page email reminders use the
mail server settings for the web server. These settings are covered in Section
4.2.
Note: If you are not providing the ability to email a return link to
the survey, you should add a label to the Session Pause page with
explicit instructions on how to bookmark the page for later return.
The following table lists the properties of Session Pause pages:
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Section

Property

Description

Basic
settings

Title

Enter the title that will appear on the title
bar when displayed in a web browser.

Include
credentials in the
web form link of
reminder emails

When using a Login page you can optionally
include respondents‟ username and/or
password in the web form invitation link. In
this case, you can also include those
credentials in the Session Pause page
reminder email link that is sent to
respondents when they pause the web form
by marking the checkbox for Include
credentials in the web form link of
reminder emails. When pausing forms,
respondents will receive a reminder email
that includes a link to resume the web form
and their username and/or password will be
included in the link so that they are
automatically logged into the web form.

Display the web
form header on
the page

Mark the Display the web form header
on the page checkbox to display the
header you have defined on the selected
web page(s). Headers are created
independently of pages and can be applied
to any page.

Display the web
form footer on
the page

Mark the Display the web form footer on
the page checkbox to display the footer
you have defined on the selected web
page(s). Footers are created independently
of pages and can be applied to any page.

Format

Use the Format button to format the style
of the web page. Formatting is covered in
detail in Chapter 7.

Header
and Footer

Format
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To insert a Session Pause page in a web form
1

From the Ribbon, select the Insert tab and then click the down arrow on
Page to reveal a list of special pages. (Note you may also insert pages by
right clicking the tree view and then clicking Insert or Insert Before.)

2

Select Session Pause.

3

If necessary, click the Email
settings link to enter the
administrator email address and
mail server information. This
information will be automatically
inserted if you have entered it
into the Remark Web Survey
program options (accessible from
the Application Button). If you
have not entered this information
in the program options, you will
need to enter it on the Session Pause page properties.
Note: Email settings should be obtained from your network or
website administrator. For detailed information about the email
settings in this window, please see Section 4.2.

4

Enter settings as desired, as described previously.

5

Click the OK button.

6

An email question element is automatically added to the Session Pause
page. If you wish to format it, double click the node that reads Please
enter your email address and format as desired.

The Session Pause page is added to the Special Pages container automatically.
Be sure to add at least one pause button to your web form so that respondents
can access your Session Pause page.

To customize the reminder email
When a respondent pauses the web form, if you have set up email settings on
the pause page, a reminder email will be sent. You may customize the email
that is generated by entering your return email address, a subject line and the
body text of the email message. Please note that the email reminder will be
sent to recipients in plain text format so rich text formatting options are
disabled in this window.
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1

Double click the Please enter your email address node in the tree view to
view its properties. (This question element is added to all Session Pause
pages automatically.)

2

At the bottom of the window, click
the Reminder email settings link.

3

Enter a valid From email address and
a Subject line.

4

If desired, modify the body of the
email message. The link to the web
form will automatically be added to
the body of the message when the
email is generated.

When using Session Pause pages with
email, ensure that you have set up email functionality (as outlined in Step 3 in
the previous instructions) in the program options or in the web form‟s
properties (see Section 2.4.9 for further information about email setup).

To hide the email address question
If you prefer not to use the email functionality of the Session Pause page, you
may instead ask your respondents to bookmark the page. It is suggested that
you add a label to the Session Pause page with instructions for bookmarking the
page. In this case, you will need to hide the email address element.

1

Double click the node that reads
Please enter your email
address.

2

Go to the Attributes section.

3

Mark the checkbox for Hide
question from respondent.

4

Click the OK button. The email
address element is visible as you
design the web form, but is hidden
from respondents when they are
submitting the web form. Be sure
to tell respondents to bookmark
the page if you choose not to use
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the email element.
Note: We advise hiding the email question element as opposed to
deleting it because if you delete the email address question, you
cannot re-insert it. If you wish to allow email reminders after
deleting the email question element, you will need to delete and
recreate the Session Pause page.

To remove incomplete form submissions
You may remove incomplete web form submissions after a certain amount of
time has passed. For example, if respondents begin the web form, pause and
then never complete it, you can remove their incomplete data and ability to relogin to the web form.
Note: Remark Web Survey Professional is capable of downloading
incomplete data submissions. If you remove incomplete data from
the web server, you will not be able to use this feature.

1

Double click the top node in the tree
view with the web form title.

2

Select the Access & Availability tab.

3

Mark the checkbox for Remove
respondent’s incomplete data from
the web server after.

4

Enter the desired number of days or
hours, and then choose whether to
base the interval on hours or days that
the incomplete data resides on the web
server.

5

Click the OK button.

Once the time limit is exceeded, any incomplete data will be removed from the
server. Any time the web form is accessed or pages are submitted, the software
performs a check to see if incomplete submissions need to be removed.
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4.8 Web Form Complete Pages
A Web Form Complete page is the last page your respondents will see when
they submit a web form. You can think of a Web Form Complete page as a
“thank you” page. It lets respondents know that they have completed the form
successfully. You may have more than one Web Form Complete page if desired.
For example, if your form uses question branching, you may want respondents
to end up at different Web Form Complete pages based on how specific
questions are answered. Every web form must have at least one Web Form
Complete page. You have the option of either designing the page within Remark
Web Survey, or redirecting your respondents to another web page created
outside of Remark Web Survey. When you create a new web form, a Web Form
Complete page is automatically added to the web form along with a section.
The following table summarizes the Web Form Complete page options:
Section

Property

Description

Basic
settings

Title

Enter the title that will appear on the title
bar when displayed in a web browser.

Header and
Footer

Display the web
form header on
the page

Mark the Display the web form header
on the page checkbox to display the
header you have defined on the selected
web page(s). Headers are created
independently of pages and can be
applied to any page.

Display the web
form footer on the
page

Mark the Display the web form footer
on the page checkbox to display the
footer you have defined on the selected
web page(s). Footers are created
independently of pages and can be
applied to any page.

Redirect browser
to

Mark the Redirect browser to checkbox
to use an existing web page as your Web
Form Complete page (designed outside of
Remark Web Survey). The respondents‟
web browser will display this web page
when the Web Form Complete page is
launched.

Browser
redirection
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Section

Property

Description

Format

Format

Use the Format button to format the
style of the web page. Formatting is
covered in detail in Chapter 7.

To insert a Web Form Complete page in a web form
1

From the Ribbon, select the
Insert tab and then select the
down arrow on Page to reveal a
list of special pages. (Note you
may also insert pages by right
clicking the tree view and then
clicking Insert or Insert
Before.)

2

Select Web Form Complete.

3

Enter settings as desired, as
described previously.

4

Click the OK button. The Web Form Complete page will be added to the
Special Pages container automatically. You may optionally add elements
(labels, images, etc.) under the Section portion of the Web Form Complete
page (see Chapter 5 for more information about adding other elements).

4.9 Login Pages
Remark Web Survey allows you to password protect any web form that you
create. Requiring a password to submit a web form allows you to control who
has access to your web form. Respondents will not be able to view a password
protected web form until they successfully enter a valid password. Passwords
also allow you to limit the number of times respondents can submit a web form.
You control how many times any given password can be used. When the limit is
reached, respondents will receive a “password expired” error message.
Password lists can automatically generated, imported from an existing database
(*Professional Version Only*) or manually entered into the software. In
addition, you may input a corresponding username, name and/or email address
and use that information to track which respondents have completed your web
form (see Section 10.8 for detailed information about Respondent Detection).
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To utilize password protection, you add a Login page to a web form. The Login
page provides a place for respondents to enter passwords in order to access
and submit the web form. Once a Login page is inserted, a password question
element box is automatically inserted (do not delete the password box; if it is
deleted, you will need to remove and reinsert the Login page). The password
question element is a textbox that allows respondents to type in their
passwords. You may format the password question element however you desire
by using the question‟s format options. To format the password element, double
click its node in the tree view and then click the Format button.
The following table summarizes the Login page options:
Section

Property

Description

Basic
settings

Title

Enter the title that will appear on the title
bar when displayed in a web browser.

Display a
username field for
an additional level
of security access

Mark the Display a username field for
an additional level of security access
checkbox to add a username textbox to
the login page. You will enter a valid list
of usernames in the Password Builder.
Respondents will have to enter a
username and password to access the
web form.

Display the web
form header on
the page

Mark the Display the web form header
on the page checkbox to display the
header you have defined on the selected
web page(s). Headers are created
independently of pages and can be
applied to any page.

Display the web
form footer on the
page

Mark the Display the web form footer
on the page checkbox to display the
footer you have defined on the selected
web page(s). Footers are created
independently of pages and can be
applied to any page.

Password list
builder

Click the Password list builder link to
enter a valid list of passwords required to
access the web form.

Header and
Footer
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Section

Property

Description

Format

Format

Use the Format button to format the
style of the web page. Formatting is
covered in detail in Chapter 7.

To insert a Login page in a web
form
1

From the Ribbon, select the Insert
tab and then click the down arrow
on Page to reveal a list of special
pages. (Note you may also insert
pages by right clicking the tree
view and then clicking Insert or
Insert Before.)

2

Select Login.

3

Enter settings as desired, as described previously.

You must also enter a valid list of passwords and the number of acceptable uses
on the Login page. Use the Password List Builder to set up valid passwords
for the web form. You may import a list of passwords from an existing database
or enter them into the Remark Web Survey software.
4

Click the Password list builder link to enter valid passwords.

The following table summarizes the available Password Builder options:
Property

Description

Username Field

Use the Username column to manually
enter a list of usernames. The keyboard
shortcut for Paste (Ctrl + V) will also work
in this grid, allowing you to paste a list of
passwords from the Windows clipboard.
The Username column only appears of the
option for Display a username field for
an additional level of security access
is marked on the Login page‟s properties.
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Property

Description

Password Field

Use the Password column to manually
type a password list. The keyboard
shortcut for Paste (Ctrl + V) will also work
in this grid, allowing you to paste a list of
passwords from the Windows clipboard.

Respondent Name Field

Use the Respondent Name column to
manually type the respondents‟ names.
The keyboard shortcut for Paste (Ctrl + V)
will also work in this grid, allowing you to
paste a list of names from the Windows
clipboard.

Email Address Field

Use the Email Address column to
manually type an email address list for
your respondents. The keyboard shortcut
for Paste (Ctrl + V) will also work in this
grid, allowing you to paste a list of email
addresses from the Windows clipboard.

Maximum number of accepted
submissions using a single
password before it is expired

Specifies the number of times each
password can be used. Select 0 for
unlimited usage. When limiting the
number of submissions per password,
once the limit is reached, respondents will
receive an “expired password” message if
they attempt to use an expired password.

Database Connection Settings

Allows you to select a database containing
a list of passwords for the form. If you
import the information from a database,
you do not have to manually enter
passwords, usernames, names and email
addresses.

Database

Displays the database file name after one
is set up.

Type

Choose a type of database from the dropdown list. Then click the Open folder to
select the database containing the
password list.
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Property

Description

DSN

If using an ODBC connection, choose the
DSN from the DSN drop-down list. Mark
whether it is Directory based or DSN
based. ODBC DSN is a pointer that tells
the system how to connect to a specific
database. It combines the database
location with the specific driver
information and connection details.

Username

If your database requires a login, enter
the Username.

Password

If your database requires a login, enter
the Password.

Connection string

Displays the connection string that is
working behind the scenes to connect to
your selected database.

Test Connection

You may optionally click the Test
Connection button to test whether you
can connect to this database.

Table

Select the table in the database that
contains the passwords.

Name field

Select the field in the database that
contains the respondents‟ names.
(Optional)

Name 2 field

Select the field in the database that
contains the respondents‟ names. (You
can optionally separate first and last
name.) (Optional)

Username field

Select the field in the database that
contains the respondents‟ usernames.
(Optional)

Password field

Select the field in the database that
contains the respondents‟ passwords.

Email Address field

Select the field in the database that
contains the respondents‟ email
addresses. (Optional)
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Property

Description

Import data

Click the Import data link to complete
the import.

Note: The password, name, username and email address
fields are used to track which respondents have submitted
your web form. When the data are downloaded, Remark Web
Survey can provide a Respondent Detection report, which
displays a list of who has and has not submitted your web
form based on these fields. You can then use this list to send
an email reminder to respondents who have not yet
submitted your web form using Remark Web Survey‟s Send
Invitations function.

5

Enter password information manually or by clicking Database connection
settings to import a list of passwords, as described in the previous table.

6

[Optional] If you prefer, random passwords
can be assigned to existing names,
usernames and/or email addresses. This
feature is useful if you have a list of
recipients in an external file but do not
have a password for each one. To use the
Random feature, you must first enter the
names, usernames and/or email addresses
of the recipients, as explained in the
previous table. Then click the Random
button.
a) Select the length of passwords, whether
to include symbols in the password
(otherwise passwords will be a
combination of letters and numbers only) and whether to overwrite any
existing passwords (if there are any).
b) Click the OK button to generate the passwords.

7

Click the OK button. The Login page is added to the Special Pages
container automatically.
Special Note: If you want to enter a range of passwords in
sequential order, enter the first password in the first cell of the
password grid. Click on the right cell border until you see a
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crosshair and then drag down the column until you reach the
number of rows you wish to fill. When you release the mouse
button, the software will automatically fill the passwords in
sequential order. For example, if you type 1 in the first box and
then drag downward to encapsulate 100 cells, you will have a
password range of 1-100.

4.10 Server Error Pages
Server Error pages provide customized error messages when an error occurs
during a web form submission. Server errors are those that occur on the web
server during processing. If you do not add a Server Error Page to your form,
default messages will be displayed if an error is encountered. The following
table summarizes the Server Error Page options:
Section

Property

Description

Basic
settings

Title

Enter the title that will appear on the
title bar when displayed in a web
browser.

Header
and Footer

Display the web
form header on
the page

Mark the Display the web form
header on the page checkbox to
display the header you have defined on
the selected web page(s). Headers are
created independently of pages and can
be applied to any page.

Display the web
form footer on the
page

Mark the Display the web form footer
on the page checkbox to display the
footer you have defined on the selected
web page(s). Footers are created
independently of pages and can be
applied to any page.

Message Links

Click any of the available message links
to customize the error message
respondents will see. The messages that
can be customized include: Invalid
Password, Password expired, File access
error, Web form unavailable and
Maximum submission capacity.
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Section

Property

Description

Format

Format

Use the Format button to format the
style of the web page. Formatting is
covered in detail in Chapter 7.

To insert a Server Error page in a web form
1

From the Ribbon, select the Insert tab and then click the down arrow on
Page to reveal a list of special
pages. (Note you may also insert
pages by right clicking the tree view
and then clicking Insert or Insert
Before.)

2

Select Server Error.

3

Enter settings as desired, as
described previously. The possible
messages you can customize
include:

4

Message

Description

Invalid Password
message

Customize the error message that appears when
respondents use an invalid password to access a
web form.

Password expired
message

Customize the error message that appears when
respondents use an expired password to access a
web form.

File access error
message

Customize the error message that appears when
respondents try to access web form pages to
which they do not have access (e.g., they mistype
URL for your web form).

Web form unavailable
message

Customize the error message that appears when
respondents attempt to access a web form
outside of its availability window.
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5

Message

Description

Maximum submission
capacity message

Customize the error message that appears when
respondents attempt to access a web form that
has already reached the maximum number of
submissions.

Click the OK button. The Server Error page is added to the Special Pages
container automatically.

4.11 Editing Existing Form Pages
There will be times when you need to edit a page that already exists in the web
form. There are three ways to edit existing page properties:
Double click the page node.
Right click the page node and select Properties.
Click the page node, go to the View tab in the Ribbon and select
Properties.
Once you are in the Properties window, you can make the appropriate changes
and then click the OK button to save your changes. To understand what is on
each individual page type, please see the previous sections.
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Chapter 5

5.1 Overview
Chapter 5 covered web form elements, including form properties and pages.
Once you have pages on a web form, you need to add other elements. The
elements are inserted onto page sections. The use of sections allows you to
customize the layout of web forms. This chapter covers the following elements:
Sections
Labels
Images
Lines
Multimedia (*Professional Version Only*)
Questions
Answers
Buttons
Headers/Footers
Note: The following sections cover inserting various page elements
on a web form. Once elements are inserted, they can be modified.
General information about how to edit an element is covered in
Section 5.11. The properties that are available for editing are the
same as those you will see when inserting an element.
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5.2 Sections
Sections are containers that hold the page elements (questions, images, labels,
etc.) of your web form. The following items can be inserted into sections:
Name

Included Elements

Label

Inserts a text label (e.g., web form directions)

Image

Inserts an image

Line

Inserts a horizontal line

Multimedia

Inserts a multimedia file, such as a video or audio clip
(*Professional Version Only*)

Question

Inserts questions: option button, checkbox, drop-down box
(single or multiple responses), textbox/text area

Buttons

Inserts Submit/Next, Back, Reset and Session Pause buttons

By default, when you create a new page, two sections are added to the page.
The first section is where you can start adding elements from the table above.
The second section will automatically contain web form buttons. The buttons
displayed are dependent upon the type of page you are inserting, but can also
be modified. See Section 5.10 for more detailed information about buttons.
Each section contains a number of columns. The columns are used to assist with
web form layout. If you put all of the elements in one column (the default
setting), that column will span the width of the page. However, if you separate
a section into multiple columns, elements can be placed in specific column
locations. Think of the sections as a table. The table has rows and columns
within it and you can place items in specific columns. The Remark Web Survey
designer displays a light gray table in the HTML Viewer to assist you with
layout. These lines will not be visible in your published web forms, but can help
you place elements in the various rows and columns on the page. (The lines are
made visible through the Show HTML Layout Borders checkbox on the View tab
of the Ribbon.)
One common use of section columns is to put questions in separate columns on
the page. You can have two columns of questions, for example, instead of only
having one column that goes all the way down the page.

110

Remark Web Survey Page Elements

To insert a section
1

With a page highlighted, click the Insert tab on the Ribbon and then choose
Section. (Note you may also insert elements by right clicking the tree view
and then clicking Insert or Insert
Before.)

2

If desired, enter a Section title for the
section (the Section title does not display
on the published web form, but is there
to help you identify sections more easily
as you design web forms).

3

Set the Number of columns for the
section. One column is typically fine
unless you plan to position elements in
various columns on the form going
across the page.

4

The Section content area is for information purposes only.

5

[Optional] Click the Format button to add and format lines in between the
columns. By default, there is no visible vertical line separator between
columns in a section. You can add vertical lines for aesthetic purposes if
desired. Once in the Style Properties, set the Column Border Visible
property to True, choose a color under Column Border Color and then
choose the width of the line, in pixels, under Column Border Width.

6

Click the OK button.

You may now begin adding other elements to the web form.
The following sections describe each of the element types in detail.

5.3 Label Elements
A label element consists of free text that you place on a web form. For example,
a label element can be used for a web form title or for providing instructions for
filling out a web form. Labels are limited to 10,000 characters. You can
customize the following attributes of a label element:
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Section

Item

Function

Description
Details

Label text

Use the Label text area to enter the text
for the label. Labels are limited to 10,000
characters.

Enable rich text
formatting

Mark the Enable rich text formatting
checkbox to display the label in rich text
format. Rich text format allows for more
style variety as compared to plain text,
including changing font sizes, styles and
colors. These attributes can be changed for
entire labels or individual characters within
the label. See Chapter 7 for further details
about rich text formatting.

Column

Select the column in which you want the
label. The number of columns available is
dependent on the Column setting in the
section to which the label belongs.

Insert answer
pipe

Click the Insert answer pipe link to set up
answer piping. Answer piping displays
information gathered from a question on
the form within the label. For example, if
you ask for the respondent‟s name, and his
name is John, you can then “pipe” the
name into the label to make your form
appear more personalized (e.g., “Thank
you, John, for taking the time to submit this
survey.”). Piping is covered in more detail
in Section 5.7.5.a.
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Section

Item

Function

Behavior

Hyperlink

Mark the Hyperlink checkbox to turn the
label text into a hyperlink. A hyperlink
takes the respondent to another question
on the web form or to a different web page.
When using a web page, enter a fully
qualified URL (e.g.,
http://www.example.com).
Note: If you add a label to a Web Form
Complete or Popup Info page, and you
mark it to behave as a hyperlink, you will
also have the option to specify whether to
open the hyperlink in a new window.

Format

Use the Format button to format the look
of the label. Formatting is covered in detail
in Chapter 7.

To insert a label
1

Select an insertion point in the tree
view.

2

From the Ribbon, select the Insert
tab and then click Label. The Label
Properties window appears. (Note
you may also insert elements by right
clicking the tree view and then clicking
Insert or Insert Before.)

3

Fill in the desired Label text.
Note: When typing label text, you can insert HTML tags if you are
not using Rich Text (e.g., to add a hyperlink to a word or phrase).
You should only insert your own HTML tags if you have a firm grasp
on the HTML language. Gravic technical support personnel cannot
support user-created HTML tags.

4

If desired, utilize the other properties within the Label Properties window,
as described in the previous table.

5

Click the OK button to save the label.
113

Remark Web Survey User’s Guide

The label is added to the tree view and is visible in the HTML Preview window.

5.4 Line Elements
A line element is a horizontal break that can be inserted on a page wherever it
is appropriate. When you insert a line, there are no properties to set. However,
you can access the line‟s properties to adjust its style properties by double
clicking the line element once it has been added. Formatting is covered in detail
in Chapter 7.

To insert a line
1

Select an insertion point in the tree view.

2

From the Ribbon, select the Insert tab and
then click Line. (Note you may also insert
elements by right clicking the tree view and
then clicking Insert or Insert Before.) The
line is automatically added to the tree view
and is visible in the HTML Preview window.

3

[Optional] If you wish to format the line,
double click it within the tree view and then
click the Format button.

5.5 Image Elements
An image element is a graphic that is placed onto a web form in a designated
area. Images can be in the GIF (Graphics Interchange Format), JPG/JPEG (Joint
Photographic Experts Group) or PNG (Portable Network Graphics) formats.
An image element can be added to the page anywhere that is appropriate. A
copy of the image will be published to your web server with the rest of the form
content. Therefore, there is no need to specify where the image is located on
your web server.
The following table lists a summary of the image attributes that can be set:
Section

Item

Function

Description
Details

Image path

Click Select image to locate the image
you wish to add to your web form.
114

Remark Web Survey Page Elements

Section

Original
Dimensions

Item

Function

Alternate text

Use the Alternate text item to enter text
that is displayed when the mouse is placed
over the image on your web form and
while the image is loading. Alternate text
is useful if you want to create Section 508
compliant web forms. Screen readers will
read the alternate text.

Column

Select the Column in which you want the
image. The number of columns available is
dependent on the Column setting in the
section to which the image belongs.

Width

Use the Width setting to resize the image.
Enter the number of pixels wide you want
the image to be in the Width box. Note
that changing the size does not alter the
original image; it only resizes it in Remark
Web Survey.

Height

Use the Height setting to resize the
image. Enter the number of pixels high
you want the image to be in the Height
box. Note that changing the size does not
alter the original image; it only resizes it in
Remark Web Survey.

Maintain aspect
ratio

Mark the Maintain aspect ratio checkbox
to automatically size the image
proportionately as you set either the Width
or Height settings. The other setting will
automatically update so that your image
does not become distorted. Note that
changing the size does not alter the
original image; it only resizes it in Remark
Web Survey.
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Section

Item

Function

Behavior

Hyperlink

Mark the Hyperlink checkbox to turn the
image into a hyperlink. A hyperlink takes
the respondent to another question on the
form or to a different web page when
clicked. When using a web page, enter a
fully qualified URL (e.g.,
http://www.example.com).

Open external
hyperlinks in a
new window

Mark the Open external hyperlinks in a
new window checkbox to have hyperlinks
open in a separate (new) window when
clicked. This option applies to images that
are on Popup Info and Web Form Complete
pages only.

Format

Use the Format button to format the
image. Formatting is covered in detail in
Chapter 7.

To insert an image
1

Select an insertion point in the tree view.

2

From the Ribbon, select the Insert tab
and then click Image. The Image
Properties window appears. (Note you
may also insert elements by right
clicking the tree view and then clicking
Insert or Insert Before.)

3

Use the Select image link to locate the
image you wish to insert into your web
form.

4

If desired, enter Alternate text.
Alternate text is useful for Section 508
compliance; screen readers use this
text to read information about the
image.

5

If desired, utilize the other properties within the Image Properties
window, as described in the previous table.
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6

Click the OK button to save the image.

The image is added to the tree view and is visible in the HTML Preview window.

5.6 Multimedia Elements
(*Professional Version Only*)
Multimedia includes video and audio files that you embed into your web forms
for respondents to view. For example, suppose you are conducting a survey
about a possible new product and want to show respondents a potential
advertisement for the new product and then ask questions about it.
Respondents can play the video clip (or audio clip) directly from the web form.
Supported multimedia formats include: Moving Picture Experts Group (mpeg,
mpg, mp3), Audio Video Interleave (avi), QuickTime (mov), Waveform (wav),
Real Audio (ram, rm).
Note: Remark Web Survey does not provide functionality to create
multimedia files. These files must be created outside of Remark
Web Survey. You may then either embed them into the web form or
provide a link (URL) to them on an existing website.
You should understand the requirements of the format and player that you are
using. In addition, your respondents must have the appropriate viewer and
supporting files on their system in order to view the media. You may wish to put
instructions on the web form indicating what respondents need to properly view
your multimedia file. Note that different browser‟s have varying capabilities and
requirements when it comes to displaying multimedia files. We strongly suggest
you test your web form with the browsers you expect to be able to support
(e.g., the browsers you expect your respondents to use).
The following table lists a summary of the multimedia attributes that can be
set:
Section

Item

Function

Description
Details

Select media
from the
system

Click system to locate the multimedia file
you wish to add to your web form.
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Section

Original
Dimensions

Item

Function

Specify a web
address

Click web address to enter a hyperlink to
your multimedia file. The file must reside
on an existing website. Please use caution
when using URLs to link to files; if the file
is moved, the hyperlink will no longer
work. When using a web page hyperlink,
enter a fully qualified URL (e.g.,
http://www.example.com/myfile.avi).

Source

The Source lists the name of the file you
have selected. If the name is too long to fit
in the window, hover your mouse over the
name to see the entire name. Source is
not editable; go back to Select media
from the system to choose a new file if
needed.

File Size

The File Size lists the size of the selected
multimedia file. Note that large files may
take longer to load for the respondent.
File Size is for informational purposes
only.

Define a
custom media
player size

Mark the Define a custom media player
size to enter specific dimensions for the
media player that will play your video or
audio file. Please note that the default
dimensions are determined by the
resolution of the media file, and that the
media player then determines the size
needed to play your file. Use caution when
altering the size manually, as the video
may not display as expected.

Width

Use the Width setting to resize the media
player. Enter the number of pixels wide
you want the player to be in the Width
box. Note that changing the size does not
alter the original multimedia file; it only
resizes it in Remark Web Survey.
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Section

Behavior

Item

Function

Height

Use the Height setting to resize the media
player. Enter the number of pixels high
you want the player to be in the Height
box. Note that changing the size does not
alter the original multimedia file; it only
resizes it in Remark Web Survey.

Maintain aspect
ratio

Mark the Maintain aspect ratio checkbox
to automatically size the media player
proportionately as you set either the Width
or Height settings. The other setting will
automatically update so that the media
player does not become distorted. Note
that changing the size does not alter the
original multimedia file; it only resizes it in
Remark Web Survey.

Standby text

Use the Standby text box to enter text
that displays while the multimedia file is
loading. For example: “Please wait while
the video loads. This operation may take a
few minutes.”

Column

Select the Column in which you want the
multimedia file displayed. The number of
columns available is dependent on the
Column setting in the section to which the
multimedia file belongs.

Automatically
start media
(auto play)

Mark the Automatically start media
checkbox to have the multimedia file begin
as soon as the web page is loaded. The
respondent will not have to interact with
the multimedia file, such as having to click
the Play button to begin play.

Repeat media
(loop)

Mark the Repeat media checkbox to have
the multimedia file continuously play for as
long as the web page is on-screen.

Format

Use the Format button to format the
image. Formatting is covered in detail in
Chapter 7.
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To insert a multimedia file
1

Select an insertion point in the tree view.

2

From the Ribbon, select the Insert tab and then click Multimedia. The
Multimedia Properties window appears. (Note you may also insert
elements by right clicking the tree view and then clicking Insert or Insert
Before.)

3

Use the system link to locate the multimedia you wish to insert into your
web form. Alternatively, use the web address link to enter a URL to a
multimedia file on an existing website.
If you are entering a URL, Remark
Web Survey will attempt to validate
the link immediately.

4

If desired, enter Standby text.
Standby text displays while the media
player is loading so that your
respondents know to wait.

5

If desired, utilize the other properties
within the Multimedia Properties
window, as described in the previous
table.

6

Click the OK button to save the
multimedia file.

The multimedia file is added to the tree view and is visible in the HTML Preview
window.
Tip: Displaying or hiding the multimedia player‟s controls can be set
using the Format button in the Multimedia Properties window. For
some browsers you may need to make the size of the player slightly
larger in order to completely see the player‟s controls.
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5.7 Question and Answer Elements
Question elements represent the questions on a web form. There are four
general types of question elements: option buttons (also known as radio
buttons), checkboxes, drop-down boxes and single and multiple line
textboxes/text areas.

5.7.1 Option Buttons
An option button is a small circle that can be selected or cleared:
. When
selected it contains a dot. Option buttons are used for multiple choice questions,
where the respondent is only permitted to choose one response.

5.7.2 Checkboxes
A checkbox is a small square that can be selected or deselected:
. When
selected it contains a check mark (). Checkboxes are used for multiple-choice
questions that allow the respondent to choose more than one response for a
single question. The responses can be output to one data cell or individual data
cells.

5.7.3 Textboxes/Text Areas
A textbox is used for questions that allow the respondent to type an answer:
. Textboxes are appropriate for open-ended types of
questions, or for collecting information about respondents, such as names and
addresses. You may select the size of the textbox and whether to limit the
length of a respondent‟s response. A single line write in area is called a textbox.
A multiple line write in area is called a text area.

5.7.4 Drop-Down Boxes
A drop-down box is a list in which pre-defined answer choices can be selected:
. Drop-down boxes can be used for questions that allow single or multiple
responses. A drop-down single box will only allow the respondent to select one
item. A drop-down multiple box will allow the respondent to choose more than
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one item by holding down the Shift or Ctrl key and clicking the desired
responses.

5.7.5 Question Element Properties
When setting the properties for a question, there are five areas to be
configured: General, Answers, Attributes, Analysis and Database Link. The
following tables summarize the question element properties:
General:
The General window allows you to set general properties related to the
question.
Property

Function

Question type

Use the Question type drop-down list to change
the type of question selected: Textbox/Text Area,
Checkbox, Option Button or Drop-Down Box.

Allow multiple
selections

Mark the Allow multiple selections checkbox
when using a Drop-Down Box question type to
allow respondents to select more than one answer
from the pre-defined list. Respondents will be able
to hold down the Ctrl key while they click answers
in the list in order to select them.

Data type

Use Data type to select a data type for the
question: text or numeric. When exporting data to
other programs, data will be formatted according to
the data type selected.

Field name

Use Field name to create a field name for the
question, which will be used as a column header in
the data grid. Field names are also useful if you
plan to combine data with Remark Office OMR or
Remark Classic OMR; use the same field names in
both products. When planning to export data, be
sure to follow your export format‟s guidelines for
field naming conventions. In addition, if you will be
saving data to an existing database file, be sure to
match your field names in Remark Web Survey to
those in the existing database.
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Property

Function

Question text

Use Question text to enter the text for the
particular question. Question text will also appear
on select reports when you analyze your data.
Question text is limited to 10,000 characters.

Display as rich text

Mark the Display as rich text checkbox to display
the question text in Rich Text format. Rich text
provides more formatting options than plain text
(e.g., font sizes, types and colors). See Chapter 7
for further details.

Insert answer pipe

Click the Insert answer pipe link to set up answer
piping. Answer piping displays information gathered
from a different question on the web form within
the question text. For example, if you ask for the
respondent‟s name, you can then “pipe” the name
into another question‟s text to make your form
appear more personalized (e.g., ”John, how do
would you rate your latest customer service
experience?”). (*Professional Version Only*)

Format

Use the Format button to format the question.
Formatting is covered in detail in Chapter 7.

Answers:
The Answers window allows you to set and format answer options.
Property

Function

Pre-defined scales

Use the Pre-defined scales drop-down list to
select an answer scale for the question‟s answers.
You can use this option for Checkbox, Option
Button and Drop-Down Box question types. You can
select a scale from the Pre-defined scales dropdown list, or edit or create an existing scale by
selecting the Edit scales link. You may also enter a
scale into the HTML Labels grid and then click the
Save scale link to add the scale to your list of
reusable scales.
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Property

Function

Default value

Use the Default value box to put default text in a
Textbox/Text Area style question. The text in the
text box/text area will automatically be downloaded
into the data set for the web form. This feature is
often useful for hidden textbox/text area questions
where you want to include data in your data file,
but do not wish to display it to the respondents.

HTML Display

Use the HTML Display column to enter a list of
answer choices as you want them to appear on the
web form. This list controls the display of answer
choices to your respondents. HTML Display text is
limited to 10,000 characters.

Labels

Use the Labels column to enter a list of answer
choices as you want them to appear in the resulting
data file. Enter one label to correspond with each
entry in the HTML Display column. As you type in
the HTML Display column, the same information will
automatically be entered into the Labels column
(without any special characters, which are not
allowed). You may modify the Labels as desired
(the Label text does not have to be the same as the
HTML Display text). The following characters are
not allowed in the Labels column: “'+,=(). Data
labels are limited to 240 characters.

Values

Use the Values column to enter a list of numeric
values associated with each Label. Values are used
to calculate statistics and are exported to certain
file formats, such as SPSS. As you type in the HTML
Display column, the Values are automatically
entered into the Values column sequentially. You
may modify the Values as desired, but each Value
must be unique. Note that the Values column will
not be visible when using the Numeric data type on
the Question Properties|General window. In
addition, values are not used as points awarded
when grading tests (points are assigned in the
Analysis portion of the properties window or the
Grade Wizard).
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Property

Function

Insert a choice to be
treated as a nonresponse

The Insert a choice to be treated as a nonresponse property applies to single-selection dropdown lists only. When selected, this property
inserts a choice that will replace a non-response.
Choose text from the list or enter your own. If
respondents leave the question blank, or choose a
valid response, then go back and choose this
response, the question will be treated as blank. If
the drop-down list is set as “required” this response
will not fulfill the question being answered and
respondents will be notified that they have not
answered a required question. This answer choice is
not passed down to Remark Quick Stats as a valid
answer when analyzing data.

Access current
answer‟s properties

Use the Access current answer’s properties link
to access each individual answer choice‟s options.
The items on the Answer Properties window are
described in detail in Section 5.7.6.

Limit the number of
answers allowed to

Mark the Limit the number of answers allowed
to checkbox to limit the number of responses
allowed for a Checkbox or Drop-Down Box that
allows multiple responses. Enter the maximum
number of responses allowed in the box. If
respondents choose too many responses, they will
receive an appropriate error message when they
submit the web form page.

Max exceeded error
message

Click the Max exceeded error message link to
customize the error message that respondents see
when they submit a web form page where they
have selected too many answer choices for a
question. If you do not customize the message, a
default message will be displayed.

Randomize answer
choices during display

Mark the Randomize answer choices checkbox to
have the answer choices for the question appear in
a random order every time the web form is
displayed.
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Attributes:
The Attributes window allows you to set more advanced settings for the
question.
Section

Property

Function

Attributes
and Display
Settings

Display question in
the data grid

Select the Display question in the
data grid checkbox to include the
question in the data grid when
opening or downloading data.
Note: When you have a data file
open, you may also right click a
question node and turn on or off
Display question in grid. Upon
returning to the Respondent grid, the
data will be refreshed accordingly.
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Section

Property

Function

Mark question as
required

Select the Mark question as
required checkbox to require a
question to be answered in order for
the web form page to be submitted
successfully. If respondents do not
answer the required question, they
will receive a “required question
missing” error message (see below).
Tip: If using single-selection dropdown lists, use the Insert a choice
to be treated as a non-response
property in the Answers window.
When selected, this property inserts a
choice that will replace a nonresponse. If respondents leave the
question blank, or choose a valid
response, then go back and choose
this response, the question will be
treated as blank. If the drop-down list
is set as “required” this response will
not fulfill the question being answered
and respondents will be notified that
they have not answered a required
question. This answer choice is not
passed down to Remark Quick Stats
as a valid answer when analyzing
data.

Missing error
message

Click the Missing error message link
to customize the error message that
respondents see when they submit a
web form page without responding to
a required question. If you do not
customize the message, a default
message will be displayed.
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Section

Property

Function

Hide question from
respondent

Mark the Hide question from
respondent checkbox to make a
question hidden. Hidden questions are
not visible and therefore cannot be
answered by a respondent. However,
a pre-selected response choice will be
submitted with the web form page.
Hidden questions are useful when you
want a piece of data to be included in
your data file but you do not
necessarily want respondents to see
the information. For example, suppose
you want respondents to answer the
same questions about three different
products. You could set up three
surveys, each with a hidden question
within the survey that identifies the
product. When downloading the data,
you will easily be able to see which
product the respondent is referencing.

Treat each answer
choice as a
separate question
item

Mark the Treat each answer choice
as a separate question checkbox to
output the responses from a Checkbox
or Drop-Down Box (allowing multiple
responses) to separate cells in the
data grid. Each possible answer choice
will occupy a field in the data grid.
When downloading data, the cells will
be filled for those answer choices that
respondents selected.
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Section

Property

Function

Mask text input

Mark the Mask text input checkbox
to mask the text that the respondent
types into a Textbox/Text Area
question type. This feature is most
useful for a password question on a
Login page so that others cannot see
the password that was used to gain
entry to a web form. You can,
however, use the mask formatting on
any Textbox/Text Area style question
to allow the entry of masked
information. The password/text will be
masked with asterisks (*) as the
respondent types information.

Column

Select the Column in which you want
the question. The number of columns
available is dependent on the Column
setting in the section to which the
question belongs. By placing questions
in columns, you can use more of the
available viewing space of the web
browser. Questions will be positioned
both across the page and down the
page if more than one column is used.

Answer box height

When inserting a Textbox question,
you can increase its height by adding
rows, which turns it into a Text Area.
A Text Area style question has
multiple rows and columns to
accommodate more text than a oneline textbox.
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Section

Behavior

Property

Function

Answer box width

When inserting a Textbox question,
you can increase its width by adding
columns. Note that the width of a
textbox is the same number of
characters respondents will be able to
type (e.g., a textbox with a width of
10 allows 10 characters). If using a
Text Area (multiple lines), the
Answer box width setting does not
limit the number of characters that
can be typed. However, respondents
will receive an appropriate error
message upon submitting the page if
they have entered too much text.

Answer choice
columns

The Answer choice columns setting
allows you to place answer choices in
multiple columns, side-by- side. This
feature is useful if you have a large
number of answer choices for an
option button or checkbox style
question. The answer choices will be
listed across the page in columns
instead of in one long column going all
the way down the web page.

Hyperlink

Mark the Hyperlink checkbox to have
the question display as a hyperlink.
Then type the hyperlink into the box
using a fully qualified URL or select a
question or page from the list. Use
caution when setting up questions as
hyperlinks; respondents will navigate
away from the current page. However,
the hyperlink for questions will always
display in a new browser window.
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Section

Property

Function

Associate response
with the following
query parameter

Mark the Associate a response with
a query parameter checkbox to pass
a hidden value into the web form‟s
data dynamically. Enter a name for
the query. Then when generating
URLs for the web form, append the
query parameter name and value to
the URL that is sent to respondents.
See Section 5.7.5.b for detailed
information about using query
parameters.
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Section

Property

Function

Input Pattern

Ensure input
conforms to this
pattern

When using a textbox style question
(single line only) you can force a
pattern for the characters entered by
your respondents by marking the
checkbox for Ensure input conforms
to this pattern. For example, if
respondents are entering phone
numbers, you may want the pattern to
be (000) 000-0000. By default, you
can choose Date, Phone and Social
Security Number patterns. However,
you may also create your own
patterns by clicking the down arrow
on the textbox and choosing Edit
Input Patterns (or simply type your
pattern in the box and click the Save
icon). In the Input Pattern Editor
box, click the New button and then
type your pattern in the box. When
entering a pattern, use a 0 to
represent numeric characters, an A to
represent alpha characters and an X
to represent alphanumeric characters.
For example, if you wanted your
pattern to be a phone number without
the parentheses, you might put use:
000-000-0000. When respondents
enter their phone numbers, they will
need to format it like: 123-456-7890
or an error will occur when they
submit the page. You should tell
respondents the pattern you are
expecting either in your question text
or in a label near the question. Note
that if you want the literal characters
0, A or X to appear in your pattern,
you need to enclose them in
quotations (e.g., “X”).
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Section

Property

Function

Input pattern error
message

If a respondent submits a page
without following the appropriate
textbox formatting the following error
will appear: The response does not
conform to the specified input pattern
for this question. If you would like to
customize this error, click the Input
pattern error message link and
adjust the text (includes the ability to
format the text).

Analysis:
The Analysis window allows you to set properties for grading tests and
tabulating surveys.
Property

Function

Include question in
grading process

Mark the Include question in grading process
checkbox to indicate the question should be graded
in Remark Quick Stats. If this option is not selected
the question will not be included in a grade
operation.

Treat as a subjective
question

Mark the Treat as a subjective question
checkbox to include subjective points when grading
a test. Subjective questions contain a point value to
be added to the objective portion of the test that
Remark Web Survey can automatically calculate.
The question must be of the numeric data type to
be used as a subjective question.

Include question in
tabulation process

Mark the Include question in tabulation
process checkbox to tabulate responses from the
question in Remark Quick Stats. If this option is not
selected the question will not be included in a
survey tabulation operation.
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Property

Function

Points awarded for
correct response

Use the Points awarded for correct response
item to select how many points to award for correct
answers when grading a test.

Points awarded for
incorrect response

Use the Points awarded for incorrect response
item to select how many points to award or
subtract for incorrect answers when grading a test.

Points applied if
question is skipped

Use the Points awarded for incorrect response
item to select how many points to award or
subtract if a question is not answered when grading
a test.

Missing value

Use the Missing value textbox to enter a value
Remark Web Survey will use when a question is not
answered or characters appear in the response that
do not match the pre-defined scale. Missing data is
anything that doesn‟t match the Labels you defined
for the question, including blank responses. You can
set the missing value on a question by question
basis. The default missing value is -1. Only numeric
characters are allowed. Missing values can be
reported in Remark Quick Stats and are exported to
other applications when saving data.

Mark question as the
respondent identifier
in the analysis

Select the Mark question as the respondent
identifier in the analysis checkbox to include the
question‟s responses as an identifier on various
reports. For example, if you are grading student
exams and want the students‟ ID numbers or
names to be on analysis reports, you can mark the
corresponding question on the web form as a
respondent identifier. The item must be “ungraded”
in order to be used as a respondent identifier
question.
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Database Link:
The Database Link window allows you to establish a link to an external database
so that you can extract information from that database. It provides an easy way
to get external data into your web form‟s data for analysis. To use this feature,
you link a question on the web form to an existing database. Once the data a
respondent enters is found in the linked database, you can replace it with other
information from that database (called Append fields). When the data are
downloaded, Remark Web Survey will look for the data that was entered as the
question‟s response in the linked database field. Remark Web Survey will then
output any selected append fields in the data file. If the data are not present in
the database field, Remark Web Survey will fill the data cell with the response
that was entered, but will not display any of the append field information (which
comes directly from the linked database).
For example, suppose you ask respondents for an identification number on a
web form. In an external database, you have that identification number listed
along with other information about each respondent (perhaps their name, email
address or other demographic information). Using the Database Link feature,
when the data for the web form are downloaded, Remark Web Survey will look
up each identification number in the external database and then return the
associated demographic information from the database to your Remark Web
Survey data file. You can have multiple Append fields if desired.
The following table describes the database link properties:
Property

Function

Enable database link

Mark the Enable database link checkbox to link a
question to an existing database. This feature
allows you to add fields to the Remark Web Survey
data by outputting information from other field(s)
within the database.

Database connection
settings

Click the Database connection settings link to
set up a connection to the database you wish to
use.

Type

Choose the type of database you wish to use from
the Type drop-down list.

Browse

Click the Open folder to select the database
containing the desired information.

135

Remark Web Survey User’s Guide

Property

Function

DSN

If using an ODBC connection, choose the DSN from
the DSN drop-down list. Mark whether it is
Directory based or DSN based.

Username

If your database requires a login, enter the
Username.

Password

If your database requires a login, enter the
Password.

Connection string

Displays the connection string that is working
behind the scenes to connect to your selected
database. You do not need to edit this string; it is
for informational purposes only.

Test Connection

You may optionally click the Test Connection
button to test whether you can connect to this
database.

Table name

Use the Table name list to select the table from
your database that contains the information you
wish to lookup.

Reference field

Use the Reference field list to select the field in
the connected database to which you want to link
this question. When the data are downloaded, the
respondents‟ answers will be verified against the
values in this database field. If the response is
found in the database field, Remark Web Survey
will output the Append value(s). If the answer is
not found in the database field, Remark Web
Survey will leave the Append fields blank. Mark the
checkbox for Include field in data if you want to
both lookup and output the Reference field.
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Property

Function

Append fields

Use the Append fields list to select a field in the
connected database to return when the Reference
field is verified. To look up the value and then
replace it with a different database field‟s
information, select the appropriate field(s) in the
Append fields list. Place a checkmark in the fields
you wish to append to the data. Use the Alias
column to provide a field name for Remark Web
Survey to use. If desired, mark the checkbox for
Respondent ID to include the field‟s data on select
analysis reports.

To use the Database Link feature, first follow the steps below to insert a
question. Then click Database link in the Question Properties window and
enter the information as outlined above. If you move the database to a new
location or rename it, the link is broken. When this happens two things can
occur:
1. When opening a web form with a broken database connection, Remark Web
Survey will detect the broken connection and display a warning screen (if
this setting is turned on in the
Program Options). Click Yes to
repair the connection (e.g.,
reconnect to the right database).
Click No to leave the broken
connection as is for this sesion and
not perform any database linking
at this time. Click No to All when
using multiple append fields and
you do not desire to utilize
database linking at this time.
2. Under the Tools tab on the Ribbon you will find a button called Sync with
Database. When you set up Database Link, you tell the software where to
find your linked database. If the database is moved or renamed, use the
Sync with Database option to quickly relink the database to your web
form. When you select this option, a window will appear where you can
select the database to re-establish the link. This option is available when
you are in the Data Viewer view.
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To insert question elements
1

Select an insertion point in the tree view. You must be within a section to
insert a question.

2

From the Ribbon, select the
Insert tab and then click
Question. The Question
Properties window appears.

3

You must select a Question type
and if using Checkbox, Option
Button or Drop-Down Box style
questions, you must enter the
answer choices on the Answers
window.

4

If desired, utilize the other
properties within the Question Properties window, as described
previously.

5

Click the OK button to save the question.

The question is added to the tree view and is visible in the HTML Preview
window.
5.7.5.a Answer Piping
(*Professional Version Only*)
Displaying the answer to one question in the text of another subsequent
question, label or answer is called answer piping. For example, if you ask for the
respondent‟s name, you can then “pipe” the name into another question‟s text
to make your form appear more personalized (e.g.,”John, how would you rate
your latest customer service experience?”). Note that in order to use answer
piping, the question from which you are drawing the answer must be on a
previous page from the question or label where you are adding the answer pipe.
Note: Using answer piping in answer elements is covered in Section
5.7.6.b.
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To use answer piping in a question
1

Select an insertion point in the tree view. You must be within a section to
insert a question.

2

From the Ribbon, select the Insert tab and then click Question. The
Question Properties window appears.

3

You must select a Question type and if using Checkbox, Option Button or
Drop-Down Box style questions, you must enter the answer choices on the
Answers window.

4

If desired, utilize the other properties within the Question Properties
window, as described previously.

5

Click the Insert answer pipe link.

6

Under Source Question, choose the Question that will contain the answer
you wish to pipe into the current
question. Remember that the source
question must be on a different
page than the current question.
When selecting questions, you may
display the question by question text
or field name using the radio
buttons for each on the screen. The
Answer Pipe example window
shows you how the question will
appear in the properties window and
on the actual web form.
Note: If using a Login page, you can use the Username, Name and
Email fields from the Login page as source questions.

7

Click the OK button to return to the
Question Properties window. You
will see the question text from the
question you inserted as an answer
pipe. This text is a placeholder for
the piped answer. You may not
change the text. However, you may
format the text. For example, you
can click within the pipe
placeholder, turn on rich text
formatting and apply font
characteristics to the text. You may
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also add punctuation or other text around the pipe placeholder. If you need
to delete the answer pipe, click anywhere inside of the pipe text and press
the Delete key on your keyboard. To edit an existing answer pipe, click the
placeholder text, click Insert answer pipe and then choose a new
question. The old answer pipe question text will be replaced with that of the
new question.
8

Click the OK button to save the question.

To use answer piping in a label
1

Select an insertion point in the tree view. You must be within a section to
insert a label.

2

From the Ribbon, select the Insert tab and then click Label. The Label
Properties window appears.

3

Enter and format the Label text.

4

If desired, utilize the other properties within the Label Properties window,
as described previously.

5

Click the Insert answer pipe link.

6

Under Source Question, choose
the Question that will contain the
answer you wish to pipe into the
current label. Remember that the
source question must be on a
different page than the current
label. The Answer Pipe example
window shows you how the label will
appear in the properties window and
on the actual web form.

7

Click the OK button to return to the
Label Properties window. You will
see the question text from the
question you inserted as an answer
pipe. This text is a placeholder for
the piped answer. You may not
change the text. However, you may
format the text. For example, you
can click within the pipe placeholder,
turn on rich text formatting and
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apply font characteristics to the text. You may also add punctuation or other
text around the pipe placeholder. If you need to delete the answer pipe,
click anywhere inside of the pipe text and press the Delete key on your
keyboard. To edit an existing answer pipe, click the placeholder text, click
Insert answer pipe and then choose a new question. The old answer pipe
question text will be replaced with that of the new question.
8

Click the OK button to save the label.

Once the answer piping is applied to your web form, respondents will answer
the “source” question, and then when they arrive at the question or label in
which you included the answer pipe, they will see the answer they typed into
the source question.
5.7.5.b Query Parameters
(*Professional Version Only*)
Using Query Parameters allows you to pass hidden information into a web form.
When using hidden textbox questions, you can associate a Query Parameter
with the textbox. When the URL to the web form is sent out, the Query
Parameter is appended to the URL. When the web form is submitted, the value
for the Query Parameter is sent down to the data file.
For example, suppose you are doing course evaluations. You could set up a
hidden textbox question with a Query Parameter called Instructor. When
sending out URLs to respondents, you could append the Query Parameter name
plus an instructor‟s name to the URL. When students fill out the evaluation, the
instructor they are evaluating will be listed in the data. However, the students
do not have to enter this information, thus reducing the chance of error (you
probably do want to let them know the instructor they are evaluating when you
send them invitations to fill out your web form). You can even take this one
step further if students have a web portal. Students could login to the portal
and have several course evaluation URLs listed with an instructor name. Each
URL would have the instructor Query Parameter included, but the value would
be for different instructors. Students could click each URL to rate the various
instructors, but would not need to type in the instructor‟s name each time.
When you receive students‟ data, you would automatically know which
instructor was being evaluated. (In this scenario you would need to let them
know which instructor they are evaluating in your portal.)
This functionality is similar to using default fill values in textboxes, but allows
you to change the default fill on the fly without changing the web form.
The syntax for the URL when using Query Parameters is as follows:
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http://www.example.com/cgibin/rws5.pl?FORM=formname&queryparametername=queryparametervalue
In the course evaluation example above, the URL would look like the following:
http://www.example.com/cgibin/rws5.pl?FORM=formname&Instuctor=JohnDoe (where John Doe is the name
of the instructor being evaluated)

To use Query Parameters
1

Create a textbox style question by clicking Insert on the Ribbon and
choosing Question.

2

For Question type, select Textbox/Text Area.

3

[Optional] Enter the desired Field Name.

4

[Optional] Enter the desired
Question Text.

5

Click the Attributes link in the left
side of the window.

6

Mark the checkbox for Hide
question from respondent.

7

In the Behavior section, mark the
checkbox for Associate response
with the following query
parameter.

8

Enter a name for the query
parameter in the associated
textbox. We suggest keeping the name short as it will become part of the
URL in your web form link.
Note: The following words are reserved and cannot be used to
name query parameters: FORM, UID, USER, PWD, PWDE,
POPUPINFO, ENC.

9

Modify any other settings as desired for the question.

10 Click the OK button to save the question.

Once the form is published, you will be able to send out URLs to respondents
that include the desired Query Parameter value. This value will be included in
each respondent‟s data file. If you send the URLs out independently of Remark
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Web Survey, you will need to manually put the query parameter value into each
email (or merge it). If you send the URLs via Remark Web Survey‟s email
center, you can use advanced options to append the query parameter value.
Tip: The Email Center is covered in detail in Section 9.8. You may
wish to review this section and gain a full understanding of the
Email Center before you attempt to use it to send Query
Parameters.

To send emails using query parameters from Remark Web Survey
1

When the web form is finalized, published and tested (e.g., you are ready to
go live), access the email center from the Ribbon by selecting the Tools tab.

2

Click the down arrow on the Send Invitations button and choose
Advanced.

The Advanced Invitation Setup window appears.
3

[Optional] If the web form is password protected and you wish to embed the
password (and username if applicable) into the URL invitation, click the
Include the web form credentials (username/password) checkbox. If
the web form is not password protected or you do not want to embed the
credentials, skip to step 4.

4

Mark the Include predefined query
parameters checkbox.

5

[Optional] If you want the query
parameter to be encrypted (masked)
mark the Encrypt the query
parameter values checkbox. This
option will encrypt the value you
insert for each query parameter so
that respondents cannot decipher it
in the web form invitation/reminder
URL.

6

The table displays the query parameters you have defined in the web form.
Place a checkmark in the Include column for any parameters you wish to
include while sending this email.

7

Enter the desired value in the Parameter Value box. This value will be
appended to the invitation URL and passed down into the data via the field
in which you specified the query parameter. For example, if you were
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sending a link to a course evaluation and set up a query parameter called
“Instructor”, you would enter the instructor‟s name as the Parameter Value.
The name will be passed into your hidden question and appear in the
Instructor field when you download respondents‟ data. When you want
students to evaluate a different instructor, you enter a new Parameter Value
and then send out the invitations.
8

Click the OK button. The Email Message window appears. At this point you
can modify the rest of the email prior to sending it. Formatting the Email
Message window is covered in detail in Section 9.8.
Tip: You could build a “cover” page with instructions for completing
the form. On that cover page could be the hidden Query Parameter
question. The value for that Query Parameter could then be passed
to a label through Answer Piping on the header of every page. In
the course evaluation example described previously, the header
could display the instructor being evaluated, which would be piped
from the Query Parameter on the first page.

5.7.6 Answer Element Properties
When you insert a question on the web form, you can set up the answer
choices, which become answer elements in the tree view. The answer elements
can be further defined through the Answer Properties window. You can access
this window in one of three ways:
Double click an answer element in the tree view.
Right click an answer element in the tree view and select Properties
from the menu.
Select an answer element in the tree view and then select Properties
from the View tab in the Ribbon.
The following items can be customized through the Answer Properties
window:
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Property

Function

Field name

Use the Field name to create a name for the
answer, which will be used as a column header in
the data grid. Setting field names for individual
answers is most useful when using Checkbox or
Drop-Down Box style questions that output the
answers in separate data grid cells. This feature
allows you to give each answer choice a unique
field name for clarity and/or matching data to an
existing external database or file. When planning to
export data, be sure to follow your export format‟s
guidelines for field naming conventions. In addition,
if you will be saving data to an existing database
file, be sure to match your field names in Remark
Web Survey to those in the existing database.

HTML display

Use the HTML Display column to enter the text for
answer choices as you want it to appear on the web
form. This list controls the display of answer
choices to your respondents. HTML Display text is
limited to 10,000 characters.

Insert answer pipe

Click the Insert answer pipe link to set up answer
piping. Answer piping displays information gathered
from a different question on the web form within
the answer text. For example, if you ask someone
who just purchased a new car the color they chose,
you can then “pipe” the color into another
question‟s answer to make your form more
personalized (e.g., ”How much did the color silver
influence your decision to purchase this car?”).
Please see Section 5.7.6.b to understand more
about how answer piping is used in answer
elements. (*Professional Version Only*)

Enable rich text
formatting

Mark the Enable rich text formatting checkbox to
display the answer text in Rich Text format. Use the
box above the checkbox to format the text. Rich
text provides more formatting options than plain
text (e.g., font sizes, types and colors). See
Chapter 7 for further details.
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Property

Function

Display an associated
image or answer
illustration

To use an image as part of your answer display to
respondents, mark the Display an associated
image or answer illustration checkbox. Then
click the image icon next to the box and choose the
desired image file. Supported file formats include
JPG/JPEG, GIF and PNG. Using images as answer
items is described in greater detail in Section
5.7.6.a.

Data label

Use the Data Label box to enter the answer choice
as you want it to appear in the resulting data file.
The following characters are not allowed for answer
data labels: “'+,=(). Data labels are limited to 240
characters.

Value

Change or enter the numeric Value associated with
the Label. Values are used to calculate statistics
and are exported to certain file formats, such as
SPSS. When you are creating questions, the Values
are automatically entered into the Values column
sequentially as you type in the HTML Display and
Labels columns. You may modify the Values as
desired, but each answer choice‟s value should be
unique. When grading tests, values are not used to
calculate points earned (this is handled in the
“Analysis” section of the question properties
window). Note that the Values property is not
visible when using the Numeric data type on the
Question Properties|General window.

Preselect answer
choice by default

Mark the Preselect answer choice by default
checkbox to preselect the selected answer choice
when the web form page is displayed to the
respondent. Respondents can still choose another
answer choice, but the preselected answer choice
will automatically be selected if they do not choose
a different answer.
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Property

Function

Append a textbox/text
area to this answer

Mark the Append a textbox/text area to this
answer checkbox to automatically append a
textbox to an answer choice. This option is most
useful when you have a multiple choice style
question that allows for an “other” option (e.g.,
select your favorite color: Red, Blue, Green, Other).
The textbox/text area allows respondents to write
in another response. You can have just one
textbox/text area or multiple textboxes/text areas
per question. When the data are collected for the
question, the typed text is placed in the data cell in
place of the word “other” (or whatever word you
use to define that answer choice).

Treat appended item‟s
answer as a separate
question with field
name

Mark the Treat appended item’s answer as a
separate question with field name checkbox to
have the “other” text entered into the textbox be its
own data field. Without this option marked, the
data replaces the answer choice that was defined.
For example, if the last option button for the
question is “Other”, treating the appended textbox
as a separate question will give you one data cell
with the word “Other” and a separate data cell with
the write-in text from the respondent.

Mark appended
answer item as
required

Mark the Mark appended answer item as
required checkbox to ensure that if respondents
choose the “Other” textbox‟s answer choice, they
must also fill something in for the appended
textbox. If they select the option for “Other” but do
not put something in the appended textbox, they
will receive an appropriate error message when
they submit the page.
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Property

Function

Set the maximum
length of response
characters to

Mark the Set the maximum length of response
characters to checkbox to limit the number of
characters allowed for a Textbox/Text Area style
question. Enter the maximum number of characters
allowed in the box. For a textbox (single line of free
text) respondents will not be able to enter more
characters than you allow. For a text area (multiple
lines of free text), respondents will receive an
appropriate error message when they submit the
web form page if they entered too many
characters.

Max exceeded error
message

Click the Max exceeded error message link to
customize the error message that respondents see
when they submit a web form page with either too
many answer choices selected (Checkbox or DropDown Box style question) or too much text entered
(Text Area style question). If you do not customize
the message, a default message will be displayed.

Hyperlink

Mark the Hyperlink checkbox to have the answer
display as a hyperlink. Then type the hyperlink into
the box using a fully qualified URL or select a
question or page from the list. Use caution when
setting up answers as hyperlinks; respondents will
navigate away from the current page. However, the
hyperlink for answer choices will always display in a
new browser window.

Format

Use the Format button to format the style of the
answer choice. Formatting is covered in detail in
Chapter 7.

To insert answer elements
1

Select an insertion point in the tree view. You must be on a question or
answer element to insert an answer element.
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2

From the Ribbon, select the Insert
tab and then click Answer. The
Answer Properties window
appears.

3

None of the properties in the
Answer Properties window are
required. You will typically want to
fill in the HTML Display, Label
and Value, but all properties are
optional.

4

Click the OK button to save the
answer.

The answer is added to the tree view and is visible in the HTML Preview window.
5.7.6.a Using Images as Answer Elements
As described in the previous table, you may use an image as part of the answer
that you display to respondents. For example, suppose you want to display a
product image or mathematical equation; you could insert an image as part of
the answer choice. Images can be in the JPG/JPEG, GIF or PNG formats. The
image can be placed to the right, left, top or bottom of the HTML Display text (if
you have entered HTML Display text).

To insert images as answer elements
1

Select an insertion point in the tree view. You must be on a question or
answer element to insert an answer
element.

2

From the Ribbon, select the Insert tab and
then click Answer. The Answer
Properties window appears.

3

If desired, type in a Field Name and the
HTML Display text.

4

Mark the checkbox for Display an
associated image or answer
illustration.

5

Click the image icon next to the checkbox.
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6

Click the Select image hyperlink.

7

Choose the desired image. Images can be
in the following formats: JPG/JPEG, GIF,
PNG.

8

The original dimensions are displayed. If
you wish to adjust the dimension, enter
new pixel values in the Height and Width
boxes. If you want the aspect ratio to
remain the same between width and
height, mark the Maintain aspect ratio
checkbox. As you adjust width or height,
the other will adjust automatically. Please note that making adjustments to
the size within Remark Web Survey does not affect the original image.

9

If desired, enter alternate text in the Alternate text textbox. This text
appears while the image is loading and when you hover the mouse over the
image, and can be read by screen readers (this is useful if you want web
forms to be Section 508 compliant for handicapped persons).

10 If desired, mark the checkbox for Hyperlink and then enter a hyperlink

(fully qualified URL) in the associated textbox. A hyperlink will be applied to
your image, meaning that if someone clicks the image, they will be
redirected to another web page in a new browser window. Please note that it
is possible to add hyperlinks for the image element as well as the answer
element as a whole (on the previous screen). The hyperlink applied to the
image element will only take effect when the image is clicked. The hyperlink
applied to the answer element will only take effect when the HTML Display
text is clicked.
11 Click the OK button to save the image element information.
12 Continue defining any other desired properties for the answer element.
13 Click the OK button to save the answer element.

The answer is added to the tree view and is visible in the HTML Preview window.
In the tree view, you will see the name of the image file you selected. If you
wish to format the position of the image (left, right, top or bottom of the HTML
Display text), double click the answer node in the tree view and then click the
Format button. For Image Position select Left, Right, Top or Bottom.
Note: You may need to adjust the answer element‟s line break
property to get the image and HTML Display text to appear just as
you wish.
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5.7.6.b Answer Piping with Answer Elements
Answer piping was described in detail in Section 5.7.5.a for use with Labels and
Questions. However, answer elements can also have answer pipes within them.
Displaying the answer to one question in the text of another subsequent
question, label or answer is called answer piping. For example, suppose you are
surveying new car owners. You ask a question on page one about the color of
the car they purchased. Then on page two, you ask a question about what
influenced their decision to purchase the car. One of your answer choices could
include the color of the car they purchased. You would use answer piping to
“pipe” in the color they entered on page one of the survey. Note that in order to
use answer piping, the question from which you are drawing the answer must
be on a previous page from the answer where you are adding the answer pipe.

To use answer piping in an answer
1

Insert a question or individual answer element, as described in previous
sections.

2

Go to the answer item to which you wish to add the answer pipe. You can
get to the answer item‟s properties either through the question properties
window or the answer properties window:

Question Properties Window

Answer Properties Window

a. Go to the Answers portion of
the Properties window.

a. Click Insert answer pipe.

b. In the answers grid, select the
answer to which you wish to add
the answer pipe.
c. Click Access current answer’s
properties.
d. Click Insert answer pipe.
3

Under Source Question, choose the Question that will contain the answer
you wish to pipe into the current answer. Remember that the source
question must be on a different page than the current question. When
selecting questions, you may display the question by question text or field
name using the radio buttons for each on the screen. The Answer Pipe
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example window shows you how the
answer will appear in the properties
window and on the actual web form.
Note: If using a Login page,
you can use the Username,
Name and Email fields from
the Login page as source
questions.
4

Click the OK button to return to the Answer Properties window. You will
see the question text from the question you inserted as an answer pipe. This
text is a placeholder for the piped
answer. You may not change the
text. However, you may format the
text. For example, you can click
within the pipe placeholder, turn on
rich text formatting and apply font
characteristics to the text. You may
also add punctuation or other text
around the pipe placeholder. If you
need to delete the answer pipe,
click anywhere inside of the pipe
text and press the Delete key on
your keyboard. To edit an existing
answer pipe, click the placeholder text, click Insert answer pipe and then
choose a new question. The old answer pipe question text will be replaced
with that of the new question.

5

Click the OK button to save the answer.

Once the answer piping is applied to your web form, respondents will answer
the “source” question, and then when they arrive at the question containing the
answer in which you included the answer pipe, they will see the answer they
typed into the source question as part of the answer text.
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5.8 Question Tables
Questions that have the same answer set and/or are of the same type (e.g., all
textboxes) can be placed in a question table. A question table places the
questions in table format. For a question and answer set to be the same, the
number of answer choices must be the same, and the HTML Display choices
must be identical.
When it comes to question tables, there are two concepts:
Placing questions with the same answer choices in a table format
Placing questions with the same answer choices in multiple tables, also
known as side-by-side tables
These two concepts will be described separately.

5.8.1 Table Formatting
When you have questions that use the same answer scale, you may wish to
place them in a table format instead of one by one down the web page. Only
questions of the same type can be placed in a table format (e.g., all option
buttons or all checkboxes).
Note: This section discusses inserting and modifying question
tables, including question text, answer items and so forth. It does
not cover the style properties that are available for question tables
(e.g., shading rows and columns, fonts, table alignment, etc.).
Please see Chapter 7 for detailed information about the options that
are available when formatting question tables.
The following example shows option button style questions in a table:
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The following example shows the same option button style questions, but not in
a table:

The following criteria must be met in order to place questions in tables:
Questions must be of the same type (e.g., all option button responses)
Questions must have the same set of answer choices
Questions may not have the option to treat each answer choice as a
separate question enabled
There are two ways you can place questions in a table format:
Placing existing questions in a table by right clicking the questions and
choosing Insert into question table
Inserting a question table from the Ribbon

To format existing questions
1

Select the questions you wish to place in a table. You can multi-select
questions by holding down the Ctrl or Shift key as you click them in the
tree view.
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2

With all questions selected, right click the mouse and choose Place in
Question Table from the menu.
Note: Do not release the Ctrl or Shift key until after you right click
the mouse.

The questions will automatically be placed
into a table. You may edit the table by
clicking the Question Table node in the tree
view. The Question Table Properties
window will appear. You can use the next set
of instructions to understand the Question
Table Properties window (the instructions
detail inserting a question table, but once in
the table, they apply to existing tables as
well).

To format questions in a table using the Ribbon
When inserting a question table, you will add the questions and answer choices
using the Question Table Properties window.

1

From the Insert tab in the Ribbon, select the down arrow on the Question
button and click Question Table. The Question Table Properties window
opens.

2

Click the Insert Row button to insert
a row that will hold your question text.
The Question Text Editor appears.

3

In the Question Text Editor window,
type the question text for the question
and format it as desired. Question text
is limited to 10,000 characters.
Note: Answer Piping is allowed in questions that are placed in
Question Tables using the Insert pipe link. It is used the same as
when inserting single questions. You won‟t be able to add the piping
until after you add the question (click the question text to return to
the Question Properties window for editing). See Section 5.7.5.a for
information about using Answer Piping with questions.

4

Repeat steps 2 and 3 to insert more questions if desired.
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5

To insert answer items for the questions,
click the Insert Answer Group
Column button. The answer columns
represent the answer choices for each
question. The answer column applies to
all questions within the table (although
you can remove answer items for
individual questions). If you are simply
formatting questions with the same scale
in a table, you will only insert one
answer column. (See Section 5.8.2 for detailed information about inserting
side by side tables with more than one set of answer choices.)

6

In the Question type drop-down box choose the type of question you are
inserting: Textbox/Text Area, Checkbox, Option Button, Drop-Down Box.

7

Choose the Data type: Textual or Numeric.

8

If desired, enter a Table Header. The table header is placed above the
answer choice labels in the table and is optional. Table Headers are limited
to 10,000 characters.

9

Click the Answers item on the left of
the Answer Group Properties window.

10 If using a Checkbox, Option Button or

Drop-Down Box question type, enter the
HTML Display, Labels and Values (or
select a pre-defined list).
11 If desired, utilize any of the other

properties in the Answer Group
Properties window.
12 Click the OK button to insert the answer group.
13 Click the OK button again to insert the question table.

The questions are automatically placed into a table. You may edit the table by
clicking the Question Table node in the tree view. The Question Table
Properties window will appear.
Note: To format the style of the question table, click the Format
button. See Chapter 7 for detailed information about formatting.
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5.8.2 Side-by-Side Tables
Remark Web Survey provides the ability to place two or more tables of
questions side-by-side. This feature is useful when you want to ask the same
set of questions for two different purposes. For example, a respondent may
answer the same set of questions for ranking areas of satisfaction and how
important each area is to him or her. When adding multiple question sets using
the Question Table Properties window, you may use two different types of
answer formats. For example, you can use option buttons to rank satisfaction
and then textboxes to allow the respondent to enter supporting comments.
The following is an example of a side-by-side table with the question text in the
middle.

Side-by-Side table formatting is accomplished by using the same Question
Table Properties window as described in the previous section. When pairing
questions, you enter the question text once and then add as many answer
columns as you wish. The individual answer columns can contain different styles
of answers (e.g., checkboxes and option buttons).

To format questions in side-by-side tables
1

From the Insert tab in the Ribbon, select the down arrow on the Question
button and click Question Table. The Question Table Properties window
opens.

2

Click the Insert Row button to insert a row that will hold your question.

3

In the Question Text Editor window, type the question text for the
question and format it as desired. Question text is limited to 10,000
characters.

4

Repeats steps 2 and 3 to insert more questions if desired.
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5

Click the Insert Answer Group Column button. The answer columns
represent the answer choices for each question. Insert multiple answer
columns to create more question groupings. The answer column applies to
all questions within the table (although you can remove answer items from
individual questions).

6

In the Question type drop-down box choose the type of question you are
inserting: Textbox/Text Area, Checkbox, Option Button, Drop-Down Box.

7

Choose the Data type: Textual or Numeric.

8

If desired, enter a Table Header. The table header is placed above the
answer choice labels in the table and is optional. Table Headers are limited
to 10,000 characters.

9

Click the Answers item on the left of the Answer Group Properties
window.

10 If using a Checkbox, Option Button or Drop-Down Box question type, enter

the HTML Display, Labels and Values (or select a pre-defined list).
11 If desired, utilize any of the other

properties in the Answer Group
Properties window.
12 Click the OK button to insert the

answer group.
13 Repeat steps 5 – 12 to insert

additional
answer groups. Note that the
question text applies to all answer
groups.
14 Once you have created all of the

answer groups, to position them, click the
header of the answer column in the
grid and then use the mouse to drag
and move the groups around. The
order in which you see them in this
window is the order in which they will
appear on-screen.
15 To position the question text, enter

the column in which you want the
question text in the Question text
position box. If you have two answer
columns and want the question text
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to appear in the middle of them, enter 1 in this box. (A position of 0
indicates the question text is all the way to the left.)
16 Click the OK button to insert the question table.

The questions will automatically be placed into a table. You may edit the table
by clicking the Question Table node in the tree view. The Question Table
Properties window will appear.
Note: Each answer group does not have to have the same number
of answer items. Also, each question does not have to correspond
to every answer group. For example, if you have two answer groups
set up, you could have a question (or questions) within the table
pertain to only one of the answer groups.

5.8.3 Modifying Question Tables
Once the table is set up, you cannot change certain features for individual
questions, such as the actual answer choices (they must remain constant).
However you can change properties such as formatting, whether a question is
required, whether to grade or tabulate a question, etc.

To modify a question table
1

Double click the table node that you wish to modify in the tree view. Tables
are represented by the syntax Question Table (5) in the tree view, where
the number in parentheses is the number of questions in the table. Use the
Question Table Properties window to make modifications.
To modify question text, click the question‟s link in the Question Text
cells to display the Question Text Editor window. Question text is limited
to 10,000 characters.
To modify individual answer items,
click the Edit link within the answer
column. Choose Delete to remove the
answer item. Choose Import to
import an existing question from the
web form into the answer column.
Note that only questions that have the
same format as the existing answer
column will be available for importing
(see Section 6.8.3.a for further
details). Choose Properties to edit
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the answer item. When accessing
properties, you will be able to modify
the properties on the Attributes and
Analysis windows only.
To modify an entire group of answer
items, highlight the answer column and
then click the Modify Answer Group
Column button at the top of the
window. The Answer Group
Properties window appears, where you can change question types,
modify answer choices, format text, etc. Changes made with this method
affect the entire answer group.
2

Click the OK button when you are finished modifying the question table.

5.8.3.a Importing Questions into a Question Table
When clicking the Edit link within an answer item in a question table you will
also notice an option called Import. This option allows you to import a question
from another area of the web form into the question table. You can import a
copy of the question or move the question from its original position to the
question table. You have the choice of overwriting an existing question in the
table or importing the question as a new question in the table. You may only
import questions that are not currently within a question table.

To import questions into a question table
1

Insert a question table or double click the table node that you wish to
modify in the tree view. Tables are represented by the syntax Question
Table (5) in the tree view, where the number in parentheses is the number
of question rows in the table. Use the Question Table Properties window
to make modifications.

2

Determine whether you want to overwrite
an existing question or insert a question
into the table as a new question. To modify
an existing question, click the Edit link
within the corresponding answer column.
To add a question to the table, click Insert
Row to insert a placeholder for the
question you will import and then click the
Edit link in the corresponding answer
column. In either case, then choose
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Import from the Edit menu to import
a question into the table.
3

Select a question from the drop-down
list titled Question to import. Note
that only questions with the selected
answer scale (listed in the Import
requirements section of this window)
will be visible in the drop-down list.

4

If you would like to import a copy of
the question and also leave the question in its original position, mark the
checkbox for Import a copy of the selected question.

5

Click the Import button.

6

If you are not importing a copy of the question, a prompt will appear
confirming that you want to import the question and remove it from its
original position. Click Yes to import the question or click No to return to
the Question Table Properties window.

7

If you selected an existing question to overwrite with the imported question,
when you click Yes in step 6 (or if you are importing a copy of the
question), a prompt will appear asking if you wish to overwrite the question
text of the selected question. You have three options:
Click Yes to overwrite the existing question text in the table with that of
the question you are importing.
Click No to keep the question text
that is already in the question
table, but still import the question
(even though your answer items
are the same as the existing
question, any other attributes will
be imported).
Click Cancel to cancel the import and return to the Question Table
Properties window.

8

Click the OK button to complete the import and close the Question Table
Properties window.

161

Remark Web Survey User’s Guide

5.8.3.b Extracting questions from a question table
You may extract questions from a question table, in which case they will be
pulled out of the table and listed in the tree view beneath the table. When you
extract questions from a table, the questions will utilize the page style
attributes defined in the Format Options window.

To extract a question from a question table
1

Expand the question table in the tree
view until you can see the question text
of the question(s) you wish to extract.

2

Select the question(s) you wish to
extract.

3

Right click the mouse and then choose
Extract Question from Table from the
menu. The question(s) will be removed
from the table and added to the tree
view after the question table.

5.9 Form Buttons
The various form pages can have a combination of buttons on them depending
on the purpose for the page. By default, each page type has certain buttons
added automatically. Buttons are added to their own Page Buttons section to
help make positioning them easier. The button section has 10 columns by
default so that you can move the buttons around to suit your needs. You can
adjust the section settings as desired. The functionality of each button type is
described below. Each button can be titled with any text that you like, but some
of the common uses are below.
Submit/Next: Submits all data on the current page. This button can be
titled Submit, Next, Send Reminder (Session Pause pages), Login (Login
pages), etc.
Reset: Resets all data on the current page to its original state (blank).
Back: Takes the respondent back to the previously loaded page. All data
that was submitted from this page will be displayed.
Session Pause: Pauses the web form at the current submission point
and allows the respondent to enter an email address to which a reminder
will be sent with a link back to the web form for completion. If using a
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Session Pause page, you need to place Session Pause buttons on at least
one Standard page of your web form.
The following table summarizes the buttons that are available and automatically
added for each page type:

Page Type

Buttons Available

Buttons Added by
Default

Standard
Pages

Submit/Next, Reset, Session
Pause, Back

Submit/Next, Reset

Login Pages

Login (Submit/Next), Reset

Login (Submit/Next),
Reset

Web Form
Complete
Pages

None

None

Confirmation
Pages

Submit/Next, Back

Submit/Next, Back

Session Pause
Pages

Reset, Back, Send Reminder
(Submit/Next)

Reset, Back, Send
Reminder (Submit/Next)

Server Error
Pages

Back

Back

Popup Info
Pages

None

None

You may customize the look of any of the buttons placed on a form. You may
use standard text buttons or import images of your own. If you import images,
they must be in the GIF, JPG or PNG formats. These images are buttons that
you have created on your own outside of the Remark Web Survey software.
Tip: When creating multi-page web forms, we recommend that you
put a back button on the pages. If the respondent attempts to use
the web browser‟s back button an error will occur. You may wish to
instruct respondents to only use the page‟s back and next buttons.
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To select what type of buttons to use
1

Insert the desired page type.

2

Expand the Section – Page Buttons
node in the tree view. The default
buttons will be listed.

3

Double click a button to modify it.
Alternatively, right click a button and
choose Properties, or select a
button and choose Properties from
the View tab on the Ribbon.

4

If using standard buttons, under
Basic settings, select the type and
accept or enter custom text for the
button.

5

If using your own images, enter the button text first, and then mark the
checkbox for Display button as image. Note: the text entered for button
images appears when the respondent hovers the mouse over the button
(also called Alternate text). This text is useful for creating Section 508
compliant forms so that screen readers can pick up the text for each button.

6

Under Button preview, click the link for Select image.

7

Locate the desired button image and then click the Open button.

8

If desired, use the Column setting to modify the position of the button. The
number of columns listed here is dependent upon the number of columns in
the section. The lowest column number will place the button to the left of
the screen, while the highest column number will place the button to the
right of the screen.

To insert a button
1

Select a section in which to insert the button.

2

From the Ribbon, select the Insert tab and then click Button. The Button
Properties window appears.

3

Choose the type of button and format it as desired, as outlined in the
previous steps.

4

Click the OK button to save the button.
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The button is added to the tree view and is visible in the HTML Display. Buttons
have their own set of format options in order to adjust the style. See Chapter 7
for detailed information about how to format buttons.

5.10 Headers and Footers
You may add headers and footers to your web form that can include images,
text labels, lines and multimedia. Headers and footers are useful for static
information you want to display either at the top (header) or bottom (footer) of
a web form. Once a header or footer is created, you can choose which pages
you want the header and/or footer to appear on within a web form. By default,
headers and footers are turned on for all standard pages. Therefore, if you
define a header and footer, they will automatically appear on each web form
page. You can turn off the header and footer for any individual page by going
into the page‟s properties. The header and footer nodes are added to the tree
view every time you create a new web form. To use them, add elements to the
header and/or footer and then determine which pages will include the header
and footer.
Note: If adding multimedia files to the header or footer, the video
or audio clip will restart every time a new web page within the web
form loads.

To format the header or footer
The only item you can format on a header or footer is the number of columns.
By default, they have one column. If you would like to adjust this setting so
that you can place elements in the header or footer going across the page (in
columns), you can access the header or footer‟s properties and then change the
column setting.

1

Access the header or footer properties by
either double clicking the header or
footer node in the tree view, right
clicking the header or footer node in the
tree view and then selecting Properties
or selecting the header or footer node in
the tree view and the selecting
Properties from the View tab in the
Ribbon.
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2

Change the Columns setting to the desired number of columns (if you want
more than one column).

3

Click the OK button to save the changes. You may now start adding
elements to the header or footer.

To add elements to the header or footer
1

Click the header or footer in the tree view to select it.

2

From the Ribbon, select the Insert tab and then choose the element you
wish to insert: Label, Image, Line or Multimedia.

3

Enter or adjust the properties of the element, as described in the previous
sections of this chapter. If desired, click the Format button to further
format the element (e.g., color, positioning, etc.). Detailed information on
Style Properties is found in Chapter 7.

4

Click the OK button to save your changes.

The added element is added to the header or footer section of the tree view and
will is visible in the HTML Preview.

To display headers and footers on web form pages
Once you have set up a header or footer, you may choose the pages on which
to display the header or footer. By default, headers and footers are turned on
for all standard web form pages.
1

Access a page‟s properties by either double clicking the page node, right
clicking the page node and selecting Properties or clicking the page node
and then selecting Properties from the View tab in the Ribbon.
Note: You may place headers and footers on multiple web form
pages at one time by either: 1) clicking each page node in the tree
view while holding down the Ctrl key on the keyboard to select
multiple pages, or 2) if you wish to select all pages of a certain
type, click the container node in the tree. For example, if you want
to turn on headers/footers for all standard pages, double click the
Standard Pages node in the tree view.

2

Mark the checkbox for Display the web form header on the page to turn
on page headers. Mark the checkbox for Display the web form footer on
the page to turn on page footers.
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3

Click the OK button to save your
changes.

The selected pages have headers and/or
footers displayed on them in the HTML
Preview.

5.11 Editing Existing
Elements
There may be times when you need to modify an element that you have added
to the web form. All elements can easily be modified.

To edit an element
1

Double click the element you wish to modify in the tree view. Alternatively
right click the element(s) you wish to modify and then select Properties, or
select Properties from the View tab in the Ribbon to view the element‟s
properties window.

2

Make the desired changes.

3

Click the OK button to save the changes.
Note: You may select multiple elements by holding down the Ctrl
key as you click the elements in the tree view. When selecting more
than one element, the Properties option will only be enabled if you
are selecting two elements of the same type (e.g., two buttons or
two questions). When viewing the properties, items in red have
dissimilar information. For example, if you select a checkbox style
question and an option button style question, the Question type
property will be listed in red. You may still adjust these disparate
properties, but keep in mind that all selected elements will be reset
to the newly entered property information. The property for the
item that was selected last is visible in the properties window.
Tip: You can select all items of the same type by going to the
Home tab on the Ribbon, clicking Select and then choosing the
type of element you wish to select from the list. For example,
suppose you want to add a border to all buttons on the web form.
Click Select and then choose Buttons from the list. All buttons will
be highlighted. You can then go to the View tab on the Ribbon and
select Properties to adjust the buttons‟ properties.
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Opening, Saving and Modifying Web
Forms
Chapter 6

6.1 Overview
The previous chapters described the various parts that make up a web form and
how to insert and modify elements on a web form. When using the software,
there are other tools that you may find useful as you design web forms. The
topics that are covered in this chapter include:
Opening web forms
Saving web forms
Manipulating existing web forms
Spell checker

6.2 Opening a Web Form
You can open a previously created web form to make modifications or publish it
to your web server, download data or run analysis. Only web forms saved in the
Remark Web Survey format (.rwsx or .rws) can be opened from within Remark
Web Survey.

To open a web form
1

From the Design window, select the Application Button

and then click

Open, or click
, to display the Open window. Notice that when you click
the Application Button, a recently used file list appears automatically (this
list stores up to 10 recently accessed files). You may also select a web form
from this list.
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Note: The Open button is also
available from the Quick
Access Toolbar.
2

Select the desired web form by clicking
its name.

3

Click the Open button to open and
display the form.
Warning: You are only able to
open web forms that are created in Remark Web Survey and
therefore have a .rwsx extension. These files are only meant for use
within Remark Web Survey. Though we do not recommend or
support it, once a form has been created and published, you are
able to make changes to the resulting HTML files outside of Remark
Web Survey. For example, you may format the HTML files in an
HTML editor. However, if you modify a form outside of Remark Web
Survey, you cannot reopen the .rwsx file in Remark Web Survey
without losing those changes. The .rwsx file will be the original file
you created without any of the changes made to the HTML files. You
may not change the name of the HTML files while editing it (e.g., do
not change the name page_1.html to mysurvey.html). Changing the
name will cause Remark Web Survey to be unable to administer the
form properly. Certain changes to elements on the web form can
also break the web form‟s functionality. Gravic cannot support
files that have been altered outside of Remark Web Survey.

6.3 Saving a Web Form
You can save a web form as a Remark Web Survey document. Forms are saved
in the .rwsx format, which is proprietary to the Remark Web Survey software.

To save a web form
1

Select the Application Button
and then click Save, or click
, to
display the Save As window. You may also select Save As to save an
existing form with a new name or to a new location.
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Note: The Save button is
also available from the Quick
Access Toolbar.
The Save As window allows you to select
a form name and a directory to which to
save the form.
2

Place the cursor in the File name box
and type a name for the form.

3

Click the Save button to save the
form.
Note: If you have already saved the web form, clicking Save will
automatically overwrite the file without prompting you.

Once the web form is complete, you are ready to publish the web form to your
web server. See Chapter 9 for further details.

6.4 Moving and Rearranging Elements
While Chapter 5 covered inserting elements into a web form, the tree view can
be used to delete, copy and move elements.

To delete an element
1

Select the node(s) representing the element(s) you wish to delete.

2

Select the Home tab in the Ribbon and then click Delete
, right click
the element and then select Delete, or press the Delete key on your
keyboard.

To move an element using cut and paste
You can move an element to another position on the web form in one of two
ways. The first method is to use the Home tab in the Ribbon to cut and paste
the object in a new position.

1

Select the element you would like to move.
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2

Select the Home tab in the Ribbon and then click Cut (Ctrl + X), or click
.

3

Select an insertion point in the tree view.

4

Select the Home tab in the Ribbon and then click Paste (Ctrl + V), or click
, to paste the element after the currently selected element.

To move an element using drag and drop
You may use drag and drop to move an element to a new position.

1

Select the element you would like to move.

2

While holding down the left mouse button, drag the item to its new desired
location.

3

When you have reached the new location, release the mouse button. The
element is dropped after the selected element.
Note: You may press the Shift key while dragging the element to
insert it before the last selected element. An arrow will show you
that you are moving before the selected element

To copy an element using copy and paste
You can copy one element to another location in one of two ways. The first
method is to use the Home tab in the Ribbon to copy and paste the object in a
new location.
1

Select the element you would like to copy.

2

Select the Home tab in the Ribbon and then click Copy (Ctrl + C), or click
.

3

Select an insertion point in the tree view.

4

Select the Home tab in the Ribbon and then click Paste (Ctrl + V), or click
to paste the element after the currently selected element.
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To copy an element using drag and drop
The second method of copying elements is to use drag and drop to copy the
element to a new location.

1

Select the item you would like to copy.

2

Drag the item to its new desired location.

3

Press the Ctrl key when you have reached the new location (before
releasing the mouse button).

4

Release the mouse button. The element will be copied to the new location.
Note: You may press the Shift key while dragging the element to
copy it before the last selected element. An arrow will show you
that you are copying before the selected element.

6.5 Spell Checker
Remark Web Survey includes a spell checker feature that includes customized
dictionaries in multiple languages. The spell check will search labels, question
text, answer text and table headers for misspellings.
To set up the spell checker
1

Select the Application Button,
then click Spell Checker.

then click Web Survey Options and

2

Under Dictionary Files, select the location where your dictionaries are
found. (Note that the default dictionary is typically fine unless you have a
specific dictionary you would like to use.) There is a Main dictionary and a
Custom dictionary. Remark Web Survey will first use the main dictionary
and then as you add custom spellings it will create the custom dictionary.
When performing spell check functions, the software will use both
dictionaries unless you mark the checkbox titled Suggest from main
dictionary only.
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3

In the Language box, select the
language for your spell check
dictionary files.

4

Under When correcting
spelling, select the options you
wish the spell checker to use:
Ignore words in UPPERCASE,
Ignore words that contain
numbers, Ignore internet and
file addresses, Check
compound words, Check
hyphenated words, Suggest from main dictionary only. These options
can help you customize how the spell checker reviews your web forms.

To use the spell checker
1

With a form open, select the Tools tab from the Ribbon and then click
Spelling, or click
found.

2

. The spell checker window displays if an exception is

When an exception is encountered, select an option for the problem. The
following options are available:
Option

Description

Ignore Once

Ignore the exception this time only.

Ignore All

Ignore all occurrences of the exception.

Add to Dictionary

Add the exception to your custom
dictionary.

Change

Select a word from the Suggestions list and
then click Change to change the exception.

Change All

Select a word from the Suggestions list and
then click Change All to change all
occurrences of the exception.

Close

Cancel the spell checker.
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3

Make a selection from the above
list. Note that you may type directly
into the Not in Dictionary box and
then choose an option.

4

Continue making selections until
you receive a message that the
spell checker is complete.

6.6 Converting Remark Web Survey 4 Forms
Remark Web Survey 5 will convert .rwsx files that were created in Remark Web
Survey 4 automatically.
Important Note: If you are using Remark Web Survey 1.x or 2.x
web forms, these files will not convert automatically. They need to
be converted to the Remark Web Survey 3 or 4 format first, and
then they can be opened in Remark Web Survey 5. If you do not
have Remark Web Survey 3/4, please email your web form files
(.rws files) to Gravic‟s support team and we will convert them for
you (contact information is on the back of this book or our website).
When a Remark Web Survey 4 file is converted to the new version, the
conversion takes place when the file is saved. Upon saving, the new file will
have a .rwsx extension. Therefore, you will still have your version 4 .rwsx file
should you need to use it again in version 4 of the software.
When you set up Remark Web Survey 5, you may decide to use a different
Default forms directory for the storage of web forms on your website.
Therefore, your converted web form and all of its files may be in a different
folder. We recommend that you download any data that currently exists for
Remark Web Survey 4 forms before the conversion. You can always combine
this data with any new data files that are created.
Tip: If at all possible, you may wish to close out any web forms you
are currently running under Remark Web Survey 4 before bringing
them into Remark Web Survey 5. We realize that this may not be
possible for ongoing web forms. In this case, use the instructions
that follow to make the migration as smooth as possible.
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To convert an old file to the new version
1

Select the Application Button
the Quick Access Toolbar.

and then click Open, or click

from

2

Locate the .rwsx or .rws file you wish to open. Keep in mind that you may
only convert version 3.x and 4.x files in this version.

3

Click the Open button to open the file.

4

Save the file in Remark Web Survey 5 by selecting the Application Button
and then clicking Save, or click
from the Quick Access Toolbar.
Provide a File name and select a location in which to save the file. Do not
overwrite the original file or you will not be able to use it in the older
version.

5

Click the OK button. The new file will have a .rwsx extension and can only
be opened in Remark Web Survey 5. The old file will remain intact and can
still be used in the previous Remark Web Survey version if needed.

You may now modify the web form as desired. If you plan to combine data for
the same form that was collected in Remark Web Survey 4 and Remark Web
Survey 5, do not make any structural changes to the web form (e.g., add
questions, delete questions, rearrange questions, etc.). When completed,
publish the form to your website as you would any other web form (see Chapter
9).
If the form still has data that you collected with Remark Web Survey 4, you
have two options for combining the data (in both cases you should start a new
data file once the file is converted to version 5):
RECOMMENDED: Download the data into Remark Web Survey 4, save it
as a Remark (RMK) data file and then open that data file in Remark Web
Survey 5.
Download the old data from your website using the Remark Web Survey
4 administration script (rwsad4.pl). This will provide you with a .rwd file
that can be opened in Remark Web Survey 5.
Note: Remark Web Survey 5 is an upgrade to Remark Web Survey
4. While the two products can physically reside on the same
system, Remark Web Survey 5 should replace Remark Web Survey
4 (e.g., it does not grant you an additional license to Remark Web
Survey). We understand that you may need to migrate web forms
from one version to the other over a period of time. Once all of your
web forms are migrated to the new version, please uninstall
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Remark Web Survey 4 and only use version 5 (always back up your
files before uninstalling any program).
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Formatting and Style Sheets
Chapter 7

7.1 Overview
Each web form that you create has its own format, also known as style; that is,
its own character in terms of colors, fonts and other formatting attributes.
Remark Web Survey allows you to customize the format of the elements on the
web forms that you create. In addition, you can save formatting options as style
sheets so that they can be reused. Styles allow you to customize fonts, colors,
line breaks, image attributes and other properties throughout the web form.

7.2 Formatting Options
The application of styles is handled through the Style Properties window. You
use this window to set formatting options and then apply them to the various
parts of the web form. Every property listed in the Style Properties window has
descriptive text at the bottom of the window. Click a style property to view its
descriptive text.
The following table shows all of the possible formatting options in the Style
Properties window (listed in alphabetical order for each element):
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Element Category: Answers
Style Property

Description

Alignment

The Alignment style property sets whether to place
the answer element in the left, center or right area of
the section. Click in the right portion of the cell to
access a drop-down list of choices. The Alignment
property can only be accessed when you click Format
from the Question Properties window (not from the
Answer Properties window). Alignment applies to all
answers within a question and cannot be applied to
individual answers within the same question.

Answer Box Height

When inserting a Textbox question, you can increase
its height by adding rows, which turns it into a Text
Area. A Text Area style question has multiple rows and
columns to accommodate more text than a one-line
textbox. Note that this style is also available in the
Attributes section of the Question Properties window.

Answer Box Width

When inserting a Textbox question, you can increase
its width by adding columns. Note that the width of a
textbox is the same number of characters respondents
will be able to type (e.g., a textbox with a width of 10
allows 10 characters). If using a Text Area (multiple
lines), the Answer Box Width setting does not limit
the number of characters that can be typed. However,
if they exceed the limit you set in the question‟s
properties, respondents will get an appropriate
message when they submit the page. Note that this
style is also available in the Attributes section of the
Question Properties window.

Background Color

The Background Color style property sets the
background color for the element. Click in the right
portion of the cell to access a drop-down list of colors.
The font will remain unchanged, but the background
of the text will change in color.
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Style Property

Description

Font

The Font style property sets the font name for the
element. Click in the right portion of the cell to access
a drop-down list of fonts. Alternatively, type a list of
fonts separated by commas.
Note: It may be the case that the font you select here
is not available on the respondent‟s computer. Using
the Remark Web Survey program options, you can
select more than one font for your respondents. If the
main font is not available on the respondent‟s system,
the backup fonts will be used. Select the Application
Button
and then choose Web Survey Options to
choose backup fonts that will display when the
selected font is unavailable.

Font Bold

The Font Bold style property sets whether the font
used for the answer element is in bold format. Use
True to set it to bold format and False to remove bold
formatting.

Font Color

The Font Color style property sets the color for the
font used for the answer element. Click in the right
portion of the cell to access a drop-down list of font
colors.

Font Italic

The Font Italic style property sets whether the font
used for the answer element is in italic format. Use
True to set it to italic format and False to remove italic
formatting.

Font Size

The Font Size style property sets the size of the font
used for the answer element. Enter a numeric value.
10 is a typical number used for web forms; use a
higher number for larger text and a lower number for
smaller text.

Font Underline

The Font Underline style property sets whether the
font used for the answer element is underlined. Use
True to underline the answer element and False to
remove underline formatting.
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Style Property

Description

Horizontal Alignment

The Horizontal Alignment style property sets the
horizontal alignment for checkbox and option button
style answer elements (left, center, right). Tip: Use
this property in table formatting when you want
checkboxes and option buttons to be centered below
the answer text. This property is also useful in
conjunction with Image Position when using images as
answer choices.

Image Position

The Image Position style property sets whether
images used as answer choices should be left, right,
top or bottom aligned in comparison to the HTML
Display text.

Indent Levels

The Indent Levels style property sets the number of
levels to indent the element. One indent level equals
one HTML space. As you increase the indent levels,
the answer element will move toward the right of the
web form page.

Line Breaks After

The Line Breaks After style property sets the
number of line breaks after the element. Enter a
numeric value to add line breaks after the element.
Adding line breaks creates vertical space after the last
answer element for the question.

Line Breaks Before
Appended Textbox

The Line Breaks Before Appended Textbox style
property sets the number of line breaks between an
element and an appended textbox (e.g., an “other”
textbox). Enter a numeric value to add line breaks
before the appended textbox. Adding line breaks
creates vertical space before the appended textbox.
Use a value of 0 to place the appended textbox on the
same line as the answer element.

Vertical Alignment

The Vertical Alignment style property sets the
answer‟s alignment to Top, Middle or Bottom. This
aligns everything within the answer element (e.g.,
HTML Display, images and the element itself, such as
a checkbox or option button).
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Element Category: Buttons
Style Property

Description

Alignment

The Alignment style property sets whether to place
the button element in the left, center or right area of
the section. Click in the right portion of the cell to
access a drop-down list of choices.

Border Color

The Border Color style property allows you to choose
a color for the border around the button (if one is
used). Click the arrow in the right portion of the
window to drop down a list of available colors.

Border Style

The Border Style style property allows you to create
either a 3D border or a flat border around the button. A
3D border looks similar to a raised border if the border
width is great enough. Please note that color can affect
the 3D look of a border (e.g., black cannot look threedimensional).

Border Width

The Border Width style property places a border
around the button and sets the thickness. Enter a
numeric value; the higher the number, the thicker the
border. Use 0 if you do not want a border. The default
value is -1, which uses the web browser‟s default
setting for buttons (Windows XP style).

Font

The Font style property sets the font name for the text
in the button element. Click in the right portion of the
cell to access a drop-down list of fonts. Alternatively,
type a list of fonts separated by commas.
Note: It may be the case that the font you select here
is not available on the respondent‟s computer. Using
the Remark Web Survey program options, you can
select more than one font for your respondents. If the
main font is not available on the respondent‟s system,
the backup fonts will be used. Select the Application
Button
and then choose Web Survey Options to
choose backup fonts that will display when the selected
font is unavailable.

183

Remark Web Survey User’s Guide

Style Property

Description

Font Bold

The Font Bold style property sets whether the font
used for the text in the button element is in bold
format. Use True to set it to bold format and False to
remove bold formatting.

Font Color

The Font Color style property sets the color for the
font used for the text in the button element. Click in
the right portion of the cell to access a drop-down list
of font colors.

Font Italic

The Font Italic style property sets whether the font
used for the text in the button element is in italic
format. Use True to set it to italic format and False to
remove italic formatting.

Font Size

The Font Size style property sets the size of the font
used for the text in the button element. Enter a
numeric value. Use a higher number for larger text and
a lower number for smaller text.

Font Underline

The Font Underline style property sets whether the
font used for the text in the button element is
underlined. Use True to underline the answer element
and False to remove underline formatting.

Height

The Height style property allows you to increase or
decrease the height of the button, creating a larger or
smaller button.

Line Breaks After

The Line Breaks After property sets the number of
line breaks after the button element. Enter a numeric
value to add line breaks after the element. Adding line
breaks creates vertical space after the button. By
adding line breaks between buttons, you can force
buttons to be on separate lines (e.g., place one button
on the form, put a line break after it, then add another
button; that button will be on the next line). Please
note that buttons have one line break after
automatically (the setting reads 0 because the line
break is built-in to the element).
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Style Property

Description

Width

The Width style property allows you to increase or
decrease the width (length) of the button, creating a
larger or smaller button.

Element Category: Images
Style Property

Description

Alignment

The Image Horizontal Alignment style property sets
whether to align the image left, center or right relative
to the section in which it resides.

Border Color

The Border Color style property allows you to choose
a color for the border around the image (if one is
used). Click the arrow in the right portion of the
window to drop down a list of available colors.

Border Style

The Border Style style property allows you to create
either a 3D border or a flat border around the image. A
3D border looks similar to a raised border if the border
width is great enough. Please note that color can affect
the 3D look of a border (e.g., black cannot look three
dimensional).

Border Width

The Border Width style property places a border
around the image and sets the thickness in pixels.
Enter a numeric value; the higher the number, the
thicker the border. Use 0 if you do not want a border.
The default value is -1, which uses the web browser‟s
default setting for buttons (Windows XP style).

Height

The Height style property sets the height of the image
in pixels. Note that you can also adjust image height in
the Image Properties window.
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Style Property

Description

Line Breaks After

The Line Breaks After style property sets the number
of line breaks after the image element. Enter a numeric
value to add line breaks after the element. Adding line
breaks creates vertical space after the image. Please
note that Images have one line break after
automatically (the setting reads 0 because the line
break is built-in to the element).

Width

The Width style property sets the width of the image
in pixels. Note that you can also adjust the image
width in the Image Properties window.

Element Category: Labels
Style Property

Description

Alignment

The Alignment style property sets whether to place
the label element in the left, center or right area of the
section. Click in the right portion of the cell to access a
drop-down list of choices.

Background Color

The Background Color style property sets the
background color for the label element. Click in the
right portion of the cell to access a drop-down list of
colors. The text font will remain unchanged, but the
background of the label will change in color.
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Style Property

Description

Font

The Font style property sets the font name for the
label element. Click in the right portion of the cell to
access a drop-down list of fonts. Alternatively, type a
list of fonts separated by commas.
Note: It may be the case that the font you select here
is not available on the respondent‟s computer. Using
the Remark Web Survey program options, you can
select more than one font for your respondents. If the
main font is not available on the respondent‟s system,
the backup fonts will be used. Select the Application
Button
and then choose Web Survey Options to
choose backup fonts that will display when the selected
font is unavailable.

Font Bold

The Font Bold style property sets whether the font
used for the label element is in bold format. Use True
to set it to bold format and False to remove bold
formatting.

Font Color

The Font Color style property sets the color for the
font used for the label element. Click in the right
portion of the cell to access a drop-down list of font
colors.

Font Italic

The Font Italic style property sets whether the font
used for the label element is in italic format. Use True
to set it to italic format and False to remove italic
formatting.

Font Size

The Font Size style property sets the size of the font
used for the label element. Enter a numeric value. 10
is a typical number used for web forms; use a higher
number for larger text and a lower number for smaller
text.

Font Underline

The Font Underline style property sets whether the
font used for the text in the label element is
underlined. Use True to underline the answer element
and False to remove underline formatting.
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Style Property

Description

Indent Levels

The Indent Levels style property sets the number of
levels to indent the element. One indent level equals
one HTML space. As you increase the indent levels, the
label element will move toward the right of the web
form page.

Line Breaks After

The Line Breaks After style property sets the number
of line breaks after the label element. Enter a numeric
value to add line breaks after the element. Adding line
breaks creates vertical space after the label. Please
note that labels have one line break after automatically
(the setting reads 0 because the line break is built-in to
the element).

Element Category: Lines
Style Property

Description

Alignment

The Alignment style property sets whether to place
the line element in the left, center or right area of the
section. Click in the right portion of the cell to access a
drop-down list of choices.

Color

The Color style property sets the color for the line
element. Click in the right portion of the cell to access
a drop-down list of font colors.

Height

The Height style property sets the height/thickness of
the line in pixels.

Line Breaks After

The Line Breaks After style property sets the number
of line breaks after the line element. Enter a numeric
value to add line breaks after the element. Adding line
breaks creates vertical space after the line. Please note
that lines have one line break after automatically (the
setting reads 0 because the line break is built-in to the
element).

188

Formatting and Style Sheets

Style Property

Description

Width

The Width style property sets the width of the line in
percentages. 100% extends the line across the entire
width of the page. You may also enter a width in pixels
(do not use the percent sign in this case).

Element Category: Multimedia
Style Property

Description

Alignment

The Horizontal Alignment style property sets
whether to align the multimedia element left, center or
right relative to the section in which it resides.

Border Color

The Border Color style property allows you to choose
a color for the border around the multimedia element
(if one is used). Click the arrow in the right portion of
the window to drop down a list of available colors.

Border Width

The Border Width style property places a border
around the multimedia element and sets the thickness
in pixels. Enter a numeric value; the higher the
number, the thicker the border. Use 0 if you do not
want a border. The default value is -1, which uses the
web browser‟s default setting for buttons (Windows XP
style).

Line Breaks After

The Line Breaks After style property sets the number
of line breaks after the multimedia element. Enter a
numeric value to add line breaks after the element.
Adding line breaks creates vertical space after the
image. Please note that multimedia files have one line
break after automatically (the setting reads 0 because
the line break is built-in to the element).

Media Player Height

The Media Player Height style property sets the
height of the media player in pixels.

Media Player Width

The Media Player Width style property sets the width
of the media player in pixels.
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Style Property

Description

Show Player
Controls

The Show Player Controls style property lets you
control whether to display the audio/video player‟s
controls, such as start, stop, rewind, fast forward and
pause. The controls may vary based on the audio/video
player being used. If you show the controls,
respondents can utilize them when the audio/video file
loads. If you do not show the controls, respondents do
not have the ability to manipulate the player (e.g.,
restart the audio/video clip, rewind and re-listen, etc.).

Show Player Status

The Show Player Status style property lets you
control whether to display the player‟s status. Status
messages include things such as “buffering media”,
“loading media file” and so forth. These messages give
an indication to the respondent as to what is happening
with the multimedia file.

Element Category: Pages
Style Name

Description

Alignment

The Alignment style property sets whether the page is
left, center or right aligned. Click in the right portion of
the cell to access a drop-down list of choices.
Alignment is affected by the Width setting. When using
100% width, it is harder to see a difference in
alignment. However, as you shrink the width, the
margins get wider and the alignment of the elements
on the page will become more evident.

Background Color

The Background Color style property sets the
background color for the page. Click in the right portion
of the cell to access a drop-down list of colors. The
entire background of the web form page will change in
color.
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Style Name

Description

Background Image

The Background Image style property puts an image
in the background of the page. Click the ellipse (…) to
select an image to use as the background for the entire
page.

Background Image
Display

The Background Image Display style property sets
the position of the background page image: Left,
Center, Right or Tile.

Enable Background
Image

The Enable Background Image style property
displays the background image for the page. After
selecting a background image in Background Image
Display, set this property to True to display the image.
You can set this property to False for specific pages
without having to remove the image selected for
Background Image Display.

Width

The Width style property sets the width of the page in
percentages. When using 100% the elements placed
on the page will extend the width of the entire page.

Element Category: Question Tables
Style Name

Description

Alignment

The Horizontal Alignment style property sets the
alignment of the table relative to the section: Left,
Center or Right.

Background Color

The Background Color style property sets the
background color for the question table. Click in the
right portion of the cell to access a drop-down list of
colors.

Background Color
Enabled

The Background Color Enabled style property sets
whether to display a background color. The color is
chosen either in the Background Color for Alternate
Rows or Background Color properties.
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Style Name

Description

Background Color
for Alternate
Columns

The Background Color for Alternate Columns
property style sets the background color for alternating
columns within the question table. Use the
Background Column Color Display style property
(see next page) to determine whether alternating
columns or answer groups utilize the background color.
Click in the right portion of the cell to access a dropdown list of colors.

Background Color
for Alternate Rows

The Background Color for Alternate Rows style
property sets the background color for alternating rows
within the question table. Click in the right portion of
the cell to access a drop-down list of colors.

Background Color
for Question Text
Cells

The Background Color for Question Text Cells style
property sets the background color for the column or
row that contains the question text. Click in the right
portion of the cell to access a drop-down list of colors.

Background Color
Solid

The Background Color is Solid style property
controls whether to use a solid background for the
entire question table. When enabled, solid background
color is used and alternate row background color will
not be used.

Background Column
Color Display

The Background Column Color Display style
property allows you to format the columns by Column
or Answer Group. When formatted by Column,
alternating columns will have the background color
applied, regardless of the answer group to which the
question applies. When formatted by Answer Group,
the entire group of answers will have the background
color applied. The latter feature is useful for side-byside tables where more than one answer group is used
with the same set of questions.
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Style Name

Description

Column Header
Text Alignment

The Column Header Text Alignment style property
allows you to format all of the column header text in
the left, center or right of the column. This feature is
useful if you want all of the answer text, for example,
to be centered over the columns. Once this property is
set, you may still go into individual answer items and
adjust their alignment.

Display Answer
Group Header

The Display Answer Group Header style property
controls whether the header entered into the answer
group section of question table will be displayed. This
property is on by default.

Display Answer
Scale Header

The Display Answer Scale Header style property
controls whether the scale (e.g., Excellent to Poor
ratings for option button questions) entered into the
answer group section of question table will be
displayed. This property is on by default.

Font

The Font style property sets the font name for the
question table element. Click in the right portion of the
cell to access a drop-down list of fonts. Alternatively,
type a list of fonts separated by commas.
Note: It may be the case that the font you select here
is not available on the respondent‟s computer. Using
the Remark Web Survey program options, you can
select more than one font for your respondents. If the
main font is not available on the respondent‟s system,
the backup fonts will be used. Select the Application
Button
and then choose Web Survey Options to
choose backup fonts that will display when the selected
font is unavailable.

Font Bold

The Font Bold style property sets whether the font
used for the question table is in bold format. Use True
to set it to bold format and False to remove bold
formatting.

Font Color

The Font Color style property sets the color for the
font used for the question table. Click in the right
portion of the cell to access a drop-down list of font
colors.
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Style Name

Description

Font Italic

The Font Italic style property sets whether the font
used for the question table is in italic format. Use True
to set it to italic format and False to remove italic
formatting.

Font Size

The Font Size style property sets the size of the font
used for the question table. Enter a numeric value. 10
is a typical number used for web forms; use a higher
number for larger text and a lower number for smaller
text.

Font Underline

The Font Underline style property sets whether the
font used for the text in the question table is
underlined. Use True to underline the answer element
and False to remove underline formatting.

Indent Levels

The Indent Levels style property sets the number of
levels to indent the question table. One indent level
equals one HTML space. As you increase the indent
levels, the question table will move toward the right of
the web form page.

Line Breaks After
Question Table

The Line Breaks After Question Table style property
sets how many line breaks to put after the entire
question table.

Question Column
Width

The Question Column Width style property sets the
width of the question column within the table in terms
of percentages. The question column will utilize the
specified width, and the answer items will evenly fill
the remaining portion of the table. This feature allows
your answer items to be evenly spaced on the page.

Question Column
Widths Enabled

The Question Column Widths Enabled style
property enables the use of custom question columns
widths. Use this property in conjunction with Question
Column Width.
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Style Name

Description

Row Header Text
Alignment

The Row Header Text Alignment style property sets
whether to place the row header text in the left, center
or right portion of the table column. Row header text is
question text when a table is laid out “question by
answer”. Row header text is answer text when a table
is laid out “answer by question.”

Table Borders Color (External)

The Table Borders - Color External style property
allows you to choose a color for the external border
around the table (if one is used). Click the arrow in the
right portion of the window to drop down a list of
available colors.

Table Borders Color (Internal)

The Table Borders - Color Internal style property
allows you to choose a color for the internal borders
within the table (if they are used). Click the arrow in
the right portion of the window to drop down a list of
available colors.

Table Borders External

The Table Borders - External style property sets
whether to use an outside border around the entire
table of questions. The Background Color for Alternate
Rows property controls the border color.

Table Borders Internal

The Table Borders - Internal style property sets
whether to use borders around each individual question
within the question table. By using this feature, the
table borders will be visible. The Background Color for
Alternate Rows property controls the border color.

Table Borders –
Width (External)

The Table Borders – Width (External) style
property controls the size of the border around the
table by setting its thickness in pixels. Enter a numeric
value; the higher the number, the thicker the border.

Table Borders Width (Internal)

The Table Borders – Width (Internal) style property
controls the size of the internal border used in the table
by setting its thickness in pixels. Enter a numeric
value; the higher the number, the thicker the border.
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Style Name

Description

Table Layout

The Table Layout style property allows you to lay out
the table using Question by answer or Answer by
Question. Question by Answer puts the question text
down the left side of the table and the answer text
across the top. Answer by Question puts the answer
text down the left side of the table and the question
text across the top.

Table Width

The Table Width style property specifies the width of
the table across the web form page. The default value
is Auto meaning it will span the page. You can type a
width percentage in the box or choose one from the
drop-down list.

Vertical Alignment

The Vertical Alignment style property sets the
question table row alignment to the top, middle or
bottom of the row. Click in the right portion of the cell
to access a drop-down list of choices.

Element Category: Questions
Style Name

Description

Alignment

The Alignment style property sets whether to place
the question element in the left, center or right area of
the section. Click in the right portion of the cell to
access a drop-down list of choices.

Background Color

The Background Color style property sets the
background color for the question element. Click in the
right portion of the cell to access a drop-down list of
colors.
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Style Name

Description

Font

The Font style property sets the font name for the
question element. Click in the right portion of the cell
to access a drop-down list of fonts. Alternatively, type
a list of fonts separated by commas.
Note: It may be the case that the font you select here
is not available on the respondent‟s computer. Using
the Remark Web Survey program options, you can
select more than one font for your respondents. If the
main font is not available on the respondent‟s system,
the backup fonts will be used. Select the Application
Button
and then choose Web Survey Options to
choose backup fonts that will display when the selected
font is unavailable.

Font Bold

The Font Bold style property sets whether the font
used for the question element is in bold format. Use
True to set it to bold format and False to remove bold
formatting.

Font Color

The Font Color style property sets the color for the
font used for the question element. Click in the right
portion of the cell to access a drop-down list of font
colors.

Font Italic

The Font Italic style property sets whether the font
used for the question element is in italic format. Use
True to set it to italic format and False to remove italic
formatting.

Font Size

The Font Size style property sets the size of the font
used for the question element. Enter a numeric value.
10 is a typical number used for web forms; use a
higher number for larger text and a lower number for
smaller text.

Font Underline

The Font Underline style property sets whether the
font used for the text in the question element is
underlined. Use True to underline the answer element
and False to remove underline formatting.
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Style Name

Description

Indent Levels

The Indent Levels property sets the number of levels
to indent the question element. One indent level equals
one HTML space. As you increase the indent levels, the
question element will move toward the right of the web
form page.

Line Breaks After

The Line Breaks After style property sets the number
of line breaks after the question element. Enter a
numeric value to add line breaks after the element.
Adding line breaks creates vertical space after the
question.

Line Breaks Before
Question‟s Answers

The Line Breaks Before Question’s Answers style
property sets the number of line breaks between the
question element and the first answer element. Enter a
numeric value to add line breaks after the element.
Adding line breaks creates vertical space after the
question.

Question Answer
Columns

The Question Answer Columns style property sets
the number of columns in which to place the answer
elements (applies to checkbox and option button
question types). If a question has a large number of
answer choices, you may wish to put the answers in
multiple columns.

Element Category: Sections
Style Property

Description

Column Border
Color

The Column Border Color style property allows you
to choose a color for borders between columns within a
section (if borders are used). Click the arrow in the
right portion of the window to drop down a list of
available colors.
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Style Property

Description

Column Border
Visible

The Column Border Visible style property sets
whether to display a border between columns in a
section. This property only applies to sections that
have more than one column. Borders can act as a
visual separator between elements in the section. Set
the value to True to display borders and False to hide
borders.

Column Border
Width

The Column Border Width style property controls the
size of the border between columns by setting its
thickness in pixels. Enter a numeric value; the higher
the number, the thicker the border.

Element Category: Web Form
Style Property

Description

Error Highlight
Color

The Error Highlight Color style property allows you
to choose a color for error messages that are
highlighted when respondents submit pages with
missing/incorrect information (e.g., not answering a
required question). Click the arrow in the right portion
of the window to drop down a list of available colors.
The default color is red.

Hyperlink Color

The Hyperlink Color style property sets the color to
use for all hyperlinks on the web form. Click in the
right portion of the cell to access a drop-down list of
colors.
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7.3 Using the Style Properties Window
There are several ways you can format web forms. In order to understand how
formatting works, you will need to understand the web form hierarchy and how
style properties are passed down to the various web form elements.
When you look at a web form‟s tree view, you can think of it as a hierarchy. The
web form is at the top, followed by Pages, Sections, Questions, Labels, Images
or Lines, Multimedia and Answers. In hierarchical context, it looks like this:
Web Form
Page
Section
Questions, Images, Labels, Lines, Multimedia
Answers
When using style properties, there are two basic concepts. You can either
format individual elements or you can choose a higher point in the hierarchy
and then “push” the formatting down to the lower levels. Think of the top level
as a parent and any levels beneath it as children. When you push a style
property down, the children inherit the option from the parents. In the Style
Properties window, you have two choices for applying style changes: an OK
button and an Apply Style button.
The OK button can be used in two ways: It can apply changes made within the
Style Properties window to the selected element. Or, when used at a higher
level, it will change affected elements at that level or lower and apply to new
elements that you create from that point on, if they are on existing pages.
Important Note: When using the OK button in the Style Properties
window, if a property is changed, all elements that had the original
property‟s value will be updated with the new value. However,
disparate elements will remain unchanged. The purpose of this rule
is so that if you intentionally format an element in a special way, its
formatting will not be overwritten accidentally.
For example, if you select a question and change the font from black to blue
and then click OK, it will change the selected question to blue. However, new
questions that you create will still use the style from the next highest level
(e.g., the original color). In addition, other existing questions will not be
changed to blue. This is all true because you selected one particular element to
format. Another example is to select all Standard Pages, go to the Questions
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section of the Style Properties window and change the color from black to blue.
In this scenario, after clicking the OK button, all of the questions on the
selected pages that are black will change from black to blue. Any new questions
you insert (on any existing standard page) will also be blue. New questions are
affected in this case because you set the font color on a page level and pushed
it down to the questions on those pages (whereas in the previous example, you
only set it for one question). However, if you were to add a page to the web
form, questions on that page would use the old style (black in this case)
because new pages utilize the style set at the form level.
In contrast, the Apply Style button applies all of the settings within the Style
Properties window to the selected element and its children (lower level
elements). What you see in the Style Properties window is actually a Style
Sheet. Therefore, using the Apply Style button takes all of those properties and
applies them to the web form. In addition, any new elements that you create
will use the updated style.
Note: When using the Apply Style button, you still need to click
the OK button to close the Style Properties window. In this
circumstance, the OK button is just an added layer of confirmation
to your changes (you can use OK or Cancel at this point).
Let‟s look at an example:
Suppose you have a 5-page web form where the style defined has page
background set to gray. You decide that you want to change all of the existing
background colors on your web form pages to blue. The easiest way to
accomplish this is to select all web pages, go to the Style Properties window and
change the background color at the Page level. In this case you would then click
the OK button to apply the changes to the selected pages. If you were to create
a new page, however, it would be gray because this is what is defined at the
form level. If we change the scenario slightly and say you want to change all of
the background colors from gray to blue and have new pages be blue as well,
you could go to the form level, click the Format button, make the change and
then click Apply Style. In this case, the existing pages would change to blue
and any new pages would also be blue because you changed the style at the
web form level.
In order to make the formatting as flexible as possible, you can also change
individual elements without enforcing that change to apply to other lower level
elements. Suppose you have one question that you want to stand out. While all
the questions on the form are blue, you want this one to be red. You can go to
the Style Properties window for that question only and change the color to red
without affecting any other questions. Unless you go to a higher level in the tree
and click the Apply Style button in the Style Properties window, this question
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will stay red. In addition, any new questions will still be the original style color
of blue.
In summary, here is a list of the possible ways to use the Style Properties
window:
Select the web form element in the tree view (the top node), change
the style properties and then click the OK button. Everything on the web
form that had the original property value will be changed for any
properties that were adjusted in the Style Properties window. Any style
properties that were not touched will not carry down to the other
elements on the web form. Any new items you insert will have the
properties that you just adjusted using the Style Properties window.
(Example: Go to Style Properties through the web form properties,
change Question Color from Black to Blue, click the OK button. All
questions on the form that were originally black will be blue, but any
other settings that were in the Style Properties window that were not
adjusted will not carry over to the web form. In addition, any questions
that were not originally black will retain their color. Any new questions
that you create will be blue.)
Select the web form element in the tree view (the top node), change
the style properties and then click the Apply Style button. Everything
on the web form will be changed based on what is in the Style Properties
window, regardless of what was actually changed in that same window.
Anything new you add to the web form will also use these updated
properties. (Example: Go to the Style Properties through the web form
properties, change Question Color to Blue and click the Apply Style
button. All questions on the web form will be blue, and in addition,
everything on the web form will utilize all properties from the Style
Properties window.)
Select a higher level element, such as a page, change the style
properties and click the OK button. The style properties that you
changed will carry through to the selected items, and if you changed the
style of elements below in the hierarchy, they will change as well. Any
properties in the Style Properties window that you did not adjust will not
affect lower level items. (Example: Go to the Style Properties through a
page properties window. Change Question Color from Black to Blue. All
questions on the page that were originally black will be blue but any
other settings that were in the Style Properties window that were not
adjusted will not carry over to the web form. However, any new
questions you add to this page will use the new Question Color (blue).
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Select a higher level element, such as a page, change the style
properties and click the Apply Style button. The selected item (e.g.,
page) and any elements below it will utilize all of the properties in the
Style Properties window. (Example: Go to the Style Properties through a
page properties window. Change Question Color from Black to Blue and
then click the Apply Style button. All questions on the page will be blue
and in addition, everything on that page will utilize all properties from
the Style Properties window. If you had set formatting options for an
individual element (e.g., made one question green) the options will be
reset to those that are defined on the page level (blue, in this case). In
addition, new questions you add will also use the Question Color defined
at the page level (blue in this case).
Select an individual element, change the style properties and click the
OK button. The style properties will only apply to the selected element.
(Example: Go to the Style Properties through a question‟s properties
window. Change the Question Color from Black to Blue. Only that
question will turn blue. Any new questions you add will use the Question
Color defined at the next higher level (black).
Select an individual element, change the style properties and click the
Apply Style button. The selected element will change and anything
below that element will also change based on what was in the Style
Properties window, regardless of what was actually changed. (Example:
Go to the Style Properties through a question‟s properties window.
Change the Question Color from Black to Blue. Only that question will
turn blue. Any new questions you add will use the Question Color defined
at the web form level (black). Anything else that was in the Style
Properties window for questions and answers will carry through to that
particular question. So if that question‟s answers happened to be green
but the Style Properties window has answers set to black, that question‟s
answers will now be black. Any new questions and answers you add will
use the Question/Answer Color defined at the next higher level (black),
as well as the other properties.
Tip: Here is a good rule of thumb to remember when using styles:
When using the OK button in the Style Properties window, if a
property is changed, all elements that had the original property‟s
value will be updated with the new value. However, disparate
elements will remain the same. The purpose of this rule is so that if
you intentionally format an element in a special way, its style will
not be overwritten accidentally. However, remember that Apply
Style applies all formatting across the board.
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The following sets of instructions will help you apply formatting options to
various parts of the web form.

To apply style properties to an entire
form
1

Double click the Web Form node,
which is the top node on the form.

2

Click the Format button.

3

Make the desired changes.

4

Click the OK button to accept the
changes and apply them to the web
form. Only properties that were
changed will be applied. Or click the
Apply Style button to apply all of the
settings in the Style Properties
window to the entire web form.

To apply style properties to a web form page
1

Double click the Page node to which you want the style applied.

2

Click the Format button.

3

Make the desired changes.

4

Click the OK button to accept the changes and apply them to the selected
web page. Only properties that were changed will be applied. Or click the
Apply Style button to apply all of the settings in the Style Properties
window to the selected web page.

To apply the same style properties to multiple pages
1

Select the pages to which you wish to apply a new style. You may select
multiple pages by clicking page nodes while holding down the Ctrl key. Or,
you may select the beginning page node, hold down the Shift key and then
select the ending page node to select a range of pages. To apply a change
to all standard pages, select the Standard Pages container.

2

After selecting the page elements, right click and select Properties.
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Note: Do not release the Ctrl or Shift key until after you right click
the mouse.
3

Click the Format button.

4

Make the desired changes.

5

Click the OK button to accept the changes and apply them to the selected
web pages. Only properties that were changed will be applied. Or click the
Apply Style button to apply all of the settings in the Style Properties
window to the selected web pages.

To change style properties of an individual element
1

Select an individual element (button, label, line, image, multimedia,
question or answer) by double clicking its node or by highlighting the
element, right clicking and selecting Properties.

2

Click the Format button.

3

Make the desired changes.

4

Click the OK button to accept the changes and apply them to the selected
element. Only properties that were changed will be applied. Or click the
Apply Style button to apply all of the settings for the selected element and
any elements beneath (e.g., a question and its answers) in the Style
Properties window to the selected element.

To change style properties of multiple elements
1

Select the elements you would like to change by holding down the Ctrl key
and clicking an element to select multiple elements, or by holding down the
Shift key and clicking a beginning and ending element to select a range of
elements.
Note: You must select the same type of element to be able to
change formatting options.

2

After selecting the elements, right click and select Properties.
Note: Do not release the Ctrl or Shift key until after you right click
the mouse.

3

Click the Format button.
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4

Make the desired changes.

5

Click the OK button to accept the changes and apply them to the selected
elements. Only properties that were changed will be applied. Or click the
Apply Style button to apply all of the settings for the selected element and
any elements beneath (e.g., a question and its answers) in the Style
Properties window to the selected elements.

7.3.1 Formatting and Question Tables
Please note that many style attributes for a question table override the style
attributes for individual questions/answers within the table. The following
question properties will not have an effect on the visual display if the question
is within a table. This is due to the fact that the properties are superseded by
the table‟s style:
Backcolor
Alignment
Indent Levels
Line Breaks After
Line Breaks Before Question‟s Answers
Answer Columns
The following answer properties will not have an effect on the visual display if
the answer is within a table. This is due to the fact that the properties are
superseded by the table‟s style:
Backcolor
All other style properties will have an effect on the answer choice text (e.g.,
Good, Poor, etc.) and main table headers, utilizing the formatting as defined in
the first question row.
Finally, the formatting options for the first defined answer column of a question
table will apply to all questions within the table.
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7.4 Creating Style Sheets
When applying styles to web forms, you can utilize a style sheet. Style sheets
can be saved and applied to multiple web forms. The style properties are the
same as those defined in the Style Properties window (see Section 7.2 for a
complete list). To save time and effort, you can reuse these styles by saving
them as style sheets. Then you simply apply a style sheet to other web forms.
You can still modify individual elements of a web form after applying a style
sheet.

To create a style sheet using the Style Sheet Editor
1

From the Home tab in the Ribbon,
click the Dialog Box Launcher
next to the word Formatting. The
Style Sheet Editor window will
appear.

2

Click the New button.

3

All of the properties from the Style
Properties window appear. Set
properties as desired for each part of
the web form.

4

Enter a name for the style sheet in the
Style sheet name box.

5

Click the Update button to save your changes.

6

Click the Close button to close the window. The style sheet is now saved
and can be applied to any web form in Remark Web Survey.

To create a style sheet using existing formatting options
If you have already created a web form and applied various formatting options
to it, you can save those options as a style sheet so that you can reuse them on
other web forms.

1

If not open already, open the web form that contains the formatting options
you want to save as a style sheet.
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2

Double click the web form name to access the Properties window.

3

Click the Format button.

4

On the toolbar of the Style Properties
window, click the Save button
. The
Style Sheet Editor window will appear.

5

Enter a name for the style in the Style sheet
name box.
Note: If you want to update a style
sheet that you have previously
saved, begin typing the existing
style sheet‟s name in the box.
Remark Web Survey will look for
matches based on the letters you
type and show you a list of possible
matches for updating.

6

Click the Update button.

7

Click the Close button to close the window.

The style sheet is now saved and can be applied to any web form in Remark
Web Survey.

To update an existing style sheet
1

From the Home tab in the Ribbon,
click the Dialog Box Launcher
next to the word Formatting. The
Style Sheet Editor window appears.

2

Select the style sheet you wish to
modify from the Pre-defined sheets
list.

3

All of the properties you had previously
set will appear. Modify the properties
as desired.

4

Click the Update button to save your changes.
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5

Click the Close button to close the window. The updated style sheet is now
saved and can be applied to any web form in Remark Web Survey.

To delete a style sheet
1

From the Home tab in the Ribbon,
click the Dialog Box Launcher
next to the word Formatting. The
Style Sheet Editor window will
appear.

2

Select the style sheet you wish to
delete from the Pre-defined sheets
list.

3

Click the Delete button to delete the
style sheet.

4

When prompted, click the Yes button
to delete the style sheet. (If you do not
wish to delete the style sheet at this time, click the No button to return to
the Style Sheet Editor.)

5

Click the Close button to close the window. The style sheet is now removed
from the available style sheets.

To apply a style sheet to a web form
1

From the Home tab in the Ribbon, click the down arrow on the Style
Sheets icon.

2

Choose the desired style sheet to
apply to the active web form.

3

When prompted, click the Yes
button to apply the style sheet. (If
you change your mind and do not
wish to apply the style sheet, click
the No button.)

4

The style sheet is applied to the
entire web form. You may still
change individual elements if
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desired. However, if you reapply the style sheet, any individual elements will
be modified to match the style sheet.
Note: Style sheets do not override rich text formatting.

To share style sheets
If you want to share your style sheet with another Remark Web Survey user,
you may do so as long as you have multiple licenses of the software. For
example, you may create a style sheet that you want to use as a standard for
all of the web forms you create. The style sheets that you create are stored as
XML files in the software‟s installation directory. You can provide these XML files
to another user and they can then apply the styles to forms they open in the
Remark Web Survey Designer.

1

Locate the style XML files, typically stored in the Style Sheets folder of the
Remark Web Survey installation directory (e.g., C:\Program
Files\Gravic\Remark Web Survey 5\Style Sheets).

2

Copy the files to the same path on the other user‟s system.

3

Open Remark Web Survey. You should see all of the styles you copied over
within the Style Sheet Editor and via the drop-down list for the Styles
icon on the Ribbon.

7.5 Rich Text Formatting
Rich text provides advanced formatting options for the text on your forms.
Using rich text allows you to apply formatting to individual portions of an
element. For example, you can add bold formatting to a single word in a label
for emphasis. Or, you can change the color of a single word in a question. You
may also enter “www” to insert a hyperlink (e.g., if you type www.gravic.com
and turn on rich text formatting, the text will become a hyperlink).
When using the rich text formatting window, you may select an entire word or
set of words and change its attributes. Or you may select a single word. You
may even select a single letter to format. If you click within a word but do not
actually select anything, the entire word will become formatted with the
selected rich text options.
Note that rich text settings override any text formatting styles selected (e.g., if
you have rich text formatting and apply a new style via the Style Properties
210

Formatting and Style Sheets

window, the elements formatted with rich text will not acquire the new style
settings.)
When the rich text formatting option is turned on, some style properties are not
be available. When you click the Format button for any element that has rich
text turned on, properties that can be modified while using rich text are
available. All other properties are disabled.

To use rich text formatting for questions and labels
1

Insert a question, or label element. Or, double click an existing question or
label element.

2

In the question or label text area, type the information you would like
displayed.

3

Mark the checkbox for Enable rich
text formatting.

4

Format the text as desired using the
toolbar in the rich text window. You
may adjust font selection, font
attributes, such as bold and italics, font
color, background color, alignment and
create bulleted lists.

5

Modify or add the rest of the element
properties (if necessary).

6

Click the OK button to save the changes.

To use rich text formatting for answers
There are two ways to modify rich text formatting for answer elements:

211

Remark Web Survey User’s Guide

To use rich text via the Question
Properties window
1

Insert a question element.

2

On the Answers screen, click
in the cell containing the
answer you wish to edit.

3

Click the link that reads
Access current answer’s
properties.

To use rich text via the Answer
Properties window
1

Insert an answer element, or
double click an existing answer
element in the tree view.

4

In the Answer Properties window, you may apply rich text formatting to
the HTML Display text. Type the information you would like displayed.

5

Mark the checkbox for Enable rich
text formatting.

6

Format the text as desired using the
toolbar in the rich text window. You
may adjust font selection, font
attributes, such as bold and italics, font
color, background color, alignment and
create bulleted lists.

7

Modify or add the rest of the element
properties (if necessary).

8

Click the OK button to save the
changes.
Note: It may be the case that the font you select here is not
available on the respondent‟s computer. Using the Remark Web
Survey program options, you can select more than one font for your
respondents. If the main font is not available on the respondent‟s
system, the backup fonts will be used. Select the Application Button
and then choose Web Survey Options to choose backup fonts
that will display when the selected font is unavailable.
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Chapter 8

8.1 Overview
Remark Web Survey allows you to build branching into your web forms.
Branching allows you to direct the respondent to another part of the web form
based on how one or more questions are answered. For example, you might ask
the following question:
Have you recently contacted our service department? Yes or No.
If the respondent selects “Yes” you may direct them to a series of questions
about your service department. If the respondent selects “No” you may let
them continue with the next question on the web form.
Branching gives you flexibility in form design so that you can better select
questions targeted to your respondents. At the same time, it makes the form
easier to fill out because the questions are tailored to the respondent.

8.2 Setting Up Branching
In order to use branching, you must first add pages and questions to the web
form. You can then add branching references so that if particular responses are
chosen, the respondent will automatically be taken to a specific page of the web
form.
Caution: We strongly suggest that you first build the entire web
form and then add branching. It is much easier to add branching
once you have all of the questions/pages created. Note that
branching is page specific, meaning that you can only branch to a
question on a different page. If you change the web form at a later
point, Remark Web Survey will resolve the established branch
patterns. However, for ease-of-use purposes, it is easier to create
the branches with a completely built web form.

213

Remark Web Survey User’s Guide

Branching is set up at the page level. Once you have set up the pages on the
form, you can go back and establish the branching patterns.
Caution: We strongly suggest that you make questions that are
used in question branching “required” in the question attributes. A
blank response for a question that triggers a branch pattern could
cause unexpected results.

To set up branching
1

Double click the page node to which you want to apply the branching
pattern(s).

2

Click the Branching setup link to view the Branching Criteria Builder
window. The Branching Criteria Builder window consists of the following
properties:
Property

Description

Random Page

Click the Random Page button to have the page
appear in random page order each time it is
accessed (this setting is useful when administering
tests or trying to eliminate question bias).
Typically you will use the random option for all
standard pages in the web form so that they all
appear in a different order for each respondent.

Text

Click the Text button to display the question text
for each question on the web form instead of field
names (applies to the Question column of the
branching grid). This setting depends on your
personal preference as to how you would like the
questions displayed. If this setting is not selected,
the questions will be listed in this window by field
name.
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Property

Description

Field Name

Click the Field Name button to display the field
name for each question on the web form instead of
question text (applies to the Question column of
the branching grid). This setting depends on your
personal preference as to how you would like the
questions displayed. If this setting is not selected,
the questions will be listed by question text in this
window.

Insert Statement

Click the Insert Statement button to insert a new
statement within the branching grid. This feature
is useful if you need to place a statement within
other statements that you have already defined.
Select an insertion point by clicking in a row first
and when you click Insert Statement, the grid
will add a row above your current selection point.
It will initially insert the row as part of the selected
statement. The Rule Numbers for the statements
will update themselves automatically as you begin
to enter the criteria for the statement. You only
need to use the Insert Statement function to add
statements between other statements. If you are
simply building a branching pattern from start to
finish, use the rows of the branching grid in
sequence on the screen.

Delete Statement

Click the Delete Statement button to remove a
statement within the branching grid. Select a
statement by clicking in a row and then when you
click Delete Statement, the grid will remove the
selected statement(s).

Group Statements

Use the Group Statement option to group parts
of the branch pattern (branching statements)
together. This feature is useful when setting up
multiple branch patterns on one page. It will allow
you to further customize the criteria that
determine the branch pattern by grouping like
statements together into one action.
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Property

Description

Ungroup Statements

Use the Ungroup Statements option to ungroup
parts of the branch pattern. Ungrouping
statements can be accomplished once you have
grouped statements, as described above. You can
use the ungroup option to make changes.

Question

Displays the questions on the entire form. Use the
Question list to select a question to which the
branch pattern will apply.

Operator

Displays the available operators for the branch
pattern, which include = (equal to), <> (not equal
to), > (greater than), < (less than), >= (greater
than or equal to), <= (less than or equal to),
starts with, ends with and contains. Select the
item to which your branching pattern applies.

Response

Displays the response choices from the selected
question. Select the Response choice that will
trigger the branch pattern or enter the appropriate
text for a textbox/text area question. For example,
if your choices are A, B, C and D and choosing C
will trigger the branching action, choose C from
this list. Or, if it is a textbox style question, enter
the text exactly as you expect your respondents to
enter text in order to trigger the next action.

Action

Allows you to select the next action. Use Go To to
set up a branch pattern that will send the
respondent to another page on the web form when
the particular response choice is selected. Use And
to continue to set up branch patterns whereby the
next pattern in the sequence must also be true in
order to complete the branch. Use Or to continue
to set up branch patterns whereby the next
pattern in the sequence may also be true in order
to complete the branch.

Target

Allows you to select the target action when using a
Go To action. Use the Target column to select the
page to which to branch based on the selected
criteria.
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Property

Description

If none of the
specified criteria is
met always branch to:

Allows you to set a page order. The default branch
page will be used in the absence of any userdefined branch patterns or if no branches are
satisfied. Use the Next Page in Sequence option
to have the respondent submit the web form in
sequential page order when the branch criteria are
not met.

Reset

Resets the current branch pattern, allowing you to
start over. Note that all branching statements will
be removed when you click the Reset button.

You will notice that there is a Criteria translation box below the branching
options that will display your branch patterns as you build them. You cannot
edit the text in this window, but you may use it to double check your logic when
setting up your branch patterns.
3

If desired, select whether to view the questions in the Questions column of
the branching grid by Text (question text) or Field Name.

4

In the Questions column, select
the first question on which to
base the branch pattern.
Note: You may resize
the columns in this grid
as you see fit.

5

In the Operator column, select
the appropriate operator for the
branch pattern (e.g., Q1 = Yes
or Q1 <> No).

6

In the Response column, select
or enter the question‟s response
on which to base the branch
pattern.

7

In the Action column, select the next action. If you want to add more
parameters to the branch pattern, select And or Or, depending on whether
the next criterion must be true (AND) or can be true (OR) in addition to the
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previous criterion. If you want the respondent to go to a particular page
based on this question and response, select Go To.
8

If you have selected Go To in the Action column, select a page in the
Target column. If you have selected And or Or in the Action column, leave
the Target column blank.

9

Continue to add branch statements as needed. You will notice that based on
the operators used and other criteria, the row headers in the grid update
with Rule numbers. The Rule numbers provide you with a quick way to see
patterns in your branching criteria.

10 If desired, use the Group Statements and Ungroup Statements buttons

to refine the branch patterns. For example, if two parts of the pattern
belong together, you may select them in the grid and then click the Group
Statements button. Click and drag the row headers to select items to group
together. When statements are grouped, Remark Web Survey will evaluate
them together before going on to the next branch sequence.
11 When you are finished building your branch pattern, go to the If none of

the specified criteria is met always branch to setting. In the If none of
the specified criteria is met always branch to drop-down list, select the
page to which respondents should be taken in lieu of any other branch
patterns. Select Next Page in Sequence to have the respondent go to the
next page on the web form when the current page is submitted. Otherwise,
select the appropriate page to return to the respondent when this page is
submitted.
12 Click the OK button to save your changes.

Note: When using branching with hidden questions that allow
multiple responses, you will not have a drop-down list available in
the Response column. You will need to manually enter the valid
responses separated by commas and enclosed in parentheses.
Example:
If your branching pattern has a Day field that equals multiple days, your
branching pattern may look like this:
Questions= “Day”
Operator= “=”
Response= “(Monday,Wednesday,Friday)”
Note that there are no spaces between answer choices.
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You may have an unlimited number of branch patterns in your web form. Note
that you will receive a warning when attempting to publish a completed web
form if the web form contains circular or broken references. A circular reference
could put the respondent in an infinite loop when submitting the web form,
indicating that you have not given them a way to submit the web form
successfully based on their responses. Therefore, set up branching patterns
carefully, ensuring a smooth transition from page to page regardless of the
response chosen.

8.2.1 Branching Example
To help explain how branching works, we have included a sample below.
Suppose you are conducting an employee survey to assess your organization.
On this survey, you want to ask some questions that pertain to managers,
directors and vice presidents only. Your form contains three Standard pages and
one Web Form Complete page. The Standard pages are called: Page 1- Opening
Page, Page 2- Manager Questions, Page 3- General Employee Questions. On the
first Standard page, you ask the following question:
What is your position: Associate, Supervisor, Manager, Director, Vice President.
In order to direct the respondents who select Manager, Director or Vice
President to a separate set of questions, your branching would be set up like
this:
Question

Operator

Response

Action

What is your position?

=

Manager

Or

What is your position?

=

Director

Or

What is your position?

=

Vice
President

Go To

If none of the specified criteria is met always
branch to:

Target

Page 2Manager
Questions

Page 3- General
Employee Questions

This setup can be interpreted as:
If respondents select Associate OR Supervisor, they will be directed to Page 3General Employee Questions.
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If respondents select Manager OR Director OR Vice President, they will be
directed to Page 2- Manager Questions.

8.3 Random Page Order
(*Professional Version Only*)
You may choose to have web form pages appear in random page order for each
respondent. Random page order helps to eliminate the likelihood of viewing
others‟ responses as well as question bias based on the order in which questions
are presented. Randomization is turned on in the Branching Criteria Builder
window.
Note: When using random page order, you should not place a back
button on the web form‟s pages.

To set up random page order
1

Double click the page node to which you want to apply the branching
pattern(s). Remember that if you want all of your standard pages to appear
in random order, you should apply the random branching pattern to all
pages. You can multi-select pages by holding down the Ctrl key while
clicking the page node in the tree view with the mouse (do not release the
Ctrl key until you perform the
next action, such as right
clicking and choosing
Properties). You can also select
all standard pages by clicking
the Standard Pages container
node in the tree view.

2

Click the Branching setup
link.

3

Click the Random Page button
in the upper left hand corner of
the window.

4

Click the OK button to
continue.
Note: Random page order occurs in groups. For example, you could
have pages 2, 3 and 4 appear randomly for each respondent. This
means that this group of three pages will appear randomly each
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time the web form is accessed. Any sequential pages that you set to
the Random setting will be placed in one group. Therefore, you
could have multiple groups of randomized pages. For example,
suppose you have a 10-page web form and you set pages 1-3 to be
random and 6-9 to be random. Two groups of random pages are
created, meaning that pages 1-3 would always randomize, then 4-5
would always appear next, then 6-9 would always be randomized.

8.4 Branching Visualizer
Remark Web Survey includes a Branching Visualizer that displays the branching
patterns you have set up in one concise window. This feature provides a way for
you to review all of the branching you have set up on a web form in one place.
Then you can go back to individual web form pages and make modifications if
necessary.

To use the Branching Visualizer
1

Before utilizing the Branching Visualizer, set up your branching patterns, as
described previously in this chapter.

2

From the Ribbon select the Tools tab.

3

Locate the Branching References icon and then drop-down the arrow at
the bottom.

4

Click Branching Visualizer.

5

The pages of the web form are listed
on the left. Expand any page by
clicking the right arrow to the left of
the page name.

6

Each page name is followed by Will
Navigate To or Could Navigate To.
If you see Will Navigate To, there is
no explicit branching on the page and
the default setting of going to the
next page in sequence is in place. If
you see Could Navigate To, it is
likely that branching is set up on the
page.

7

Each branching pattern is displayed in the right side of the window. When
you click a page on the left, you will see the possible pages that can be
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branched to on the right. To dig deeper, if you click the page sub nodes
beneath the top level page, you will see the questions and responses that
trigger the specific branch to that page.
8

When you have finished reviewing the branching patterns, click the Close
button to close the Branching Visualizer.

You cannot make changes to the branching patterns in this window. If you see a
problem, close the Branching Visualizer and then go to the page that contains
the problem and make the necessary adjustments. You can always return to the
Branching Visualizer to review the updates.

8.5 Branching Validator
Remark Web Survey includes a Branching Validator that checks an entire web
form for invalid branching patterns. It will look for circular references and
branches to pages or questions that do not exist. In other words, it looks for
branching patterns that simply will not work because they are not properly set
up. Remember that only you know the questions on your web form and how
you want respondents to navigate the form. You are responsible for ensuring
the accuracy of the branching patterns. Remark Web Survey will ensure the
functionality of the branching patterns.

To use the Branching Validator
1

Before utilizing the Branching Validator, set up your branching patterns, as
described previously in this chapter.

2

From the Ribbon select the Tools tab.

3

Click the Branching References icon.

4

Remark Web Survey will check the entire web form for invalid branching
patterns. Please note that for long/complex forms, this process may take a
few moments.

5

If no problems are found, Remark Web
Survey displays a message box stating
that no issues were found; click the OK
button.

6

If problems are found the Branching
Issues window appears. This window
displays any pages where branching
problems exist, as well as the issue
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found (e.g., missing reference or circular branching).
7

You should go back to the page(s) displayed and make the appropriate
adjustments in the Branching Criteria window. You may leave the
Branching Issues window on the screen for reference. Note that the
majority of branching problems result from setting up a branch pattern and
then later removing a question or page that was part of the branch criteria.

8

Once you have made the appropriate adjustments, run the Branching
Validator again to ensure all of your branch patterns will execute
successfully.
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Chapter 9

9.1 Administering Web Forms Overview
Remark Web Survey allows you to host the web forms that you create in the
software on your own Windows or Linux/Unix web server. By hosting the web
forms yourself, you have complete control over the administration of the web
forms and their data. There are no limits in terms of number of web forms that
can be published at one time or number of responses allowed (unless you define
a limit in the web form‟s properties). Administering forms is accomplished with
the Perl scripts provided with the software. The administration script,
rwsad5.pl (also known as the Remark Web Survey Control Panel), allows you
to publish web forms and download or view the data submitted from those web
forms. Each web form you create in Remark Web Survey is published to your
web server, which can be accomplished automatically or manually. Automatic
publishing of web forms places the entire contents of the web form (e.g., pages,
images, etc.) in a folder on your web server. All data are collected in the same
folder. The end result is that each individual web form has its own location on
the web server for organizational purposes. Alternatively, manual publishing of
forms requires you to go through a separate form installation process via the
administration script.
Once the administration script is up and running, you can begin publishing web
forms. The data are collected via the data script (rws5.pl). Installing the
scripts is covered in Chapter 2: Installing the Software. Your website
administrator should install the scripts and verify that they are working
properly. However, anyone with proper permissions can access the
administration script to publish forms and download data.

9.2 Setting Up Default Script Locations
Remark Web Survey web forms are often created and published by different
people. To streamline the form publishing process, you should set up the default
locations for the Remark Web Survey scripts within the Designer component of
Remark Web Survey, making it possible for people creating web forms to
225

Remark Web Survey User’s Guide

publish the forms without the intervention of the website administrator. When
these options are set up properly in the designer portion of the software, the
location of the data collection script will be written to each HTML file you create,
which will allow proper web form submission. This topic is covered in greater
detail in Section 2.3.9, but the basics are repeated below.

To enter the script URLs in the Designer Component
1

In the Remark Web Survey Designer Component, select the Application
Button
and then click Web
Survey Options.

2

Under Server details, enter the
Admin script URL and the Data
script URL. Both URLs must be
fully qualified URLs (e.g.,
http://www.example.com/cgibin/rwsad5.pl). Your website
administrator, or the person who
installed the Remark Web Survey
Server component, should be able
to provide these URLs to you.

To set email settings in the Designer Component
In Remark Web Survey, emails can be used for three different functions: 1) the
built-in email client that is used to send web form invitations and reminders, 2)
submission notification emails that are sent every time a web form is completed
by a respondent, or 3) pause page reminders to resume a web form once it is
started and stopped. You can use an SMTP server (Simple Mail Transfer
Protocol) or a Sendmail server to send emails from Remark Web Survey. These
two types of setup are simply different methods o f sending email. Please note
that the built-in email client will only work with an SMTP mail server. If your
web server is configured to use a local Sendmail server, Remark Web Survey
can utilize the Sendmail server for sending submission emails or for sending
pause page email reminders to respondents who have paused a web form in
progress.
Setting up and configuring email servers is independent of Remark Web Survey.
Once you have determined the type of email method to use and verified your
email server is working, you can configure Remark Web Survey to use it. To set
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up the email functionality in Remark Web Survey, you will likely need the
assistance of your web server or network administrator. This person should be
able to tell you the information that Remark Web Survey requires, such as the
names of the servers and ports that they use.

3

Continuing from Step 2 above, click the link titled Email settings.

4

Enter the Administrator email address. This email address is often the
webmaster of the website, but can be any
email address of your choosing. It should
be someone who is familiar with Remark
Web Survey and in a position to
troubleshoot any web form issues that may
arise.

5

Under Email method and settings, first
set up the Web Server email settings.
Web server email is generated for email
messages that are transferred by the web
server, such as form submission emails,
advanced notification emails and pause
page reminders.

6

Choose the type of email configuration you
are using: SMTP or Sendmail.

7

If using SMTP, enter the SMTP server and the SMTP port. The SMTP port
is usually 25 but may vary with your email server.

8

[Optional] If authentication is required, enter the Username and
Password.

9

If using Sendmail, enter the Server path
(e.g., /usr/sbin/sendmail).

10 Next, set up the Local Machine email

settings. The local machine is used for
emails that are generated from the local
computer, such as web form invitations and
reminders.
11 Enter the SMTP server and the SMTP

port. The SMTP port is usually 25 but may
vary with your email server.
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12 [Optional] If using a secure connection, mark the checkbox for Enable a

secured (SSL) connection.
13 [Optional] If you need to use authentication, you can enter credentials or

use those of the user. Mark the Use the default credentials of the
currently logged in user checkbox to utilize the user‟s credentials (e.g.,
the person logged in when sending the emails from the Remark Web Survey
Designer component). Otherwise, continue to Step 14 to enter specific
credentials.
14 [Optional] If authentication is required, enter the Username and

Password.
15 Enter a Throttle rate or accept the default setting (500 ms). The throttle

rate specifies how many milliseconds to wait before sending the next email
in the queue. This setting helps prevent the email server from becoming
overloaded when sending a large number of emails.
16 Click the OK button to save the options.

Note: Please review Section 2.3.9.1 for detailed information about
requirements when using server authentication.
Each new web form you create will now use these properties. If you need to
change any of this information for an individual web form, you can do so within
the web form‟s properties. See Chapter 4 for further information about editing
an individual web form‟s properties.

9.3 The Remark Web Survey Control Panel
The Remark Web Survey Control Panel appears each time you access the
administration script (rwsad5.pl). The Control Panel allows you to administer
web forms, including managing data files, manually installing web forms and
obtaining a quick overview of a web form‟s statistics (Remark Live Stats™). You
may access the Control Panel in one of two ways:
From within Remark Web Survey, select the Web tab from the Ribbon
and then click Control Panel.
From a web browser, enter the URL to the administration script (e.g.,
http://www.example.com/cgi-bin/rwsad5.pl).
A username and password is required to gain access to the Control Panel. The
default username is administrator and the default password is rws, but the
password may have been changed during installation (we recommend changing
the password for security reasons). The person who installed the Remark Web
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Survey Server component sets up the administrator password. There can only
be one account named administrator that accesses the Control Panel. You may
make other accounts with various privileges using different usernames. Each
user who is able to publish forms and download data automatically from the
Designer component needs a username and password, which will be entered in
the Admin Control Panel access area of the Designer component. Please see
Section 2.4.8 for detailed information about setting up user accounts.
Once you login to the Control Panel, you have several options related to web
form and data administration (these options vary based on your permission
level). You may perform the following functions from the administration Control
Panel:
Tab

Feature

Description

Server
Setup

Default form directory

Specifies a default directory for
storing all active web forms. If
using the auto publish feature,
each time you publish a web
form, the form is automatically
published to the web server and
a new sub-directory is created in
the Default form directory.
If using the Create Publish
Package form of publishing,
which is a manual process, you
will have to place each installed
web form and its components in
the Default form directory. Each
form will have its own subdirectory.
Caution: This directory should
be a non-public directory for
optimum security. The Remark
Web Survey scripts must be able
to read, write and delete
information to and from this
directory.
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Tab

Feature

Description

Image script name

Specifies the name of the image
script used to handle the
publishing of web form images.
This script is supplied with
Remark Web Survey and should
be uploaded to your CGI
directory. By default, this script
is called rwsimg5.pl. However, if
your web server uses the .cgi
extension for scripts, you may
change it to rwsimg5.cgi. Do not
change the name of the file up to
the extension.

Enable automatic
publishing

Allows for automatic publishing
(uploading) of forms directly
from Remark Web Survey to the
web server. When users click the
Publish Web Form button in
the Designer component (after
supplying a valid Control Panel
username and password), the
forms will automatically be
uploaded to the Default form
directory and installed on the
web server. This action
eliminates the necessity of a
website administrator‟s
intervention to post web forms
on your web server. If you do not
enable automatic publishing,
users will have to use the Create
Publish Package method of
posting web forms. A webmaster
(or similar) will need to place the
published forms on the web
server and install them via the
Remark Web Survey Control
Panel.
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Tab

Feature

Description

Enable automatic
downloads

Allows for automatic downloading
of data directly into Remark Web
Survey from the web server
(after supplying a valid Control
Panel username and password).
This action brings the data
directly into the software, where
it can then be analyzed with
Remark Quick Stats® or exported.
If you do not allow automatic
downloading of data, you will
need to download the data from
the Control Panel in a web
browser and then open it in
Remark Web Survey.

Enable respondent
logging

Allows for a log file to be kept for
each form submission, showing
the unique ID, IP address, date
and time of the submission, as
well as whether it was
successful. If a problem occurs, it
is listed in the log file (e.g., the
respondent could not login due to
an invalid password). Generally
speaking, you want to enable
respondent logging in case a
problem arises.
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Tab

Feature

Description

Use CGI for form
redirections

The Use CGI for form
redirections setting applies
when you redirect a respondent
in your Web Form Complete
page. Web Form Complete pages
can simply be links to another
page. This is called redirection.
Enable the Use CGI for form
redirections setting to redirect
the user utilizing the CGI‟s built
in redirect method. If you do not
use this setting, Remark Web
Survey will use a basic HTML
redirection. This setting is
enabled by default. You should
only change this setting if
redirection is not working using
the default setting.

Enable data backup
during uploads

Use the Enable data backup
during uploads option to
automatically create a backup of
the data file when a form is
published to the web server and
the user selects to overwrite the
data. A file called
“archivedatetime.bak” is created.
If needed, you can rename this
file with a .rwd extension to
restore your data. Note: this
setting is only available when
publishing forms from the
Designer component (not when
deleting data via the Control
Panel). It does not back up the
log file or temporary files.
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Tab

Web Forms

Feature

Description

Define local IP address
for SMTP

Use the Define local IP
address for SMTP setting to
change the client-side IP address
used by Perl when making a
socket connection to an SMTP
server. This feature is useful if a
computer has multiple IP
addresses so that you can ensure
the correct one is being used.

Select form

Use the Select form drop-down
list to select a currently installed
web form and then choose the
desired actions listed below.

Install Form

Use the Install form button to
install web forms when automatic
publishing is not enabled. If you
do not publish your web form
automatically, you must first use
the Create Publish Package
method to generate the web
form, place it manually on your
web server in the Default form
directory and then install it via
the Remark Web Survey Control
Panel. After clicking Install Form,
enter the form name exactly as it
appears in Remark Web Survey
(the form name is the top node
of your web form when opened in
the tree view of the designer)
and then click the Install Form
button.
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Tab

Feature

Description

Access Form

Use the Access Form button to
launch the live web form in your
web browser. This feature is
useful if you need to test a web
form. Note that the web form will
display in a new window. If you
have pop ups blocked you may
need to update your web browser
to allow pop ups for this site.

View Log

Click the View Log button to
view the current log file for the
selected web form. The log file
holds information about each
submission, such as the date,
time and success or failure.

Download Log

Click the Download Log button
to download the current log file
for the selected web form. You
can open the resulting file in a
text editor, such as Notepad.

Reset Log

Click the Reset Log button to
reset the log file for the selected
web form. Resetting the log file
removes any log file entries for
web form submissions up to this
point. Note that once you reset
the log file you will not be able to
get it back.

234

Administering Web Forms

Tab

Data &
Stats

Feature

Description

Remove Form

Use the Remove form option to
uninstall a web form. Select the
desired web form from the dropdown list and then click the
Remove Form button. This
action is appropriate when the
web form is no longer active.
This option will not physically
remove the web form and its
components from the web server
unless you select the checkbox
for Remove server files.
However, respondents will no
longer be able to access the web
form.

Remove server files

Mark the Remove server files
checkbox to remove all web
form-related files from the web
server (e.g., HTML files, images,
data file, log file) when removing
a web form. Note that you will
not be able to get the files back
once you remove them. Ensure
that you have downloaded your
data file prior to removing a form
and its server files.

Select form

Use the Select form drop-down
list to select a currently installed
web form and then choose the
desired actions below.
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Tab

Feature

Description

Remark Live Stats

Click the Remark Live Stats
button to view current statistics
for each question on the web
form. The statistics are updated
dynamically each time you click
the button. You may also print
the results. See Chapter 11 for
detailed information about
Remark Live Stats.

View Data

Click the View Data button to
view the current data for the
selected web form.
Note: If a question is set to
Treat each answer choice as a
separate question, the data
will appear as one question in
this view. When downloaded, the
data will be output to separate
data cells.

Download Data

Click the Download Data button
to download the current data for
the selected web form. The data
will be in a format called .rwd.
Do not change it from this
format. The Remark Web Survey
designer will be able to open this
data file, allowing you to export
it to another format or analyze it
within the software. When
downloading data, be sure that
the file extension remains .rwd in
your browser‟s Save window.
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Tab

Feature

Description

Incomplete Data

Click the Incomplete Data
button to download any data
submissions that were not
completed. Incomplete data
resides on the web server when
someone starts to complete a
web form but never finishes it.
You may open this data into the
Remark Web Survey Designer
component and then determine
how much of the web form must
be completed in order to include
the incomplete submissions in
the analysis. See Section 10.2.2
for more detailed information.
(*Professional Version Only*)

Reset Data

Click the Reset Data button to
reset the data file for the
selected web form. For example,
you may test your web form
before allowing respondents to
submit it; you can use the Reset
Data button to clear out your test
data. Or, you can use the Reset
Data button for cyclic web forms
that you collect data on
repeatedly. Once one term is
completed, you can download
and save the data, clear it and
then start over again. Note that
once you reset the data you will
not be able to get it back. Ensure
that you have a local copy of the
data before resetting the data.
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Tab

Feature

Description

Users

Add User

Click the Add User button to add
user accounts to the Control
Panel. The default user account
is administrator. This account is
used when publishing forms and
downloading data. You can
create other access accounts and
set the permissions for those
accounts. When you click the Add
User button, enter a Username
and Password for the new
account. Then set the
permissions:
Administrator: User has full
access to the Control Panel.
Standard User: User can only
view statistics and data, but for
all installed forms. Optionally,
user can be allowed to publish
web forms automatically and
download data from the Designer
component.
Restricted User: User can only
view statistics and data for the
web forms that you select.
Optionally, user can be allowed
to publish web forms
automatically and download data
from the Designer component for
the specified web forms.

Password

Click the Password section to
change the password used to
access the Remark Web Survey
Control Panel. Enter the old
password, the new password and
then confirm the new password.
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Tab

Feature

Description

Diagnostics

The Diagnostics information
assists with troubleshooting
server issues. It is primarily used
by Gravic Support. Problems with
script permissions are
enumerated here. This area also
shows all installed web forms,
along with a test email button to
ensure email functionality is
working. The SMTP Test Script
area is used to troubleshoot
email issues; Gravic support will
instruct you on how to use this
section. Finally, a link to the
Remark Web Survey test script
(rwstest5.pl) is available for
more detailed troubleshooting.
Please install and launch this
script in order to provide these
details to Gravic Support when
having server (script) issues.

9.4 Resetting the Default Administrator Control Panel
Password
There may be a reason you need to completely remove the stored administrator
password for the Remark Web Survey Control Panel (e.g., the current password
is lost, the person responsible for administration leaves and you do not know
the password, etc.). The password is stored in a configuration file (rwsem5.cfg)
that can be safely deleted if necessary.
Note: The password configuration file should only be deleted by the
website administrator or another qualified individual.

To delete the Administrator Control Panel password
1

Using an FTP program, logon to your web server. Or, if your web server is
in-house, logon to the web server computer.
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2

Locate the file called rwsem5.cfg in your Remark Web Survey config
directory. We suggest backing up the file before you delete it.

3

Delete the rwsem.cfg file. This will reset the administrator password to the
default password, which is rws. The next time you access the Remark Web
Survey Control Panel, you will be prompted to change the password for the
administrator account.

9.5 Publishing Web Forms - Automatic Web Form
Publishing
Once you have created a web form in Remark Web Survey, you need to publish
it to your web server. There are two ways to publish forms:
Automatic: Clicking the Publish Web Form button in the Remark Web
Survey designer.
Manual: Clicking the drop-down arrow on the Publish Web Form button
and choosing Create Publish Package in the Remark Web Survey
designer.
The automatic publish option makes it easier for you to move the web forms
from a local system to the web server without the assistance of a website
administrator. In order to publish web forms automatically, this option must be
enabled in the Remark Web Survey Control Panel (see Section 9.3 for further
details) and the user must have a Control Panel login with automatic form
publishing enabled (see Section 2.4.8 for further details). In addition, the
current user must have the appropriate permission level to access your web
server. Your website administrator is responsible for setting permission levels
on your web server. If you do not have permission to access your web server,
you will need to manually publish files to the web server. This topic is covered
in Section 9.6.
If automatic form publishing is enabled, when a user clicks Publish Web Form in
the Designer component, the web form and all of its related files, such as
images, multimedia and configuration files, will be posted to the web server in
an individual folder. This folder is created in the Default form directory that is
specified in the Remark Web Survey Control Panel.
Caution: The Default form directory should be a non-public
directory for optimum security. The Remark Web Survey scripts
must be able to read, write and delete information to and from this
directory.
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For example, if the Default form directory is C:\Inetpub\surveys, each time a
web form is published using the Remark Web Survey designer, a new folder will
be created in the C:\Inetpub\surveys folder. If a web form is called
“satisfaction_survey” a folder called satisfaction_survey will be created in the
surveys folder. The satisfaction_survey folder will contain the HTML pages of the
web form, any related image files, configuration files and, as the web form is
submitted, the data files, log files and unique IDs of each respondent. Note that
data script (rws5.pl) will need to be able to write data to this directory each
time a web form is submitted. Therefore, the Default form directory should be
set up with permissions that allow the data script to read, create, write and
delete information.
Once the publish process completes, the web form is ready to use. You do not
need to install the web form separately.

To allow automatic web form publishing (enabled by default)
1

Login to the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script) using an account with administrator privileges.

2

If you have not yet configured a default form directory, in the box titled
Default form directory, enter the
path of the folder where you would
like all web forms to be published. You
have full control over the path you
choose. It can be any location on your
web server.
Caution: The Default form
directory should be a nonpublic directory for optimum
security. The Remark Web
Survey scripts must be able
to read and write information
to and from this directory.

3

Mark the checkbox for Enable automatic publishing.

4

Click the Update button to set the configuration. You should receive a
message indicating that the configuration change was successful.
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To publish web forms automatically
1

Create a web form in the designer portion of Remark Web Survey.

2

When completed, expand the Admin Control Panel Access bar at the
bottom of the window (if it is not already expanded). You may view the
Admin Control Panel Access bar by either clicking the expandable
splitter,
, at the bottom of the window, or by selecting the View tab
from the Ribbon and then clicking Admin Control Panel Access.

3

Login to the Remark Web Survey Control Panel. Enter your Username and
Password and then click the Login button.

4

Once logged in, click the Publish Web Form button.

5

After the web form is published, a window will appear showing you the URL
to your web form and asking if you would like to view the web form in a web
browser. If you click Yes, your default web browser will open the web form
and you will see the URL that your form uses. You must provide this link
exactly as it appears in this window to the respondents who will be
submitting the web form (e.g., if you are sending an email to direct
respondents to your website to submit the form, give them this link. Or, if
you are putting a link on your website to the form, use this link). This link is
in the format of: http://www.example.com/cgibin/rws5.pl?FORM=formname, where cgi-bin is the CGI/script directory
on your website, rws5.pl is the Remark Web Survey data script and
formname is the name of the web form being submitted. You can copy the
web form URL to the Windows clipboard at any time by clicking the Copy
Web Form URL to clipboard link in the Web Form Details section of the
Remark Web Survey designer. Copying the link is useful if you will be adding
a link to your web form on a page of your website or placing it in an email
message. For example, you can open an existing website page in an HTML
editor, copy the link from Remark Web Survey and then paste it into the
appropriate location on your website page. When you upload your website
page, the link will be available for respondents to reach your form.

6

Click the Yes button to view the form online or click the No button to return
to the designer.
Tip: If using a password protected web form, it is possible to
embed the user‟s password within the link you send out to submit
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your web form. Embedding the password will allow the user to
simply click the link and go right to the web form without having to
enter a password. The password can still be added to the data file
and used to track which respondents have submitted (or not
submitted) the web form. Use the following syntax to embed the
password in a link: http://www.example.com/cgibin/rws5.pl?FORM=name&PWD=password, where “password” is the
actual password for the respondent. This syntax only applies when
sending email outside of Remark Web Survey. If you are using the
built-in email center see Section 9.8 to learn how to embed
passwords into the URL or email invitation.

9.5.1 Overwriting Existing Web Forms
If a web form already exists on your web server, when you attempt to publish it
again, you will be prompted to overwrite the existing web form. You may
choose to only overwrite the existing HTML pages, or you may also overwrite
the existing data file, log file and temporary files. If you overwrite the data, log
and temporary files, you will not be able to recover log and temporary files. This
action resets the data and log files on the web server, deleting the existing files.
Note that a backup of the data file only is created if this setting is turned on in
the Remark Web Survey Control Panel (it is on by default; see Section 9.3). The
backup file‟s syntax is “archive-datetime.bak” (e.g., archive-20094101415.bak,
where “2009410” is April 10, 2009 and “1415” is 2:15PM). Ensure that you
have downloaded any data and/or log files you wish to keep prior to overwriting
them. The temporary files include data from partially completed forms.
Whenever a respondent accesses your web form, a UID (unique identifier) is
created. This UID file tracks respondents so that they can pause the web form
and come back to it at a later time. Once again, ensure that these UID files are
no longer needed before selecting to overwrite the data, log and temporary
files.
For password protected web forms, a password file is published to the web
server in the Default form directory. This file contains the allowed passwords in
an encrypted state along with the number of uses allowed for each password.
When you publish and overwrite a web form that uses passwords, you have
three options for handling the password file:
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Overwrite Option

Description

Merge existing
password file with the
latest version

When using the merge option, the file you are
publishing is the master. If passwords exist in that
file but not on the web server, they will be added. If
passwords do not exist in the file you are
publishing, but do exist on the web server, they will
be removed from the web server. In short,
whatever exists in the file you are publishing is
what will end up on the web server as valid
passwords. Note that when using the merge option,
the usage count for existing passwords is not
affected. Therefore, if a password exists in the file
you are publishing and on the web server, its usage
count will not be reset. Use this option when you
want to add passwords to the password file on the
web server but do not want to modify the usage
count (e.g., a web form is already in progress).

Overwrite the existing
password file with the
latest version

When using the overwrite option, whatever is in the
password file you are publishing is what will be
used on the web server. This option will reset
passwords and the usage count. Use this option
when you want to completely update the password
file on the web server with the current information
in your .rwsx file (e.g., after testing the form to
ensure that it works, you may wish to reset all of
the passwords so your respondents can begin
submitting the web form).

Keep existing password
file

When using the keep option, the password file that
already exists on the web server will be used.
Anything listed in the password area of the web
form you are publishing will be ignored. Use this
option when you want to make a change to the
form that does not affect the passwords; this
method will allow you to publish web form changes
without affecting any passwords that may have
already been used.
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Overwriting existing web forms
1

When the web form is ready to publish, expand the Admin Control Panel
Access at the bottom of the designer window (if it is not already expanded).
You may view the Admin Control Panel Access bar by either clicking the
expandable splitter
at the bottom of the window, or by selecting
the View tab from the Ribbon and then clicking Admin Control Panel
Access.

2

Login to the Remark Web Survey Control Panel. Enter your Username and
Password and then click the Login button.

3

Once logged in, click the Publish Web Form button.

4

When the Published Web Form Exists window appears, select whether to
Overwrite or Cancel.
Before selecting a
button, choose whether
to remove the existing
data, log and temporary
session files (see
previous explanation of
this option). Use extreme
caution when choosing to remove these files. You will not be able to get the
log files or temporary files back.

5

[OPTIONAL] If using a password
protected form, select how you
would like to handle the
password file, as described
previously.

6

Click the Overwrite button to
proceed with the web form
upload. If you do not wish to
overwrite the web form at this time, click the Cancel button.

7

After the web form is published, a window will appear confirming that the
web form was successfully published. Click the Yes button to view the web
form online or the No button to go back to the designer.
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9.6 Create Publish Package - Manual Web Form
Publishing
If you choose not to allow automatic web form publishing all web forms will
have to be published (uploaded) manually and then installed via the Remark
Web Survey Control Panel. When using the manual publish process, you will
create a publish package. This process combines all of the files needed to
administer the web form into one folder. During the publish process, you select
where that folder should be stored. You may then move the contents of the
folder to the proper location on your website (e.g., via an FTP program or, if
your web server is in-house, by copying the files to the web server).
If you primarily design web forms but are not involved in the server side of the
process, you will need to get your website administrator involved at this point.
Once the publish package is created, you can provide the folder that is created
to the website administrator to post on the web server. It is strongly
recommended that your website administrator reads this section of this user‟s
guide.
Note: Using the Create Publish Package feature requires that
you create the appropriate sub-directory under the Default form
directory specified in the Remark Web Survey Control Panel. The
entire contents of the directory that is created during the Create
Publish Package process should be placed in the Default form
directory (e.g., copy the folder to the Default form directory). If
the files are not placed in this directory, web form submission will
not work correctly. Please do not rename any files in the folder or
the folder itself.
Tip: Remember that if you are using an FTP program to upload files
to your web server, HTML, configuration (.cfg) and text files need to
be uploaded in ASCII format. Images and multimedia files should
be uploaded in Binary format.

To use the Create Publish Package feature
1

Create a web form in the designer portion of Remark Web Survey.

2

When completed, select the Application Button
, then select Publish
and then click Create Publish Package. Alternatively, expand the Admin
Control Panel Access bar at the bottom of the window (if it is not already
expanded). You may view the Admin Control Panel Access bar by either
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clicking the expandable splitter
at the bottom of the window, or by
selecting the View tab from the Ribbon and then clicking Admin Control
Panel Access. Click the down arrow on the Publish Web Form button and
then select Create Publish Package.
3

In the Browse for Folder window, choose
a location in which to store the web form
and related files. Remark Web Survey will
create a subfolder in this folder containing
the files. This location can be directly on
your web server, or a temporary holding
place (you can move the files to your web
server later).

4

Click the OK button to save the files.

5

If not already completed in Step 3, move
the files to the Default form directory on
your website (e.g., use an FTP program to
move the files from your local system to your web server). See your website
administrator for assistance.
Note: Do not change the names of the folder or files that are
created by Remark Web Survey.

Once you have created the publish package, you must manually install the web
form before it can be used.
Note: The manual form installation process only applies to forms
that are published using the Create Publish Package method.
Automatic publishing using the Publish Web Form option does not
require separate form installation.

To install web forms
1

After placing the web form and related files on your web server in the
specified Default form directory, access the Remark Web Survey Control
Panel in a web browser (rwsad5.pl script). You may access the Control
Panel by selecting the Web tab from the Ribbon and then choosing Control
Panel from within Remark Web Survey, or by entering the URL of the
Remark Web Survey administration script (rwsad5.pl) in a web browser.
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2

You will need to login with an account that has administrator privileges to
install web forms. Enter the username in the Username box and the
password in the Password box and then click Login.

3

Click the Web Forms tab.

4

Click the Install Form button.

5

In the box titled Enter form
name enter the name of the web
form that you wish to install. The
form name must be entered
exactly as it appears in the top
node of your web form in the
designer portion of Remark Web
Survey (including capitalization).
It is not the name of the .rwsx
file.

6

Click the Install Form button to complete the web form installation. You
should receive a message indicating that the web form was successfully
installed.
Note: If the installation is not successful, check the name of the
web form that you entered. Incorrectly typing the web form name is
the most common cause of form installation errors. Remember that
it must be entered exactly as it appears in the Remark Web Survey
Designer component (not the name of the .rwsx file).

Your web form is now ready for use. You will need to provide a link to your web
form in order for respondents to access it (typically you will send an email to
direct respondents to your website to submit the form or put a link on your
website to the form). The web link should be in the following format:
http://www.example.com/cgi-bin/rws5.pl?FORM=formname, where
cgi-bin is the CGI/script directory on your website, rws5.pl is the Remark Web
Survey data script and formname is the name of the form being submitted.
Note: You may also click the Copy Web Form URL to clipboard
link, which is located in the bottom of the Web Form Details
window, to copy the link to the Windows clipboard. Copying the link
is useful if you will be adding a link to your form on another page of
your website or placing it in an email message. For example, you
can open an existing website page in an HTML editor, copy the link
from Remark Web Survey and then paste it into the appropriate
location on your website page. When you upload your website page,
the link will be available for respondents to reach your form.
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9.7 Removing Installed Web Forms
Web forms can be removed when they are no longer needed. Removing a web
form with the Remark Web Survey Control Panel removes the form‟s properties
from the rwsad5.cfg file, making it unavailable on your web server. You may
also optionally remove all web form related files from the web server.
Caution: Before removing all files, be sure you have downloaded a
copy of your data and any other files you might need.

To remove forms
1

Login the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script). You will need to login with an account that has administrator
privileges to remove web
forms.

2

Click the Web Forms tab.

3

Select a form from the Form
drop-down list.

4

If desired, mark the Delete
Server Files checkbox.
When selected, all files,
including data, will be
removed from the web
server.
Caution: Enabling Delete Server Files will delete all web form
related files from the web server, including data files, log files and
temporary session files. You will not be able to recover these files.

5

Click the Remove Form button to remove the web form.

6

A confirmation page will appear. If you are certain you want to remove the
web form, click the Yes button to continue. The web form is permanently
removed.

249

Remark Web Survey User’s Guide

9.8 Emailing Web Form Invitations
Remark Web Survey includes an email client to allow you to send invitations
and reminders to your respondents. This feature is most useful when using
password protected web forms where you have entered email addresses in the
password list builder. However as long as you know your respondents‟ email
addresses, you can use the built-in email client. The email client utilizes your
SMTP server to send email. You must have an SMTP server configured outside
of Remark Web Survey to use the email client.
When you send email invitations, an email is automatically generated that
contains the link to your web form. You then add the recipients to the message.
If you are using a Login page where you have entered email addresses, the
addresses will be entered automatically. You may also append the password to
the web form link. You may modify the subject line and body of the email;
however do not modify the link to your web form. If you change this link,
respondents will be unable to access your web form. Merge fields can be added
to the email, such as a username and password. You can also create email
templates to be reused for commonly used web forms (*Professional Version
Only*).
The Send Invitations function is used to invite people to submit your web form
or to send reminders to those who have not submitted the web form. Reminders
are covered in the Respondent Detection section of this user‟s guide in Section
10.8.
Note: If you are using Query Parameters and want to send emails
from Remark Web Survey, use the Advanced option on the Send
Invitations button. Please see Section 5.7.5.b for detailed
information about using the Advanced options. Then return to this
section for generic information about the email window.

To send email invitations for non-password protected web forms
1

Before attempting to send emails, ensure that your SMTP server information
has been set up in Remark Web Survey, as outlined in Section 2.4.9. The
Local Server settings will apply to email invitations.

2

Create a web form in Remark Web Survey as you normally would, publish it
to your web server and test to make sure it works as expected. When you
are ready to send invitations to your respondents, continue to step 3.
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3

From the Tools tab of the Ribbon, select Send Invitations. The Email
Message window appears.

4

Use the To section to enter email addresses of your respondents. You have
two options for entering the email addresses:
Manually type in the email addresses. Separate the email addresses with
a semi-colon (;).
(*Professional Version Only*) Import a list of email addresses from a
database. Supported databases include Access, dBase, Excel, FoxPro,
Paradox and ODBC. Click Database connection settings to set up a
connection to an external database containing the desired email
addresses.
a. Choose the type of database you wish
to use from the Type drop-down list.
b. Click the Open folder to select the
database containing the desired
information.
c. [Optional] If you are using an ODBC
connection, choose the DSN from the
DSN drop-down list. Mark whether it
is Directory based or DSN based.
d. [Optional] If your database requires a
login, enter the Username.
e. [Optional] If your database requires a
login, enter the Password.
Note: The Connection String displays the connection string that is
working behind the scenes to connect to your selected database.
You do not need to edit this string; it is for informational purposes
only.
f.

[Optional] You may optionally click the Test Connection button to
test whether you can connect to this database.

g. Click the OK button to return to the Respondent List window.
h. Use the Table list to select the table from your database that
contains the email addresses you wish to import.
i.

Use the Email field list to select the field in the connected database
to that contains the desired email addresses.
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j.

Click the Import button.

k. Click the OK button in the
prompt that tells you the
emails were imported
successfully.
l.

Click OK to close the window.
You should see all of the email
addresses you imported in the
To line of the email.

5

The From address will be filled with the web form administrator address
that was entered in the web form‟s properties. Accept the default or enter a
new email address.

6

Accept or modify the Subject line of the email.

7

At this point you can either manually alter the body of the email or apply an
email template. If you wish to apply an email template, click the Email
Templates button and choose the
desired template. Email templates are
covered in detail in section 9.8.1.
(*Professional Version Only*)

8

[Optional] Use the options on the
toolbar to customize your message, if
desired. You may add an attachment
, send the email with High

9

Importance

or format

the email in HTML

.

[Optional] If desired, click the Local Machine button to choose which email
server to use to send the emails. The Local Machine settings can be added
at both a program level and a web form level. If the two server settings
differ, you can use this button to choose which server you wish to use. If the
two do not differ, the server information entered will be used by default.

10 [Optional] Add merge fields to the email by clicking the Merge Field button.

Merge fields allow you to personalize the email by adding in keywords that
will be merged when the email is sent. For non-password protected forms,
the only option is the Web Form URL. If you accidentally remove the URL,
you can use this option to add it back into the email. You can also use this
option to position the URL in a different place within the email. Select an
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insertion point in the body of the email, click Merge Field and then choose
the Web Form URL.
11 When you have the email formatted as desired, click the Send

button
to send the emails. They will be sent in a batch mode so as not to overload
your email server. Respondents will receive the email in the format that is
set up in their email client. They can either click or copy the link to your web
form that is included in the body of your email message.

To send email invitations for password protected web forms
1

Before attempting to send emails, ensure that your SMTP server information
has been set up in Remark Web Survey, as outlined in Section 2.4.9. The
Local Server settings will apply to email invitations.

2

Create a web form in Remark Web Survey as you normally would, including
a Login page, publish it to your web server and test to make sure it works
as expected. When you are ready to send invitations to your respondents,
continue to step 3.

You have two options for getting passwords into your respondents‟ hands:
Embed them into the web form URL. Embedding the username and
password into the web form URL means respondents will be
automatically logged in when they click the URL. The username and
password information is encrypted in the URL.
Add Merge Fields to the body of the email that tells respondents their
password (and username, if using one).
You can do one or both of the above
options. Even if you embed the URL you
may wish to make respondents aware of
their password in case they need it
later.
3

[Optional] If you wish to embed the
password into the URL, from the
Tools tab of the Ribbon click the
down arrow on the Send
Invitations button and choose
Include Username/Password.
You will not notice the username and
password embedded in the invitation
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URL. However, when the emails are sent, this information will be included in
an encrypted format.
4

If you do not wish to include the username/password into the URL, from the
Tools tab of the Ribbon click the Send Invitations button.

The Email Message window appears.
5

Use the To section to enter email addresses of your respondents. When
using a password protected web form if you have entered email addresses in
the password list builder screen, the To section of the email will
automatically be filled with your respondents from the Password list
builder window.

6

[Optional] If desired, you may input more email addresses by either typing
them in manually (separated by a semi-colon (;)) or by importing the
passwords from an external database (*Professional Version Only*). Please
see the previous set of instructions for importing passwords (“To send
email invitations for non-password protected web forms”).

7

The From address will be filled with the web form administrator address
that was entered in the web form‟s properties. Accept the default or enter a
new email address.

8

Accept or modify the Subject line of the email.

9

At this point you can either manually alter the body of the email or apply an
email template. If you wish to apply an email template, click the Email
Templates button and choose the desired template. Email templates are
covered in detail in Section 9.8.1. (*Professional Version Only*).

10 [Optional] Use the options on the toolbar to customize your message, if

desired. You may add an attachment
Importance

, send the email with High

or format the email in HTML

.

11 [Optional] Click the Local Machine button to choose which email server to

use to send the emails. The Local Machine settings can be added at both a
program level and a web form level. If the two server settings differ, you
can use this button to choose which server you wish to use. If the two do
not differ, the server information entered will be used by default.
12 [Optional] Add merge fields to the email by clicking the Merge Field button.

Merge fields allow you to personalize the email by adding in keywords that
will be merged when the email is sent. For password-protected forms, you
can add Web Form URL, Username, Password and/or Name merge
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fields. Select an insertion point in
the body of the email, click Merge
Field and then choose the desired
merge field. To use username
merge fields, you must have
marked the checkbox to include a
username on the Login page
properties screen. To include a
name, you must have defined
names in the Password builder
list. Note that passwords are not
encrypted when inserted as merge
fields so that the respondent can
see their password.
13 When you have the email formatted as desired, click the Send

button
to send the emails. They will be sent according to the throttle rate defined in
the web form properties. Respondents will receive the email in the format
that is set up in their email client. They can either click or copy the link to
your web form that is included in the body of your email message. If you
chose to embed the password into the URL, passwords will be embedded as
emails are generated and sent (behind the scenes).
Tip: Respondents with a text only email client may not see actual
hyperlinks in their email messages. When sending a hyperlink
through email, it is recommended that you include instructions that
explain to respondents that they can copy the link and paste it into
a web browser if the hyperlink does not automatically take them to
the web form.
Tip: You can use the email client to send thank you notices to
respondents as well. If you wish to send thank you notices from
Remark Web Survey, you will need to alter the subject and body of
the email message. When the email client is launched using the
Send Invitations button, the email is formatted as an invitation to
take your web form. The email text can be easily modified to thank
respondents for submitting your web form.
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9.8.1 Email Templates
(*Professional Version Only*)
You can create and save email templates to save time when you tend to send
the same information or reuse web forms. Once you have an email formatted
the way you want it, you can save it as a template file. Or you can do all of the
formatting within the Email Templates window. Email templates only save the
information contained in the body of the email.

To create an email template
1

From the Tools tab of the Ribbon, select Send Invitations. The Email
Message window appears. (We suggest you put together a real email for a
web form as you want it to appear, and then save a template for it.)

2

Format the body of the email as desired. See section 9.8 for a detailed
listing of all of the available properties.

3

Click the Email Templates
button.

4

Click the Save button.

5

Enter a name for the email
template in the box titled Email
template name. If you wish to
overwrite an existing email
template, start typing the name of
the exiting template and Remark
Web Survey will attempt to autopopulate this textbox for you.

6

[Optional] Make any adjustments to the body of the email (if you did not do
so in Step 2). You may also add merge fields at this step by clicking the
Merge Fields button.

7

Click the Save button to save the email template.

256

Administering Web Forms

To apply an email template to an email invitation
1

Open a web form and prepare it for
emailing.

2

When you are ready to send email
invitations, from the Tools tab of
the Ribbon, select Send
Invitations. The Email Message
window appears.

3

Click the Email Templates
button.

4

Choose a template from the list.

5

Format the rest of the email as
described in section 9.8, including
setting up the To list.

6

Click the Send button to send the invitations.
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Collecting Data
Chapter 10

10.1 Overview
Once a web form is created, published and installed, you are ready to start
collecting data. The data collection script (rws5.pl) you specified when
creating the web form (see Section 4.2) will handle collecting the submissions
for you. Data can be downloaded via Remark Web Survey or via a web browser.
By using Remark Web Survey, you can analyze the data in Remark Quick Stats
or export it to another analysis package.
Remark Web Survey provides a Data Viewer window for the collection of data.
The Data Viewer window contains a spreadsheet style grid containing the
downloaded data. You can open previously downloaded data files or download a
new data file in the Data Viewer window.
Data is stored on the web server in a proprietary format called a .rwd (Remark
Web Data) file. Once data is downloaded, it is moved to a .rwa (Remark Web
Archive) file so that later you can have options of downloading all data (rwa) or
only new records (.rwd). You may also download incomplete form submissions
(respondents who started to fill out the web form but never completed it)
(*Professional Version Only)*.

10.2 Downloading Data in Remark Web Survey
When downloading data from within Remark Web Survey, you may take
advantage of the software‟s data export and/or analysis features. Downloading
data from within the software involves logging into your web server,
downloading the data and loading it into the Data Viewer window.
Note: You must have a Remark Web Survey Control Panel login
that allows for automatic data downloads. See Section 2.4.8 for
more information about user accounts.
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Before you will be able to download data into Remark Web Survey, you must
have the Enable auto downloads feature set in the Remark Web Survey
Control Panel. (By default, this feature is turned on.)

To enable auto downloads
1

Login to the Remark Web Survey
Control Panel in a web browser
(rwsad5.pl script) using an account
with administrator privileges.

2

Mark the checkbox for Enable
automatic downloads.

3

Click the Update button.

In order to download data directly into Remark Web Survey you must enter the
correct administration URL in the form‟s properties and have a Remark Web
Survey Control Panel login with automatic data downloading enabled (see
Section 2.4.8 for information about user accounts). The data download function
utilizes Internet Explorer to authenticate your login on the web server.
Therefore, you must have Internet Explorer 6.0 or later installed and configured
correctly if you wish to download data from within Remark Web Survey. It does
not need to be your default web browser, but you do need to be able to connect
to the Internet via Internet Explorer. Your network administrator should be able
to assist you with this process.

To download data in Remark Web Survey
1

Open the web form in
Remark Web Survey.

2

Open the Data Viewer by
either clicking the Data
Viewer button in the
status bar or by selecting
the Home tab from the
Ribbon and then clicking
Data Viewer.

You will see a spreadsheet
style grid with columns
containing the field names
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from each of the questions on your form. Each page of your web form is
separated by a dashed line.
There are two ways to download data:
Expand the Admin Control Panel Access bar at the bottom of the
window (if it is not expanded already) by selecting the View tab and
marking the Admin Control Panel Access checkbox. In the Admin
Control Panel Access bar, login with your Username and Password
and then click the Download Data button. All of the data on the web
server for this web form will be downloaded. In addition, if you click the
drop-down arrow on the Download Data button, you may choose New
Data Only. The New Data Only option will only download new
submissions since the last time data was downloaded for this web form.
Note that you will not be able to access the Download Data button in the
Admin Control Panel Access bar until you have successfully logged in to
the administration script.

Select the Application Button
and then click Download. All of the
data on the web server for this web form will be downloaded. If you are
not currently logged into the Remark Web Survey Control Panel, the
Admin Control Panel Access bar will automatically expand at the
bottom of the window. Enter your Username and Password, and then
click the Login button. After logging in, go back to the Application
Button and then click Download.
3

Once the data downloads, a confirmation window will appear. Click the OK
button.
Note: If using Database Link fields, these fields are processed when
Remark Web Survey opens or downloads a data file directly from
the web server.

Remark Web Survey will log in to your
web server and retrieve the data. Each
line in the data grid is filled with one
respondent‟s submission. Each time
you download data, you receive the
entire file if downloading all records.
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At this point, you may save the data to another format or analyze the data in
Remark Quick Stats. See Section 10.12 for further information about data
export, and the Remark Quick Stats User‟s Guide PDF file, located by clicking
Start|Programs|Remark Web Survey 5|Documentation, for further information
about using Remark Quick Stats.

10.2.1 Appending Data or Downloading New Submissions
Only
If you have already collected data for a web form and saved it to file, you may
optionally open that data and then download new data submissions. Whenever
you have data open in the Data Viewer grid, the download process will prompt
you to add downloaded data to the
existing data set. Follow the
instructions in the previous section
to download data. After the data is
downloaded, you will receive a
message asking if you wish to
append the data to the current data
set. Click the Yes button to add the
new data to the existing records in the active data grid. Click the No button to
download the data to a new Data Viewer grid.
Alternatively, you can click the down arrow on the Download Data button and
choose New Data Only. This option will only download records that have not
been downloaded since the last time you downloaded. You can then save that
data to its own file or append it to an existing file (Click the Save As toolbar
button on the Data Viewer, then choose Save As and select the existing file.)
Note: If you append records to an existing data set when you
download data, you still need to save that data set locally in order
to finish combining the data (e.g., save it as a Remark (RMK) file).
You can save the combined data from the toolbar in the Data
Viewer.

10.2.2 Downloading Incomplete Data Submissions
(*Professional Version Only*)
Remark Web Survey allows you to download partial data submissions, which
occur when someone starts to fill in a web form but never completes it. They
may have filled in a page or two and then never completed it, or they may have
paused the web form and never came back to finish it. By default, incomplete
submissions are not downloaded with the data.
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If you plan to include incomplete data submissions use caution with the Remove
respondent‟s incomplete data from the server setting. This setting removes
incomplete submissions after a specified amount of time (days or minutes). The
scripts will check for incomplete submissions to remove whenever interaction
with the data (rws5.pl) script occurs. If you remove incomplete data
submissions, you will not be able to download incomplete data later. Please see
Section 4.2.2 for a complete description of removing incomplete data
submissions.
In order to download data directly into Remark Web Survey you must enter the
correct administration URL in the form‟s properties and have a Remark Web
Survey Control Panel login with automatic data downloading enabled (see
Section 2.4.8 for information about user accounts).

To download incomplete data submissions
1

Open the web form in Remark Web Survey.

2

Open the Data Viewer by
either clicking the Data
Viewer button in the status
bar or by selecting the
Home tab from the Ribbon
and then clicking Data
Viewer.

3

Expand the Admin Control
Panel Access bar at the
bottom of the window (if it
is not expanded already) by
selecting the View tab and
marking the Admin Control
Panel Access checkbox.

4

In the Admin Control Panel Access bar, login with your Username and
Password and then click the down arrow on the Download Data button
and choose Incomplete Data. Any incomplete data submissions will be
downloaded to the data grid.

5

Click the OK button to complete the process.

You may now save this data to its own file or an existing data file. See Section
10.12 for information about saving data.
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10.2.2.a Completion Percentage
(*Professional Version Only*)
When viewing incomplete data submissions, you can utilize the Completion
Percentage feature to determine how much data must be present in order to
analyze the records. The Completion Percentage is a slider that you can move
from 0 to 100%. Remark Web Survey will then analyze each record and
determine the percentage of data present. If it doesn‟t meet the specified
percentage, it will highlight the record in yellow. You can then determine what
you want to do with this data (e.g., delete it, include it in analysis, etc.). In
addition you can specify whether to look at all questions on the web form or
only those that are tabulated/graded in the question properties when analyzing
the Completion Percentage.

To use the Completion Percentage feature
1

Open the web form in Remark Web Survey.

2

Open the Data Viewer by either clicking the Data Viewer button in the
status bar or by selecting the Home tab from the Ribbon and then clicking
Data Viewer.

3

Expand the Admin Control Panel Access bar at the bottom of the window
(if it is not expanded already) by selecting the View tab and marking the
Admin Control Panel Access checkbox. In the Admin Control Panel
Access bar, login with your Username and Password and then click the
down arrow on the Download Data button and choose Incomplete Data.
Any incomplete data submissions will be downloaded to the data grid.
Alternatively, if you have already completed this step and have the data
saved on your computer, open that data file.

4

Locate the Completion
Percentage in the toolbar of the
Data Viewer.

5

First, determine whether you want
to include all questions or only
those that are set to grade/tabulate
(this option is set on an individual
question basis in the Analysis
portion of the properties window).
By default, only graded/ tabulated
questions are included. To view or
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change this setting, locate the Refresh button. Click the down arrow on the
Refresh button and then check or uncheck Filter Graded/Tabulated
Questions Only.
6

Use the slider on the Completion Percentage scale to move to the desired
percentage of complete data.

7

Click the Refresh button. The
data is filtered based on whether
it meets your completion
percentage. Any data records not
meeting the percentage are
highlighted in yellow.

8

Determine whether you want to
grade/tabulate the filtered
records. Click the down arrow on
the Refresh button and then click
Filtered Rows. You will have three options from which to choose:
Always Exclude From
Export/Analysis:
The data will not be included if
you save to a file or run any
analysis options.
Always Include in
Export/Analysis:
The data will be included if you
save to a file or run any analysis
options.
Always Ask:
You will be prompted whether to include the filtered data when you save
data or run analysis options.

9

You may now either save the data to a file or run an analysis option. Please
see Section 10.12 for information about saving data and Chapter 11 for
information about analyzing data.
Note: If desired, you can delete the data rows that don‟t meet your
completion percentage. This deletes the data locally, not on the web
server. To delete the records, highlight the entire record(s), click
the Home tab on the Ribbon and then click Delete Grid Row.
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Incomplete data submissions can also be downloaded from the Remark Web
Survey Control Panel (rwsad5.pl script). Please see Section 10.3.1 for
information about downloading data through the Control Panel.

10.3 Downloading Data Through a Web Browser
An alternative to downloading the data directly in Remark Web Survey is to use
your web browser to access the Remark Web Survey Control Panel and view or
download the data file to a location on your computer. The web browser
interface also gives you the option of deleting data. The Control Panel is
accessed through the rwsad5.pl script.
Accessing the Control Panel from a web browser can be accomplished in one of
two ways:
In Remark Web Survey, select the Web tab from the Ribbon and then
click Control Panel. If a web form is open, the administration script
specified in the web form‟s properties will appear in your default web
browser. If a web form is not open, the administration script specified in
the program options will appear in your default web browser.
Open a web browser and enter the URL for your administration script in
the Address bar (e.g., http://www.example.com/cgi-bin/rwsad5.pl).
Please note that there are three types of user accounts and each one has
different levels of access to the Control Panel. Administrator accounts can
download and view data from the Control Panel, but Standard and Restricted
User accounts need explicit permissions set up in order to download data from
the Control Panel. See Section 2.4.8 for detailed information about user
accounts.

To download the data through a web browser
1

Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script) with an account that has permission to download data.

2

Enter your username and password and then click the Login button.
Note: The default user is Administrator. The person who installed
the scripts onto the web server may or may not have set up
individual user accounts. You will need to ask this person for your
login information.

3

Click the Data & Stats tab.
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4

Select a web form from the Form
drop-down list.

5

Click the button for Download
Data.

6

In the File Download window,
click the button to Save the file.
This prompt may vary slightly
from web browser to web
browser.

7

In the Save window, select a
location for the file and then click the
Save button. Do not change the file
extension on the file (.rwd). Make
note of where you are saving the file
so that you can retrieve it later.

The data file is now downloaded. You can
open the downloaded file within Remark
Web Survey.
8

In the Remark Web Survey designer,
open the desired web form.

9

Open the Data Viewer window by clicking its button in the status bar
or by selecting the Home tab from the Ribbon and then clicking Data
Viewer.

10 Locate the toolbar on the Data Viewer.
11 Click the Open button. (You may also click the Application Button

and

choose Open to open a data file as long as the Data Viewer is active.)
12 Locate the .rwd file you downloaded from the Remark Web Survey Control

Panel and then click the Open button. The data will be loaded into the data
grid.
Note: If using Database Link fields, these fields are processed when
Remark Web Survey opens or downloads a .rwd data file.
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10.3.1 Downloading Incomplete Submissions via the
Control Panel
(*Professional Version Only*)
Remark Web Survey allows you to download partial data submissions, which
occur when someone starts to fill in a web form but never completes it. They
may have filled in a page or two and then never completed it, or they may have
paused the web form and never came back to finish it. By default, incomplete
submissions are not downloaded with the data.
If you plan to include incomplete data submissions, use caution with the
Remove respondent‟s incomplete data from the server setting. This setting
removes incomplete submissions after a specified amount of time (days or
minutes). The scripts will check for incomplete submissions to remove whenever
interaction with the data (rws5.pl) script occurs. If you remove incomplete data
submissions, you will not be able to download incomplete data later. Please see
Section 4.2.2 for a complete description of removing incomplete data
submissions.
Please note that there are three types of user accounts and each one has
different levels of access to the Control Panel. Administrator accounts can
download and view data from the Control Panel, but Standard and Restricted
User accounts need explicit permissions set up in order to download data from
the Control Panel. See Section 2.4.8 for detailed information about user
accounts.

To download incomplete data submissions via the Control Panel
1

Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script) with an account that has permission to download data.

2

Enter your username and password and then click the Login button.
Note: The default user is Administrator. The person who installed
the scripts onto the web server may or may not have set up
individual user accounts. You will need to ask this person for your
login information.

3

Click the Data & Stats tab.

4

Select a web form from the Form drop-down list.

268

Collecting Data

5

Click the button for Incomplete
Data.

6

In the File Download window,
click the button to Save the file.
This prompt may vary slightly
from web browser to web
browser.

7

In the Save window, select a
location for the file and then click
the Save button. Do not change the
file extension on the file (.rwd). Make
note of where you are saving the file
so that you can retrieve it later.

The data file is now downloaded. You
can open the downloaded file within
Remark Web Survey.
8

In the Remark Web Survey designer,
open the desired web form.

9

Open the Data Viewer window by clicking its button in the status bar
or by selecting the Home tab from the Ribbon and then clicking Data
Viewer.

10 Locate the toolbar on the Data Viewer:

.
11 Click the Open button. (You may also click the Application Button

and

choose Open to open a data file as long as the Data Viewer is active.)
12 Locate the .rwd file you downloaded from the Remark Web Survey Control

Panel and then click the Open button. The data will be loaded into the data
grid.
When viewing incomplete data submissions, you can customize the desired
completion percentage required to consider the data valid. Please see Section
10.2.2.a for information about using the Completion Percentage feature.
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10.4 Viewing Data Online
At any point while a web form is installed and submissions have been
submitted, you may also view the data online without downloading it. Viewing
the data is accomplished in the Remark Web Survey Control Panel.
Please note that there are three types of user accounts and each one has
different levels of access to the Control Panel. All accounts can view data from
the Control Panel, but Restricted User accounts only have access to specific web
form data. See Section 2.4.8 for detailed information about user accounts.

To view data from a web browser
1

Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script).

2

Enter your username and password and then click the Login button.
Note: The default user is Administrator. The person who installed
the scripts onto the web server may or may not have set up
individual user accounts. You will need to ask this person for your
login information.

3

Click Data & Stats tab.

4

Select a web form from the Form
drop-down list.

5

Click the button for View Data.
The data will appear on-screen.
The field names are listed across
the top and bottom of the
window, and each line in between
represents one respondent‟s
submitted data.
Note: If a question is set to Treat each answer choice as a
separate question, the data will appear as one question in this
view. When downloaded, the data will be output to separate data
cells.

6

[Optional] Click the View More Details button to view the data in greater
detail, including viewing the submitter‟s IP address (if applicable), data
submitted and time submitted.
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7

When finished reviewing the data, click the Control Panel button to return
to the previous screen.

10.4.1 Resetting Data
You may reset a web form‟s data at any time using the Remark Web Survey
Control Panel. Resetting data may be useful if you publish a web form and then
test it internally. Once you have completed your tests, you can reset the data
file prior to sending out live invitations to your web form.
Please note that there are three types of user accounts and each one has
different levels of access to the Control Panel. Only administrator accounts are
able to reset data through the Control Panel. See Section 2.4.8 for detailed
information about user accounts.
Note: Data can also be reset when publishing forms to the web
server. If a web form already exists on the web server, a prompt
will appear asking if you wish to remove data, log and temporary
session files. If you remove the data via this prompt, a backup copy
is created. See Section 9.5.1 for further details.

To reset data from a web browser
1

Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script) using an account with administrator privileges.

2

Enter your username and password and then click the Login button.
Note: The default user is Administrator. The person who installed
the scripts onto the web server may or may not have set up
individual user accounts. You will need to ask this person for your
login information.

3

Click Data & Stats tab.

4

Select a web form from the Form
drop-down list.

5

Click the button for Reset Data.
You will see a prompt asking if
you are sure you want to reset
the data. Click OK to continue or
Cancel to return to the Control
Panel.
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Note: Resetting data via the Control Panel cannot be undone! Once
you reset the data, the data file will be removed from the web
server.

10.5 Log Files
In addition to data files, you can also view or download the associated log files
for each web form. The log file tracks information about each form submission,
including:
Option

Description

Entry Number

Displays a sequential number assigned to each log
file record.

UID

Displays a unique identifier that is assigned to each
respondent and is used to track the entry. Each
respondent has a session that is tracked by this UID.
The UID helps track whether a particular respondent
has completed the web form, how much time he/she
has to go back and complete the web form, etc.

Action

Describes the action that took place (e.g., the web
form was completed, a password was entered, etc.).

Access

Describes whether access to the web form was
permitted.

Encrypted Password

Displays the password used to access the web form,
if applicable, in an encrypted format.

IP Address

Records the IP address of the person submitting the
web form (if this option is enabled in the web form‟s
properties).

Date

Records the date of the web form submission.

Time

Records the time of the web form submission.

Please note that there are three types of user accounts and each one has
different levels of access to the Control Panel. Only administrator accounts are
able to view or download log files through the Control Panel. See Section 2.4.8
for detailed information about user accounts.
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To view or download log files from a web browser
1

Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script) using an account with administrator privileges.

2

Enter your username and password and then click the Login button.
Note: The default user is Administrator. The person who installed
the scripts onto the web server may or may not have set up
individual user accounts. You will need to ask this person for your
login information.

3

Click Web Forms tab.

4

Select a web form from the
Form drop-down list.

5

Click the button for View Log to
view the log file on-screen. Or
click the Download Log button
to save the log file to disk as a
text file. This file can be opened
in a text editor, such as Notepad.
Finally, you can remove the log
file by clicking Reset Log. This
will delete the log file and a new
one will be created when/if
interaction with the web form occurs.

10.6 Understanding the Data Viewer Grid
The Remark Web Survey Data Viewer grid employs a spreadsheet style
interface to display data. Each grid column corresponds to a question on the
web form and every grid row corresponds to one submitted web form. The grid
employs two cell types to store data: text and list. The cell type depends on the
kind of question being used. Textbox/Text Area style questions use text (data
entry) cells. Checkbox, Option Button and Drop-Down Box style questions use
list cells. A cell changes between a textbox and list box depending on its
question type. The Data Viewer grid is divided into sections based on the pages
in the active web form. Each page is separated by a dashed line.
The Data Viewer has its own toolbar for frequently used functions (continue
reading this chapter for more detailed descriptions of the features):
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Toolbar
Button

Option

Description

Save

Saves the data. If saving for the first time, a save
window will appear. For subsequent saves, the
existing file will be overwritten automatically.

Save As

Saves the data by opening a save window. This
window allows you to name the file, choose a location
for the file and specify a file type.

Save All
Data

Saves all open data grids to a single file. All grids will
be closed upon saving and the combined file will
remain open. Make sure you have saved any
individual files (if needed) prior to use Save All Data.

Open

Opens a data set.

Print

Prints the active data set.

Sort
Ascending

Sorts the active data set in ascending order based on
the column you have selected.

Sort
Descending

Sorts the active data set in descending order based
on the column you have selected.

Close All
Data

Closes all open data grids.

Completion
Percentage

Allows you to specify the percent complete desired
when downloading incomplete data submissions. You
can then choose filtering options based on the data
records that are flagged as incomplete. See Section
10.2.2.a for complete details about using the
Completion Percentage feature. (*Professional
Version Only*)
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To access the Data Viewer Grid
1

Open a web form in Remark Web Survey.

2

Open the Data Viewer by either clicking the Data Viewer button in the
status bar,

or by selecting the Home tab from the Ribbon and then

clicking Data Viewer,

.

Note: You cannot make changes to a web form when the Data
Viewer is open and has data in it.

10.7 Editing the Data Viewer Grid
The Data Viewer grid behaves like a spreadsheet. You can cut, copy and paste
selections to and from the grid. Additionally, you can change the contents of
individual grid cells by clicking in a cell. This section explains the basics of
manipulating data within the grid and includes the following:
Making grid selections
Changing cell contents
Cutting, copying, pasting and deleting
Resizing, inserting and deleting rows
Using find and replace
Sorting fields

10.7.1 Making Grid Selections
The following table lists the different methods for making selections in the grid:
Selection Area

Method

Single Cell

Click in it. Use the mouse or the arrow, home and end
keys to move from cell to cell.

Multiple Cells

Click the upper, left-hand corner of the desired
selection, drag the mouse to the lower, right-hand
corner and release.
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Selection Area

Method

Single Column

Click the column header.

Multiple Columns

Click and drag a range of column headers or click a
beginning column header, press and hold the shift key,
and then click an ending column header. You may also
click the page header to select all questions on that
page.

Single Row

Click the row header.

Multiple Rows

Click and drag a range of row headers or click a
beginning row header, press and hold the Shift key, and
then click an ending row header.

Entire Grid

Click the upper, left-most grid header cell.

10.7.2 Changing Cell Contents
The Data Viewer grid allows in-cell editing by clicking within a particular cell.
The grid employs two cell types to store data: text and list. The cell type
depends on the kind of field being used. Each cell changes between a textbox
and list box depending on its question type. Textbox/Text Area style questions
are considered text cells. You will not have a drop-down list for these field
types. All other types of questions are considered list fields and will have a
drop-down list from which you can choose correct responses based on the labels
entered in the question‟s properties.

To change the contents of a text cell
1

Select the cell by clicking within its borders.

2

Type the desired cell contents into the cell and press Enter or click in
another cell.

To change the contents of a list cell
1

Select the cell by clicking within its borders.

2

Click the down arrow on the cell‟s list box.

3

Click the correct response.
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4

If more than one response is permitted, repeat steps 2 and 3 to select more
than one response.

10.7.3 Cutting, Copying, Pasting and Deleting
The Remark Web Survey Data Viewer grid supports the normal Windows
clipboard functions of cut, copy, paste and delete.

To cut data from the grid
1

Select an area to cut.

2

Select the Home tab from the Ribbon and then click Cut
Ctrl + X.

or press

The selected data are cut from the grid and placed on the Windows clipboard.

To copy grid data
1

Select an area to copy.

2

Select the Home tab from the Ribbon and then click Copy
Ctrl + C.

or press

The selected data are copied to the Windows clipboard.

To paste data from the clipboard to the grid
1

Select the area to which you want to paste.

2

Select the Home tab from the Ribbon and then click Paste
Ctrl + V.

or press

The data on the Windows clipboard are pasted into the selected grid cell(s).
Note: If you cut or copied more than one cell of data, when you
paste the data, it will fill the same number of cells that you cut or
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copied (e.g., if you copied two rows of data (not using the row
header), you may select one cell as an insertion point, but two rows
of data will be pasted).

To delete grid data
1

Select the area that you want to delete.

2

Select the Home tab from the Ribbon and then click Delete
the Delete key.

or press

10.7.4 Resizing, Inserting and Deleting Rows
You can change the number of rows contained in a respondent grid by adding
rows to the end of the grid, inserting rows into the grid or deleting rows from
the grid.
Caution: Large grid sizes may slow system performance.

To insert row(s) into the grid
1

Select the desired insertion point by clicking a grid cell.

2

Select the Home tab from the Ribbon and then click Insert Grid Row
to insert a row. The grid row will be inserted above the
selected grid row.
Note: You may also select multiple rows to insert the same number
of rows above the selection (e.g., select two complete rows to insert
two rows above the highlighted rows).

To delete rows from the grid
1

Select the rows to delete.

2

Select the Home tab from the Ribbon and then click Delete Grid Row
. Note that once the grid rows are removed, you cannot get
them back.
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Note: You may delete multiple rows by selecting more than one
grid row. Use the row headers to select the rows.

10.7.5 Using Find and Replace
Remark Web Survey provides find and replace commands for locating and
replacing text. You can search for each occurrence of characters, including
uppercase and lowercase letters, whole words and parts of words.
By default Remark Web Survey will search the entire Data Viewer grid when
performing a find and replace operation. However, you can search a specific
region by highlighting the area you would like to search prior to using Find or
Replace.

To find text
1

Select the Home tab from the Ribbon and then click Find

.

2

If searching for text, enter the search text in the box titled Find what.

3

Select the other options you want to use to control the search.

Search Option

Result

Find whole word only

Mark the Find whole word only checkbox to
search only for the entire word.

Match case

Mark the Match case checkbox to have the search
be case sensitive.

Use wildcards

Mark the Use wildcards checkbox to use wildcards
within the search to make it broader in scope. For
example, if you type *good, any word containing
“good” will be flagged.

Search within current
selection

When a portion of the data grid is highlighted, mark
the Search within current selection checkbox to
search only within that selection.

4

Click the Find Next button.
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If Remark Web Survey locates a match,
the grid scrolls to display the cell where
the match is found.
5

Make any necessary changes to the
grid.

6

Click Find Next to continue searching.

7

When the search is complete, Remark
Web Survey will report that there are
no more matches to find; click the OK button. You may also click Cancel at
any time to close the Find window.

To find and replace text
1

Select the Home tab in the Ribbon
and then click Replace

.

2

If searching for text, enter the search
text in the box titled Find what.

3

To replace items located in the
search, enter the replacement text in
the box titled Replace with.

4

Select the other options you want to use to control the search.

Search Option

Result

Find whole word only

Mark the Find whole word only checkbox to
search only for the entire word.

Match case

Mark the Match case checkbox to have the search
be case sensitive.

Use wildcards

Mark the Use wildcards checkbox to use wildcards
within the search to make it broader in scope. For
example, if you type *good, any word containing
“good” will be flagged.
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5

Choose one of the following search commands by clicking the appropriate
button:

Search Command

Result

Replace

Locate and replace the next item meeting search
criteria.

Replace All

Locate and replace all items meeting search criteria.

Find Next

Locate the next item meeting search criteria.

If Remark Web Survey locates a match, the text in the grid will automatically be
replaced when using the Replace or Replace All options.
6

When the search is complete, Remark Web Survey will report that there are
no more matches to find; click the OK button. You may also click Cancel at
any time to close the Replace window.

10.8 Respondent Detection
Remark Web Survey has a respondent detection feature that works in
conjunction with password protection. When you enter a list of valid passwords
for a password protected web form, you can optionally designate a name field,
username field and an email field. When you download the data for the web
form, Remark Web Survey can search through the passwords that were
submitted to see who has and has not filled out your web form. The full list of
respondents can also be exported to a file. You can use this file to send email
notifications to those who have not yet filled out the web form reminding them
to do so (if you are not using Remark Web Survey‟s built-in email client).

To use respondent detection
1

Create a web form with a Login page (see Section 4.9 for detailed
information about setting up Login pages). When setting up the login page,
enter information into the Name, Username and/or Email Address columns
for optimum use of this feature.

2

Publish the web form and collect responses.

3

Download or open the data file containing the responses.
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4

Select the Tools tab in the Ribbon and then click Respondent Detection,
.
Note: If multiple data grids are open that correspond to the same
web form, you will receive a prompt to choose the data grids to
include in the Respondent Detection process.

5

The Respondent Detection window
appears. Use the View drop-down list
at the bottom of the window to select
which respondents to view: All,
Detected or Missing.

6

The Detected column contains a
green checkmark if a respondent has
submitted the web form. The
respondent‟s name, username,
password and email address (if these
fields are being used in the Password
list builder) are also listed.

7

The Detected column is blank if a respondent has not submitted the web
form. The respondent‟s name, username, password and email address (if
these fields are being used in the Password list builder) are listed using a
lighter (disabled) text color. You may optionally use Remark Web Survey‟s
email function to send emails to respondents (see step 8) or export a file of
respondents (see step 9).

8

[OPTIONAL] Click the Email
button to launch Remark Web
Survey‟s built-in email client and
send an email message to the
respondents listed in the grid.
You should decide who you want
to send the email to before
launching the email client.
Choose Detected, Missing or
All in the Respondent Detection
window. See Section 10.8.1
below for detailed information
about using the email client.

9

[OPTIONAL] Alternatively, click the Export button to export the respondent
list to the desired format. Continue with steps 10-13.
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10 [OPTIONAL] Select a location in

which to save the file in the Look in
box.
11 [OPTIONAL] Enter a file name for

the report in the File name box.
12 [OPTIONAL] Select a file format

from the Save as type box format
(available formats include those
supported by Remark Web Survey
when saving data. See Section
10.12 for a complete list of
formats).
13 [OPTIONAL] Click the OK button to

save the file.

10.8.1 Sending Reminder Emails
The built-in email client can be used in conjunction with Respondent Detection
to send reminder emails to those who have not submitted your web form. When
you send reminders, an email is automatically generated that contains the link
to your web form. You then add the recipients to the message. You may modify
the subject line and body of the email; however do not modify the link to your
web form. If you change this link, respondents will be unable to access your
web form.
Note: You must have a functioning SMTP server set up outside of
Remark Web Survey to send reminder emails. The server
information must be set up either in the Remark Web Survey
program options or the web form‟s properties in order to utilize the
server. See Section 2.3.9 for further information.
The following set of instructions assumes that you have read Section 10.8 and
understand the purpose of the Respondent Detection feature.

To send email reminders
1

Select the Tools tab in the Ribbon and then click Respondent Detection,
.

2

The Respondent Detection window appears. Use the View drop-down list
at the bottom of the window to select the Missing list of respondents.
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3

There are two email options available:
Click the Email button to launch the
Email Message window or click the
down arrow on the Email button and
choose Include
Username/Passwords to embed the
respondents‟ username and password
into the web form link that is sent in
the reminder email. Embedding the
username and password into the web
form URL means respondents will be automatically logged in when they click
the URL (the password is encrypted in the URL).
Note: If you are using Query Parameters and want to send email
reminders from Remark Web Survey, use the Advanced option on
the Send Invitations button. Please see Section 5.7.5.b for
detailed information about using the Advanced options. Then return
to this section for generic information about the email window.

The Email Message window appears.
4

If you are using a password protected web form and have entered email
addresses in the password list builder screen, the To section of the email
will automatically be filled with your missing respondents from the
Password list builder window.
However, you may also click the
To button to see a list of
respondents who have either
submitted the web form
(Detected Respondents) or not
submitted your web form yet
(Missing Respondents). You
may use these lists to alter your
To list. Use the Missing
Respondents list to send
reminder emails to those who
have not submitted the web form.

5

[Optional] If desired, you may
input more email addresses by either typing them in manually (separated by
a semi-colon (;)) or by importing the passwords from an external database.
(Please see Section 9.8 for instructions for importing passwords.
(*Professional Version Only*)
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6

The From address will be filled with the web form administrator address
that was entered in the web form‟s properties. Accept the default or enter a
new email address.

7

Accept or modify the Subject line of the email.

8

At this point you can either manually alter the body of the email or apply an
email template. If you wish to apply an email template, click the Email
Templates button and choose the desired template. Email templates are
covered in detail in Section 9.8.1 (*Professional Version Only*).

9

[Optional] Use the options on the toolbar to customize your message, if
desired. You may add an attachment
Importance

, send the email with High

or format the email in HTML

.

10 [Optional] If desired, click the Local Machine button to choose which email

server to use to send the emails. The Local Machine settings can be added
at both a program level and a web form level. If the two server settings
differ, you can use this button to choose which server you wish to use. If the
two do not differ, the server information entered will be used by default.
11 [Optional] Add merge fields to the email by clicking the Merge Fields

button. Merge fields allow you to personalize the email by adding in
keywords that will be merged when the email is sent. For passwordprotected forms, you can add Username, Password and/or Name merge
fields. Select an insertion point in the body of the email, click Merge Fields
and then choose the desired field. To use username merge fields, you must
have marked the checkbox to include a username on the Login page
properties screen. To include a name, you must have defined names in the
Password builder list. Note that when merging passwords into the body of
the email, the password will not be encrypted so that the respondents can
see their passwords.
12 When you have the email formatted as desired, click the Send

button
to send the emails. They will be sent according to the throttle rate defined in
the web form properties. Respondents will receive the email in the format
that is set up in their email client. They can either click or copy the link to
your web form that is included in the body of your email message. If you
chose to embed the password into the URL, encrypted passwords will be
embedded as emails are generated and sent (behind the scenes).
Tip: Respondents with a text only email client may not see actual
hyperlinks in their email messages. When sending a hyperlink
through email, it is recommended that you include instructions that
285

Remark Web Survey User’s Guide

explain to respondents that they can copy the link and paste it into
a web browser if the hyperlink does not automatically take them to
the web form.

10.9 Printing Grid Data
Remark Web Survey allows you to print grid data on any Windows-supported
printer.

To print the grid data
1

Locate the toolbar on the Data Viewer.

2

Click the Print button

3

Click the Name down arrow and then click the desired printer.

4

Select the desired print options, including the page range, orientation and
number of copies to print. You may also click the Properties button to
configure your printer‟s options.

5

Click the OK button to print the grid.

to display the Print window.

10.10 Sorting Grid Columns
Columns in the Data Viewer grid can be sorted according to the values in a
specific field. Data can be sorted in ascending or descending order. For
example, you can sort your data by student ID number.

To sort data
1

Locate the toolbar on the Data Viewer.

2

Click the Sort Ascending
Click the Sort Descending
order.

button to sort the data in ascending order.
button to sort the data in descending

The entire data set will be sorted according to your selection.
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10.11 Auto Column Width
Remark Web Survey has an Auto Column Width feature to allow you to resize
the Data Viewer grid columns based on the amount of data within the grid.
Using the Auto Column Width feature will force the Data Viewer grid to expand
and contract based on how much text is in each column. This feature will take
field names into account when sizing the columns (but not page names).

To use auto column width
1

Select the Auto Column Width option from the Home ribbon
.

The columns will automatically resize to fit the data. If you need to resize the
columns further, drag the borders with the mouse. You may also double click
the grid border between column headers to expand a single column.

10.12 Saving Grid Data
Once data is downloaded, you can save the data in the grid to dozens of
different file formats.
Note: When working with data in Remark Web Survey, we
recommend that you use the Remark file format (RMK). Save data
to other formats when exporting for analysis.
When saving data, you have the option of using Save Data or Save Data As.
The Save Data option can be used to save a data set for the first time or to
overwrite the current data set. The Save Data As option allows you to save the
current data set with new parameters (e.g., new file name, different directory,
different file type, etc.). The Data Viewer grid has its own toolbar that contains
options for both Save and Save As.
The following table lists the different save file formats, their extensions and a
brief description:
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File Format

Extension

Description

Remark

RMK

Remark proprietary format

SQL Server 20002005

MDF

Microsoft SQL Server format

Oracle 7.4 and
later

*.*

Oracle format

Access 2007

ACCDB

Microsoft Access 2007 format (only
available if the Access 2007 database
engine is installed)

Access

MDB

Microsoft Access 2000-2003 format

Access 95-97

MDB

Microsoft Access 95-97 format

Access 2.0

MDB

Microsoft Access 2.0 format

Access 1.0

MDB

Microsoft Access 1.0 format

Excel 2007

XLSX

Microsoft Excel 2007 format (only available
if the Access 2007 database engine is
installed)

Excel 97-2003

XLS

Microsoft Excel 97-2003 format

Excel 95

XLS

Microsoft Excel 95 format

Excel 4.0

XLS

Microsoft Excel 4.0 format

Excel 3.0

XLS

Microsoft Excel 3.0 format

Questionmark

QSF

Perception Questionmark format (save
only)

SPSS

SAV

SPSS format

Survey Pro

SRV

Survey Pro standard format (Apian
Software)

Survey Pro STL

STL

Survey Pro STL format (Apian Software)

ASCII [commas]

ASC

Comma delimited ASCII

ASCII [tabs]

ASC

Tab delimited ASCII

Spreadsheet
[commas]

TXT

Comma delimited ASCII with quotes
around non-numeric data
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File Format

Extension

Description

Spreadsheet
[tabs]

TXT

Tab delimited ASCII with quotes around
non-numeric data

Survey System

DAT

The Survey System format (Creative
Research Systems)

dBase 5.0

DBF

dBase 5.0 format

dBase IV

DBF

dBase IV format

dBase III

DBF

dBase III format

Paradox 5.X

DB

Paradox 5.X format; existing files may only
be overwritten (there are no append
options)

Paradox 4.X

DB

Paradox 4.X format; existing files may only
be overwritten (there are no append
options)

Paradox 3.X

DB

Paradox 3.X format; existing files may only
be overwritten (there are no append
options)

Lotus WK3

WK3

Lotus Works 3 format; existing files may
only be overwritten (there are no append
options)

Lotus WK1

WK1

Lotus Works 1 format

Lotus WJ3

WJ3

Lotus WJ3 format (Japanese)

Lotus WJ2

WJ2

Lotus WJ2 format (Japanese)

Lotus 1-2-3

WKS

Lotus 1-2-3 format

LXR Test

MRG

LXR Test format

Report

RPT

Fixed format ASCII, cell text padded or
truncated to specified record length

Data Interchange
Format

DIF

Standard format using file header and data
section

XML

XML

Extensible Markup Language format

HTML

HTM

Hypertext Markup Language

ODBC

*.*

Open Database Connectivity
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File Format

Extension

Description

Custom

ASC, TXT

Custom Text format

Database Update

XLS, XLSX,
MDB,
ACCDB

Updates an existing database with new
data (e.g., adds missing information,
overwrites existing information).

ODBC Database
Update

*.*

Updates an existing ODBC database with
new data (e.g., adds missing information,
overwrites existing information).

To save grid data
1

Locate the toolbar on the Data Viewer:
.

2

There are three options when saving data:
Click the Save Data
button if saving the data set for the first time
or to overwrite the data.
Click the Save Data As
parameters.

button to save the data with new

Click the Save All Data
button to save all open data grids
corresponding to the active web form to a single data file. This feature is
useful if you have saved data files individually and now want to combine
them into one overall (complete) data file.
Note: When using the Save All Data files, the individual data grids
are closed and only the
combined data file will
be visible in the Data
Viewer. If you made
changes to your
individual data files and
want them to be saved,
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save the individual files first. Then use the Save All Data option.
(Note: A warning regarding this information appears when you click
Save All Data.)
If saving for the first time or using Save Data As or Save All Data, the Save
Data window opens, allowing you to choose a file name, a file type, the
directory in which you would like the file
saved and Advanced saving options, if
applicable.
3

Select the desired directory location
using the Look in drop down box.

4

Enter a name in the box titled File
name.

5

Select the desired output format in
the box titled Save as type.

6

If saving to a database type that
supports internal table names, enter
a table name in the box titled Table
name.
Note: Each database format has different table name limitations.
Refer to your database documentation for information on table
name limitations.

7

When exporting, you can save the column headers for certain formats by
selecting the Save headers checkbox. The Save headers checkbox will
only display when appropriate. The SPSS file format also allows you to save
decimal places. Enter a value in the Decimal places box (you may save up
to 4 decimal places).

10.12.1 Advanced Saving Options
When saving data to database formats, you have the option of setting advanced
parameters. The advanced window shows you each question and pertinent
information about its field type. You can then choose options about the question
that you want included in your database. This feature can be useful if you are
saving to a database format that has specific requirements. You can temporarily
override the .rwsx form settings by using the advanced parameters.
Note: Setting parameters in the advanced saving window does not
make any changes to the web survey file (.rwsx).
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The following advanced features are available (depending upon the selected
format):
Option

Description

Include

Mark the Include checkbox to include the question in the
database.

Name

Use the Name column to enter a new field name to be used in
the exported database, if desired. Changing the field name in
this window will not affect the field name in the web form file.

Data Type

Use the Data Type column to change the data type for this
question.

Size

Use the Size column to specify a field size for the data for this
question. Do not specify a size that is smaller than what is in
your data.

To use advanced saving options
1

Locate the toolbar on the Data Viewer:
.

2

Click the Save Data
click the Save Data As

button if saving the data set for the first time,
button to save the data with new parameters

or click the Save All Data
button to save all open data grids
corresponding to the active web form to one file.
If saving for the first time, using Save Data As or using Save All Data, the
Save Data window opens, allowing you to choose a file name, a file type, the
directory in which you would like the file saved and Advanced saving options.
3

Select the desired directory location using the Look in drop down box.

4

Enter a name in the box titled File name.

5

Select the desired database format in the box titled Save as type.
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6

If saving to a database type that supports internal table names, enter a
table name in the box titled Table name.
Note: Each database format has different table name limitations.
Refer to your database documentation for information on table
name limitations.

7

Click the Advanced button.

8

[OPTIONAL] If you have previously
saved a definition file for this data set,
click the Load button to locate the
appropriate INI file containing your
settings. Otherwise, continue to Step 9
to build a new data file.

9

Make any desired changes in the
Include, Name, Data Type or Size
columns, as described previously.

10 [OPTIONAL] If desired, click the Save

button to save the settings to a
configuration file (.ini file). You can
then open this configuration file for future save operations with this same
web form. This feature can save time when saving future data sets.
11 Click the OK button to save the changes.
12 In the Save Data window, click the OK button to save the data.

10.12.2 Custom Format
The Custom format allows you to create a customized text file. This format is
useful for exporting data into a database that has very specific requirements.
The format can also be used to break apart rows of data into multiple rows. For
example, if you are processing an attendance sheet where each student should
be one data record, you can use the Custom format to separate the data into
individual records.
Note: When saving to an existing custom data file, fields are not
matched by field name; instead they are matched by position in the
data file. Ensure that the data you are saving matches the existing
custom data file before appending new records.
The following table summarizes the screens and options that are found in the
Custom data format wizard and the corresponding descriptions of each option:
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Custom
Wizard
Screen

Option

Description

Step 1:
Configuration
File

Configuration File

Use the Browse… button to
locate a previously saved
configuration file that you created
when using the Custom Wizard
(optional).

Step 2: File
Type and
Start Row

File Type

Delimited: Fields are separated by
a delimiter, such as a comma or
tab.
Fixed Width: Fields are aligned at
fixed character spaces.

Automatically format
questions that allow
multiple responses

Mark the Automatically format
questions that allow multiple
responses checkbox to
automatically set formatting for
questions that allow more than
one answer choice (e.g., (1,5,12)
becomes 1 5 12).

Start export at row

Enter the row number that you
want to use as the first record in
the exported data file. All rows
from this point forward will be
included in the data file. Enter 0
to include field names as the first
record.

Note: Step 3 will change based on whether you select Fixed Width or
Delimited for the File Type in Step 2. Items that correspond with each type
are noted.
Step 3:
Column
Delimiter and
Text Qualifier
(Delimited
Fields Only)

Column Delimiter

Select the item to be used to
separate the columns in the data
file: Comma, Tab, Semi-colon,
Space, Other.
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Custom
Wizard
Screen

Option

Description

Text Qualifier

Select an item to be used to
qualify text. Textual responses
will be encapsulated within this
setting. Options include: None,
double quote (“), single quote („).

Field Size

The maximum number of
characters allowed in the field.

Start Position

The position, in characters, where
the field will begin. For example,
if your field sizes are 25, the first
field will start at position 1 and
the second field will start at
position 26 (25 characters later).

Pad With

Enter the character to use to pad
the field (typically a space
character).

Pad On

Select whether to pad the field on
the left or right of the text that
resides in the field.

Step 4:
Record
Delimiter

Record Delimiter

Sets the delimiter to be used to
separate records: Carriage
Return/Line Feed, Carriage
Return, Line Feed, Other.

Step 5: Field
Exclusion and
Record Breaks

Exclude

Mark the Exclude checkbox to
exclude the field listed from the
data file.

Break After

Mark the Breaks After checkbox
to start a new record in the data
file after this field.

Step 3: Field
Width and
Padding (Fixed
Width Fields
Only)
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Custom
Wizard
Screen

Option

Description

Every Record

Mark the Every Record checkbox
to include the field in every record
of the data file (e.g., repeat the
field for each record).

To use the Custom format
1

Locate the toolbar on the Data Viewer:
.

2

Click the Save Data
click the Save Data As

button if saving the data set for the first time,
button to save the data with new parameters

or click the Save All Data
button to save all open data grids
corresponding to the active web form to one file.
If saving for the first time, using Save Data As or using Save All Data, the
Save Data window opens, allowing you to choose a file name, a file type, the
directory in which you would like the file saved.
3

Select the desired directory location using the Look in drop down box.

4

Enter a name in the box titled File name.

5

Select the Custom (*.ASC, *.TXT) format in the box titled Save as type.

6

Click the OK button. The Text Export Wizard opens.

7

If you have used the Custom Wizard format previously and have a saved
configuration file that applies to this data set, click the Browse… button to
locate the configuration file. Otherwise, click the Next>> button to begin
creating a new configuration file.

8

Select the options you wish to use to customize your data set. Each option is
described in the previous table. Use the Next>> button to navigate from
screen to screen.
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9

When finished, click the OK button.

10 When the Save Text Export

Configuration window appears, click
the Yes button to save your settings to
a file that you can use later when saving
data. If you do not wish to save this
configuration file, click the No button. If
you are not saving the configuration
file, the data file will be saved when you
click the No button. Continue with the
next steps if you are saving the
configuration file.
11 [OPTIONAL] If saving the configuration file, in the Save Text Export

Configuration As box, select a location in which to save the configuration
file in the Save in box.
12 [OPTIONAL] Enter a name for the file in the File name box.
13 [OPTIONAL] Leave the Save as type box set to Text Export

Configuration Files (*.tec).
14 [OPTIONAL] Click the Save button to save the file and create the data file.

10.12.3 Database Update Format
The database update format allows you to update an existing database based
on the data in the Remark Web Survey data grid (Access or Excel). The data are
matched to the existing database by the field names and a mapping process.
When saving to this format, you map the fields in the Remark Web Survey data
to the fields in the existing database. You also choose a question to be the
record identifier. If data exists in the database it will be updated with what is in
Remark Web Survey. For example, if you were conducting a course evaluation
and asked for the students‟ ID number in the web survey, you could use the
student ID as the record ID to update an external database using the Database
Update format. During the save process, Remark Web Survey attempts to find
the Student ID in the database and then updates the data fields associated with
that student. If the student ID is not found, you have the option of adding the
record to the external database.
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To use the Database Update format
1

Locate the toolbar on the Data Viewer:
.

2

Click the Save Data
click the Save Data As

button if saving the data set for the first time,
button to save the data with new parameters

or the Save All Data
button to save all open data grids corresponding
to the active template to a single data file.
If saving for the first time or using Save Data As, the Save Data window
opens, allowing you to choose a file name, a file type, the directory in which you
would like the file saved and Advanced saving options if applicable.
3

Select the desired directory location using the Look in drop down box.

4

Select a file to update, which will fill the File name box.

5

Select the Database Update (*.ACCDB, *.MDB, *. XLSX, *.XLS) format
in the box titled Save as type.

6

Click the OK button. A wizard will open to walk you through the next few
steps.

7

If you have used the Database Update format previously and have a saved
configuration file that applies to this data set, click the Load… button to
locate the configuration file. Otherwise, go on to step 8.
Note: You will be prompted to save a configuration file with your
settings after saving the data.

8

In the Update Options area, select the
number of records contained in each row
of the data set (e.g., if multiple
respondents‟ answers are on a single
form, you would have more than one
record per data row). If each record in
the data set corresponds to one
respondent‟s submission, use 1 for the
value.
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9

In the Update Options area, mark the Add database records for
missing record identifiers checkbox if you would like to create new
records in the database when an identifier
is not found.

10 In the Field Mapping area, map the

fields from Remark Web Survey to the
fields in the external database. The
database fields are listed in the first
column and the Remark Web Survey fields
(questions) are listed in the second
column, called Grid Column. Use the
down arrow in the Grid Column section
to choose the appropriate field to map to
the corresponding database field.
11 Choose a field or fields to use as an

identifier by marking the appropriate
checkbox next to the field name. The identifier fields are used to match data
from Remark Web Survey to the external database. If a match is not found,
the data will not be added to the database and you will receive a message.
You may select more than one field to use as the identifier, in which case
the data from all identifier fields must be a match for the record to be
updated in the external database.
12 Click the OK button to save the data.

Note: The ODBC Database Update format works just as described
above, but you can save to a database using an ODBC connection.

10.13 Opening Data
Remark Web Survey can open data saved in dozens of different file formats.
The following table lists the different file formats Remark Web Survey can open,
their extensions and a brief description:
File Format

Extension

Description

Remark

RMK

Remark proprietary format

Web Survey

RWD

Remark Web Survey proprietary format
(the data that resides on the web server)
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File Format

Extension

Description

SQL Server 20002005

MDF

Microsoft SQL Server format

Oracle 7.4 & later

*.*

Oracle format

Access 2007

ACCDB

Microsoft Access 2007 format (only
available if the Access 2007 database
engine is installed)

Access

MDB

Microsoft Access 2000-2003 format

Access 95-97

MDB

Microsoft Access 95-97 format

Access 2.0

MDB

Microsoft Access 2.0 format

Access 1.0

MDB

Microsoft Access 1.0 format

Excel 2007

XLSX

Microsoft Excel 2007 format (only available
if the Access 2007 database engine is
installed)

Excel 97-2003

XLS

Microsoft Excel 97-2003 format

Excel 95

XLS

Microsoft Excel 95 format

Excel 4.0

XLS

Microsoft Excel 4.0 format

Excel 3.0

XLS

Microsoft Excel 3.0 format

SPSS

SAV

SPSS format

Survey Pro

SRV

Survey Pro standard format (Apian
Software)

ASCII [commas]

ASC

Comma delimited ASCII

ASCII [tabs]

ASC

Tab delimited ASCII

Spreadsheet
[commas]

TXT

Comma delimited ASCII with quotes
around non-numeric data

Spreadsheet
[tabs]

TXT

Tab delimited ASCII with quotes around
non-numeric data

dBase 5.0

DBF

dBase 5.0 format

dBase IV

DBF

dBase IV format

dBase III

DBF

dBase III format
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File Format

Extension

Description

Paradox 5.X

DB

Paradox 5.X format

Paradox 4.X

DB

Paradox 4.X format

Paradox 3.X

DB

Paradox 3.X format

Lotus WK4

WK4

Lotus Works 4 format (open only)

Lotus WK3

WK3

Lotus Works 3 format

Lotus WK1

WK1

Lotus Works 1 format

Lotus WJ3

WJ3

Lotus WJ3 format (Japanese)

Lotus WJ2

WJ2

Lotus WJ2 format (Japanese)

Lotus 1-2-3

WKS

Lotus 1-2-3 format

LXR Test

MRG

LXR Test format

Report

RPT

Fixed format ASCII, cell text padded or
truncated to specified record length

Data Interchange
Format

DIF

Standard format using file header and data
section

XML

XML

Extensible Markup Language format

HTML

HTM

Hypertext Markup Language

ODBC

*.*

Open Database Connectivity

Custom

ASC, TXT

Custom Text format

To open grid data
1

Open a Remark Web Survey web form.

2

Open the Data Viewer by either clicking the Data Viewer button in the
status bar
or by selecting the Home tab in the Ribbon and then clicking
Data Viewer.

3

Locate the toolbar in the Data Viewer:
.
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4

Click the Open Data button

.

Note: When the Data Viewer is displayed, clicking the Application
button and then selecting Open will display the Open Data
window.
5

Select the folder containing the data
file from the Look in drop-down list.

6

Select a file from the list.

7

If opening a database type that
supports internal table names, click a
table name in the box titled Table
name.
Caution: When opening a
database file type, Remark
Web Survey attempts to
match grid column headers
to the database's field
names. If any column
headers can't be matched, an error occurs. Grid column headers do
not need to appear in the same order as the database fields.

8

Click the OK button to open the data file.
Note: The data contained in the file must correspond to the current
web form or an error may occur.
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Chapter 11

11.1 Overview
There are two types of data analysis tools within Remark Web Survey: Remark
Quick Stats® and Remark Live Stats™. Remark Quick Stats is used when
downloading data in Remark Web Survey and Remark Live Stats is used to view
results on the web.

11.2 Remark Quick Stats
Remark Quick Stats is an analysis package that ships with the Remark Web
Survey software. Remark Quick Stats allows you to tabulate surveys and grade
tests right in the software. An overview of Remark Quick Stats is provided here;
a complete user‟s guide is installed in PDF format with the software and can be
found by clicking Start|Programs|Remark Web Survey
5|Documentation|Remark Quick Stats User’s Guide.
Depending on the report selected, Remark Quick Stats can include the following
statistics:
Survey Statistics include:
For each item Remark Quick Stats calculates: Mean, Variance, Standard
Deviation, Standard Error, Min, Max, Range, Median, Skewness,
Kurtosis, T-Value, Percentiles, Confidence Intervals
For each answer choice Remark Quick Stats calculates: Frequencies,
Percentages, Valid Percent
A Response Report displays the responses for any particular question on
one, easy to read, report (primarily used for open ended questions)
Crosstabs
A Group Report displaying means for question groupings
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Test Statistics include:
A Grade Wizard steps you through the process of setting up an answer
key, grade scale, questions points, learning objectives, benchmark
scores and other grading information for your test
For each item Remark Quick Stats calculates: Mean, Variance, Standard
Deviation, Standard Error, Min, Max, Range, Median, Skewness,
Kurtosis, T-Value, Percentiles, Confidence Intervals, P-values, Point
Biserial Correlation
For each answer choice Remark Quick Stats calculates: Frequencies,
Percentages, Point Biserial
For each student Remark Quick Stats calculates: Total score, Raw score,
Grade, Dev. IQ, Number correct, incorrect, unanswered
For the test Remark Quick Stats calculates: Number of graded tests and
items, Max, Min, Median, Range, Percentile scores, Mean, Variance,
Standard Deviation, Confidence Intervals (1,5,95,99%), KR 20, KR21,
Coefficient (Cronbach) Alpha
A Grade Report displays each student‟s results on the test
A Group Report displays grades for specific subsets of your data
A variety of graph types are also included (all of which can be copied and
printed):
Pie
Bar
Horizontal Bar
Line
Area
Point
Polar
Fast Line
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11.2.1 Tabulating Surveys with Remark Quick Stats
Surveys can be tabulated in two ways: Easy Survey and the Survey Wizard.
Easy Survey uses the parameters specified in the form‟s question and answer
properties, such as which questions to tabulate, and then launches Remark
Quick Stats. The Survey Wizard allows you to customize the tabulation process
by choosing which questions to include, assigning numeric values to answer
items, assigning benchmarks, adding question text, specifying question groups
and more.

To access survey tabulation features
1

Open a web form and then download data or open an existing data file.

2

Select the Tools tab in the Ribbon, and then click Easy Survey

Survey Wizard

or

.

Remark Quick Stats will open allowing you to configure and display reports.
Please consult the Remark Quick Stats user‟s guide PDF for further details about
using Remark Quick Stats.
Tip: The Survey Wizard and Easy Survey screens and functions are
described in complete detail in the Remark Quick Stats User‟s Guide
PDF file. Access the file by clicking Start|Programs|Remark Web
Survey 5|Documentation.

11.2.2 Grading Tests with Remark Quick Stats
Tests can be graded in two ways: Easy Grade and the Grade Wizard. Easy
Grade uses the parameters specified in the web form, such as which questions
to grade and their point values. In addition, Easy Grade uses the first row of
data in the Data Viewer grid as the answer key; therefore, you should insert
your answer key before your test data if you plan to use Easy Grade. The Grade
Wizard allows you to customize the grading process by choosing which
questions to include, assigning point values, setting benchmarks, adding
question text, specifying learning objectives and more.
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To access test grading features
1

Open a web form and then download data or open an existing data file.

2

Select the Tools tab from the Ribbon, and then click Easy Grade

Grade Wizard

or

.

Remark Quick Stats will open allowing you to configure and display reports.
Please consult the Remark Quick Stats user‟s guide PDF for further details about
using Remark Quick Stats.
Tip: The Grade Wizard and Easy Grade screens and functions are
described in complete detail in the Remark Quick Stats User‟s Guide
PDF file. Access the file by clicking Start|Programs|Remark Web
Survey 5|Documentation.

11.3 Using Remark Live Stats
The Remark Live Stats™ feature is accessed via the Remark Web Survey
Control Panel (rwsad5.pl script). It provides an item analysis, response report
and duration report using any data collected for a particular web form. It is a
great way to get a quick feel for the data for a live form without having to
download the entire data set. User accounts can be set up to only access the
Remark Live Stats information.

To use Remark Live Stats
1

Access the Remark Web Survey Control Panel in a web browser (rwsad5.pl
script).

2

Enter your username and password and then click the Login button.
Note: The default user is Administrator. The person who installed
the scripts onto the web server may or may not have set up
individual user accounts. You will need to ask this person for your
login information.

3

Click the Data & Stats tab.

4

Select a web form from the Form drop-down list.
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5

Click the button for Live Stats.
The Item Analysis report
appears by default. However, you
may choose a Response Report
or a Duration Report:
Item Analysis Report: The
Item Analysis report displays
each option button, checkbox
or drop-down box question on
the web form and then calculates the number of detected and missing
responses, along with the responses chosen and their corresponding
percents. A bar chart of the frequency also displays. If a response has
not yet been chosen, it will not display on the report.
Response Report: The Response Report displays information from all
textbox/text area questions on the web forms. These are typically openended questions.
Duration Report: The Duration Report shows the number of responses
that fall into a specific time (duration) interval (e.g., how many
responses took 0-30 minutes to complete the web form). Select an
interval, in minutes, in the Interval box. The total number of detected
responses displays along with the average time per response for the
form. A breakdown of each interval based upon the interval length
defined and the number of those responses that fell into that interval is
displayed, along with a bar chart of the frequency (based on the number
that fell into the selected interval compared to the number of
responses).

6

To run a report, choose the option
button of the desired report and
then click the Generate Report
button.

7

If desired, print the report by
clicking the Print Version button
at the bottom of the window. A
printer friendly report will appear.
Use the browser‟s Print button to
print the report. After printing,
click the OK button to return to
the Remark Live Stats page.
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Note: This
page is best
printed when
the option
within your
web browser
is set to "Print
background
colors and
images." The
setting name
may vary
depending on
your web
browser.
8

When finished viewing the report, click the Control Panel button to return
to the previous screen.

11.3.1 Configuring Remark Live Stats Only Accounts
Remark Web Survey 5 allows you to set up three different Server component
account types:
Administrator: This account has full control over the Server component
(can change settings, publish forms, download data, view logs, view
statistics, edit users, etc.). The default account is the Administrator
account and there can only be one account named Administrator. You
may, however, create different user accounts with administrator
privileges.
Standard User: This account only allows the user to view Remark Live
Stats and web form data when they login to the Remark Web Survey
Control Panel (rwsad5.pl script). In addition you can choose whether to
allow automatic form publishing and data downloading from the Designer
component for this account. If automatic form publishing and data
downloading are enabled, they can use these features for any web form
within the Designer component. In addition, if automatic data
downloading is enabled, the user will be able to download data from the
Control Panel.
Restricted User: This account only allows the user to view Remark Live
Stats information and web form data for specific forms when they login
to the Remark Web Survey Control Panel (rwsad5.pl script). In addition
you can choose whether to allow automatic form publishing and data
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downloading from the Designer component for the specified forms for
this account. If automatic form publishing is enabled, the user can
publish any web form from the Designer component. If automatic data
downloading is enabled, the user can only download data from the
Designer component for the forms specified in their user account. The
user can also download data from the Control Panel for the specified
forms. Note that after a new web form is published, an administrator will
need to add that web form to the list of available web forms for the
restricted user.
Standard and Restricted User accounts only have access to data and Remark
Live Stats; they will not see the other options available in the Remark Web
Survey Control Panel.

To set up a Remark Live Stats user
1

Login to the Remark Web Survey Control Panel (rwsad5.pl) using an account
with administrator privileges through a web browser.

2

Select the Users tab.

3

Click the Add User button.

4

Enter the desired Username and
Password for the new user.
Determine the level of permissions
you want to grant to the user (see
description above): Standard User
or Restricted User.

5

If setting up a Standard or
Restricted User, choose the web
forms to which the user will have
access.

6

Once you choose a permission level, determine whether you want the user
to be able to automatically publish web forms and download data from the
Designer component. Mark the Enable automatic publishing from the
Designer component and/or Enable automatic data downloading from
the Designer component checkboxes to grant these permissions. If users
do not have these permissions, they will have to rely on another user to
publish web forms and download data.
Note: Restricted Users can publish any web form, but will only be
able to download data for those forms that are specified.
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7

Click the OK button to add the new user.

When the new user logs in, s/he will have access to the Remark Live Stats area
and data for all forms if the user is a Standard user or for only the specific
forms allowed if the user is a Restricted user.
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Chapter 12

You can customize Remark Web Survey so that the software runs in the most
efficient manner appropriate to your tasks. Use the Program Options to
customize default program settings. By choosing the default settings that you
most commonly use, you can save a considerable amount of time when creating
new web forms. Remember that the changes you make in the program options
affect every new web form that you create from that moment forward. Changes
made in the program options will not affect previously created web forms.
Tip: The following sections describe how to set global options in the
software. The features mentioned are described in detail in previous
chapters in this user‟s guide. If you need more detail about a
particular feature, please go to the proper location in this user‟s
guide by consulting the index.

12.1 Accessing the Program Options
You can modify settings that control how the software looks and operates. Use
the program options to perform software customization. Once you input
program settings, they will remain in place until you change them again.

To display the program options
1

Select the Application Button

and then click Web Survey Options.

The Remark Web Survey Options window appears. Continue to the next sections
to learn more about the available options.
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12.2 Server Details
The Server details
area of the General
section allows you to
set up details related to
interaction with the
Remark Web Survey
Server component. We
strongly recommend
that you enter this
information in the
software upon
installation. Much of the
information is needed
in the web forms that
you create. By placing
it in the program
options, your resulting
web forms will automatically have the correct server information. The following
options can be set:
Note: When configuring email options, you can use an SMTP server
or the Sendmail protocol to send emails from Remark Web Survey.
Emails can be used for three different functions in Remark Web
Survey: 1) the built-in email client that is used to send web form
invitations and reminders (SMTP only), 2) submission notification
emails that are sent every time a web form is completed by a
respondent, or 3) pause page reminders to resume a web form
once it is started and stopped. The email server is set up and
configured outside of Remark Web Survey. Once you have
determined the type of email method to use and verified it is
working, you can configure Remark Web Survey to use it.
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Option

Function

Admin script URL

The URL (path) to the Remark Web Survey
Administration Script (rwsad5.pl). This script is
posted on the web server and is necessary for web
form administration. Your webmaster or whoever
installed the scripts should be able to provide this
URL to you. This entry must be a fully qualified URL
(e.g., http://www.example.com/cgi-bin/rwsad5.pl).

Data script URL

The URL (path) to the Remark Web Survey Data
Script (rws5.pl). This script is posted on the web
server and is necessary for web form data
collection. Your webmaster or whoever installed the
scripts should be able to provide this URL to you.
This entry must be a fully qualified URL (e.g.,
http://www.example.com/cgi-bin/rws5.pl).

Email settings

Click the Email settings link to enter email
settings for form submission notifications and use
of the built-in email client.

Admin email address

Enter the web form administrator email address
(e.g., webmaster@example.com).

Use SMTP method to
transport email
messages (Web
Server tab)

The Web Server settings are used to set up email
transfers that originate on the web server, such as
pause page reminder emails and respondent
submission emails. Mark the Use SMTP method to
transport email messages option to use Simple
Mail Transport Protocol for sending notification
emails. You need to have a valid SMTP server set
up outside of Remark Web Survey.

SMTP Server

Enter the SMTP server address (e.g.,
mail.example.com).

SMTP Port

Enter the SMTP port that email transfers use
(typically port 25).

Username

If using authentication, enter a valid username.

Password

If using authentication, enter a valid password for
the username specified.
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Option

Function

Use Sendmail method
to transfer email
messages (Web
Server tab)

Mark the Use Sendmail method to transfer
email messages option to use Sendmail for
sending notification emails. Sendmail is an open
source email transfer agent. You need to have
Sendmail set up outside of Remark Web Survey.

Server path

Enter the Sendmail Server path (e.g.,
/usr/sbin/sendmail)

Use SMTP method to
transport email
messages (Local
Machine tab)

The Local Machine settings are used to set up email
transfers that originate from the Remark Web
Survey software, such as email invitations and
reminders. Sendmail is not available for Local
Machine settings. Mark the Use SMTP method to
transport email messages option to use Simple
Mail Transport Protocol (SMTP) for sending
notification emails. You need to have a valid SMTP
server set up outside of Remark Web Survey. Once
the SMTP server is functioning, the SMTP server
information can be set up ahead of time in the
Remark Web Survey program options by your
website administrator (see Section 2.3.7 for further
details). Please note that your website
administrator can advise you on what email method
you are to use and the proper settings.

SMTP Server

Enter the SMTP server address (e.g.,
mail.example.com).

SMTP Port

Enter the SMTP port that email transfers use
(typically port 25).

Enable a secured
(SSL) connection

Mark the Enable a secured (SSL) connection
checkbox to transmit information over Secure
Sockets Layer (SSL), which provides security and
data integrity for communications.
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Option

Function

Use the default
credentials of the
currently logged in
user

If you need to use authentication, you can enter
credentials or use those of the user. Mark the Use
the default credentials of the currently logged
in user checkbox to utilize the user‟s credentials
(e.g., the person logged in when sending the emails
from the Remark Web Survey Designer
component). Otherwise, continue below to enter
specific credentials.

Username

If using authentication, enter a valid Username.

Password

If using authentication, enter a valid Password for
the username specified.

Throttle Rate

The Throttle rate adds a delay while sending
emails. The default setting is 500ms, meaning that
one email will be sent every 500 ms (in other
words, two emails are sent per second). Throttling
emails keeps the SMTP server from being
overloaded when sending large numbers of emails.

12.3 HTML Display
The HTML display area
allows you to set the
default Display language
to use for web forms. The
language selected here is
specified in the HTML
source code of web forms
that you create (this is
called a “lang” tag in
HTML). Please note that
whether the language‟s
characters display
correctly is dependent
upon the character set
specified on the
respondents‟ computer.
The Backup fonts area allows you to select fonts to use on the web form when
respondents do not have the fonts you have selected for a web form on their
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computer. For example, you may apply rich text formatting to questions on
your web form in a font that a respondent does not have on his or her
computer. If the software cannot find the font you specified, it will use the
Backup fonts specified in the software‟s program options. By default, Verdana
and Arial are selected; these fonts are common to most systems. Using two or
more fonts provides a greater likelihood of finding a font that the respondent
has on his or her system, which gives you some level of control over the look
and feel of your web form.

12.4 New Web Form Window
Remark Web Survey displays a New Web Form window by default each time you
begin a new web form. On the New Web Form window, you can specify a web
form name, special pages
desired, etc. (see Section
3.1.4.a for complete
details for using the New
Web Form window).
Essentially it creates the
shell of the web form so
that you can then start
adding other elements.
The New Web Form
window can be hidden if
desired. If you wish to
show the New Web Form
window (it is shown by
default), place a
checkmark in the Show
new web form window
when creating a new web form checkbox. If you do not use this feature,
when beginning new web forms, the web form will be created with one standard
page and a web form complete page by default.
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12.5 Welcome Window
Remark Web Survey
displays a welcome
window by default each
time you start the
software. On the welcome
window you will find
shortcuts to begin a new
web form, open an existing
web form or convert a
Remark Office OMR or
Remark Classic OMR
template file. The welcome
window can be hidden if
desired. If you wish to
show the welcome window
(it is shown by default),
place a checkmark in the
Show the welcome window at startup checkbox.

12.6 Analyze Database Connections
Remark Web Survey has a
Database Link feature
that allows you to connect
a question to an external
database in order to
lookup and add
information from the
database to a web form‟s
data (see Section 5.7.5
for a description of
Database Linking). In
order to use this feature,
the connection to the
database must remain
constant. If the database
is moved or renamed
after the connection is
established, the feature will no longer work. Remark Web Survey can
automatically check the database connection for any web form using this
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feature each time the web form is opened. If the connection is broken, a
warning message will appear and you will have the option to update the
connection. If you wish to have the database connections analyzed (it is on by
default), place a checkmark in the Analyze database connections when
opening web forms checkbox.

12.7 Application Font
The Application Font
button allows you to
select the type of font
used throughout Remark
Web Survey Designer
component windows. Click
the Application Font
button to choose a font
for your program. This
font does not affect the
actual web forms that are
produced. Please note
that selecting very large
sized fonts may adversely
affect how text is
displayed in Remark Web
Survey windows.

12.8 Defaults
The Defaults area allows
you to specify default
error message text for the
various errors that can
occur when respondents
are taking a web form. By
defining default text in
the program options, all
web forms that you create
will utilize the text. You
may still customize an
individual web form by
selecting an element and
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customizing its properties or by customizing a Server Error page within a web
form. The following error messages can be customized:
Error Message

Purpose

Invalid Password
message

Customize the error message that appears when a
respondent uses an invalid password to access a
web form.

Password expired
message

Customize the error message that appears when a
respondent uses an expired password to access a
web form.

Web form unavailable
message

Customize the error message that appears when a
respondent attempts to access a web form outside
of its availability window.

Maximum submission
capacity message

Customize the error message that appears when a
respondent attempts to access a web form that has
already reached the maximum number of
submissions.

File access error
message

Customize the error message that appears when a
respondent tries to access web form pages to which
they do not have access.

Required response
missing message

Customize the error message that appears when a
respondent fails to answer a question set with the
required attribute.

Maximum response
length exceeded
message

Customize the error message that appears when a
respondent enters too much text in a text area.

Maximum responses
exceeded message

Customize the error message that appears when a
respondent chooses more responses than are
allowed for a checkbox or drop-down box question.

Input pattern error

Customize the error message that appears when a
respondent enters text into a textbox that does not
match the input pattern you have applied to the
textbox.
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Under Defaults, there are also three miscellaneous items you can customize:
Error Message

Purpose

Maximum grid cell
length

Use the Maximum grid cell length property to
enter the maximum amount of characters that can
be contained in a single grid cell. This setting
applies to the Data Viewer grid, branching grid,
advanced notification grid, login page password
criteria builder and the grids used to store answer
information when setting up questions. The default
value is 3000. Increase the value if you encounter
difficulties storing text or executing complex
question branching.

Missing value

Use the Missing value property to change the
number associated with missing values in your
data. Missing values are any data that are not valid
(e.g., data exists in a cell that does not match what
was defined for the question, or when a question is
unanswered). The missing value is used in Remark
Quick Stats and when exporting data to the SPSS
file format. The default missing value is -1, which
you can adjust to a different number if desired.

Treat each answer
choice as a separate
question

Use the Treat each answer choice as a separate
question to turn on this property by default
whenever you create a checkbox or drop-down list
style question that allows multiple responses. Each
answer choice will be treated as a unique question,
occupying its own cell in the Data Viewer grid. You
may still change the property on the fly for certain
questions as you build web forms.
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12.9 Spell Checker
The Spell Checker area allows you to specify spell checker options. Under
Dictionary Files, you
can select the location
where your dictionaries
are found. There is a
Main dictionary and a
Custom dictionary.
Remark Web Survey will
first use the main
dictionary and then as
you add custom spellings
it will create the custom
dictionary. When
performing spell check
functions, the software
will use both dictionaries
unless you mark the
checkbox titled Suggest
from main dictionary
only. In the Language box, you can select the language for your spell check
dictionary files.
The When correcting spelling area allows you to select the options you wish
the spell checker to use: Ignore words in UPPERCASE, Ignore words that
contain numbers, Ignore internet and file addresses, Check compound
words, Check hyphenated words, Suggest from main dictionary only.
These options can help you customize how the spell checker reviews your web
forms.
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12.10 Resources
The Resources area
allows you to reach
Gravic, Inc. online and
view information about
the software. The
following options are
available:

Option

Description

Go to Gravic Online

Click the Go Online button to go to the Gravic
website, where you can find product and support
information.

Edit Remark Web
Survey Authentication

Click the Edit Authentication button to enter a new
serial number and authentication code for the
software. This feature is typically used to upgrade to
a new version of the software or unlock features. It
should only be used when directed by Gravic
personnel.

Copyrights

Click the Copyrights button to view copyright and
legal information pertaining to Remark Web Survey.

About Remark Web
Survey

Click the About button to view information about
Remark Web Survey. This area also shows the
current version level of the software.
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12.11 Documentation
The Documentation area
gives you quick access to
Remark Web Survey‟s
supporting documentation.
You can access the Remark
Web Survey User‟s Guide,
Remark Quick Stats User‟s
Guide and the Remark Web
Survey Tutorial by clicking the
appropriate link in this
window. Please note that
documentation is in Adobe
Acrobat format; you need the
Acrobat Reader in order to
use these links.
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Remark Office OMR/Remark Classic
OMR
Appendix A

A.1 Overview
Remark Web Survey can be used as a standalone web form tool or in
conjunction with Remark Office OMR and Remark Classic OMR. Remark Office
OMR and Remark Classic OMR are forms processing applications that collect
information from paper-based forms and convert it to data that can be analyzed
within the software or exported to another program for analysis. These software
packages use template files that define the areas of a paper form to be
recognized and the output to be generated. The software then uses a scanner to
collect the data from the forms. Once the data are collected, Remark Office
OMR and Remark Classic OMR are used to tabulate or grade the data, or the
data can be saved in a format compatible with virtually any spreadsheet,
database or survey design package for further analysis.
The following chapter is designed to help Remark Office OMR and Remark
Classic OMR users understand how Remark Web Survey can interact with their
existing Remark Office OMR or Remark Classic OMR software. Topics that are
covered include:
Converting Remark Office OMR and Remark Classic OMR templates into
Remark Web Survey documents.
Combining data collected in Remark Web Survey with data collected in
Remark Office OMR and Remark Classic OMR for analysis.
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A.2 Converting Templates
Existing Remark Office OMR (version 4.0 and higher) and Remark Classic OMR
(version 2.0 and higher) templates can be converted into web-based forms for
publishing on a web server. The benefit of converting a template to a web form
is that you can collect the same data as on the paper-based form over the web.
In other words, you will have two different mechanisms for collecting data.
When a template is converted, the original template can still be used in Remark
Office OMR or Remark Classic OMR. The data collected in Remark Web Survey
can then be combined with data gathered in Remark Office OMR or Remark
Classic OMR for complete analysis. It is recommended that the templates you
convert make use of question text. This question text will become the question
text in your web form. If there is no question text in the template that is
converted, you will need to enter it in the web form.

To convert a template
1

Open Remark Web Survey.

2

Select the Application Button
Open window.

and then click Convert to display the

Note: When you first start
Remark Web Survey, if you
are showing the Welcome
dialog, you may choose the
option on this screen for
Convert a Remark Office
or Classic Template to
open a template file.
3

Select a Remark Office OMR
(.omr) or Remark Classic OMR
(.rco) template and then click the
Open button.

The template will be displayed as a
Remark Web Survey web form. You may now modify the look of the web form
as desired. If you plan to combine web data with data collected from the paper
forms, do not change the structure of the form (e.g., add questions, remove
questions, reorder questions, etc.). If the web form does not match the paper
form‟s template, the data will not match.
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When converting templates, the web form name will be based on the template
name. The Admin and Data Script URLs will be entered on the web form
properties based on those entries in the Remark Web Survey program options
(see Section 12.2 for more information).
Caution: When modifying converted templates, adding or deleting
questions will result in importing data problems when combining the
data with data from Remark Office OMR or Remark Classic OMR.
The data collected in Remark Web Survey will not match the data
that were collected in the other packages. If you plan to use the
data from both programs together, only make basic formatting
modifications to the converted web survey.

A.3 Data Collection and Analysis
The Remark Web Survey Server component is used to collect data from web
forms. For forms that have been converted from Remark Office OMR or Remark
Classic OMR templates, the data collected in Remark Web Survey can be
combined with data that was collected in the paper scanning Remark software.
Remark Quick Stats is essentially the same in all of the Remark products.
Therefore, you can combine data collected from the various Remark products in
any one of those products. For the purposes of this user‟s guide, we will outline
how to analyze the data in Remark Web Survey.
Once the data has been collected in both programs, you may open it in Remark
Web Survey. We recommend saving data to the Remark (.rmk) format in both
programs to ensure compatibility. Note that this format saves the data in the
order in which the fields (questions) are defined. If you remove, add or
rearrange questions, it will cause incompatibility in your data sets.

To tabulate or grade data from both programs
1

If not already running, start Remark Web Survey.

2

Open the desired web form.

3

Switch to the Data Viewer and open the data file that was saved in Remark
Web Survey. Or, download the data from your web server.

4

Open the data file(s) that was saved previously in Remark Office OMR or
Remark Classic OMR. A second grid will open. (Note: You may also choose
to append it to the existing data grid when prompted.)
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5

Select the Tools tab in the Ribbon and then choose the desired operation:

Survey Wizard

or Grade Wizard

.

6

In the Analyze Data window, mark the checkboxes for any open data grids
that you wish to include in the operation.

7

Click the OK button to run the report.

Depending on the analysis function chosen, either the Grade or Survey Wizard
will appear. See the Remark Quick Stats User‟s Guide PDF file, located in
Start|Programs|Remark Web Survey 4|Documentation, for further information
about using Remark Quick Stats.

A.3.1 Special Note for “Other” Textboxes
If you have questions in your Remark Office OMR or Remark Classic OMR
template that have textboxes appended to them, you will need to append a
textbox in Remark Web Survey to accommodate the textbox. When using the
appended textbox, be sure to mark the checkbox for Treat appended item’s
answer as a separate item with field name. For example, if you have a
multiple choice style question with the last option as “other” you may have a
textbox where they can enter information in as their “other” response. In
Remark Office OMR and Remark Classic OMR, you would have two separate
regions/fields. Remark Web Survey, on the other hand, offers the appended
textbox to handle this situation. With the appended textbox, you have the
choice of outputting the write-in responses in the same data cell as the
multiple-choice responses or treating them as separate items. If you do not use
the option to treat the appended textbox as a separate item, it is considered
one field and your data would not match that which was collected in Remark
Office OMR or Remark Classic OMR. If using this type of field setup, use the
appended textbox for the “other” textbox in Remark Web Survey but remember
to mark Treat appended item’s answer as a separate item with field
name. This method will give you two fields in Remark Web Survey to match the
two fields you have defined in Remark Office OMR or Remark Classic OMR.
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Appendix B

Remark Web Survey is rich with features; some of which you will use often and
some that you may only need on occasion. The purpose of this extended
glossary is to provide you with a listing of the software‟s features, a short
description of the feature and the section where you can find more detailed
information about the feature. For a complete listing of terms, please see the
Glossary or Index.
Feature

Explanation

Admin Control
Panel Access

The Admin Control Panel Access bar allows you to login to
the administration script (rwsad5.pl) and publish web forms
and download data. Details are found in Section 3.1.8.

Answer Piping

Answer piping allows you to “pipe” information from one
question‟s answer to the text of another question, answer
or a label on a web form. For example, if you have a
question on the web form that asks for the respondent‟s
name, you can then “pipe” that name into another
question. (*Professional Version Only*) Details are found in
Sections 5.7.5.a and 5.7.6.b.

329

Remark Web Survey User’s Guide

Feature

Explanation

Auto
Downloading
Data

Auto data download allows you to download data from the
web server without the assistance of a website
administrator. You must first enable auto data downloads in
the Remark Web Survey Control Panel (auto data
downloads are enabled by default) and have a login that
allows for data downloading. Then, you may open the web
form in the Remark Web Survey designer, click the
Application Button and then select Download. You will
be prompted to login to your web server and then the data
will automatically be downloaded into the Data Viewer. If
you use the Download button in the Admin Control
Panel Access bar, you may choose to download all records
or only download the new records since the last download.
Data can then be exported or analyzed by Remark Quick
Stats. Details are found in Section 10.2.

Auto Form
Publishing

Auto form publishing allows you to publish forms and
related files (e.g., images) to your web server without the
assistance of a website administrator. You must first enable
auto publishing in the Remark Web Survey Control Panel,
(auto publishing is enabled by default) and setup a user
account that allows automatic form publishing. You must
also enter the address of the administration script
(rwsad5.pl) in the program options (click the Application
Button and then choose Web Survey Options). As each
web form is created, you will then be able to select the
Application Button and click Publish to send the form to
the web server. Each web form will have its own folder on
the web server, which will contain the form pages, images,
data file, log file, configuration files, password information
(if applicable) and each respondent‟s tracking ID. You can
specify the location to store these individual folders in the
Remark Web Survey Control Panel. Details are found in
Section 9.5.
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Feature

Explanation

Branching/Skip
Patterns

Branching, also known as skip patterns, allows you to set
up a form that jumps to various pages based on a how a
question or questions are answered. For example,
responding with a Yes to a question can send the
respondent to one page. Responding with a No to the same
question, can send the respondent to a different page. This
type of setup makes it easier for the respondent to fill out a
web form because he or she does not have to answer
unnecessary questions. (*Professional Version Only*)
Details in Chapter 8.

Button Text
and Images

The buttons used on a page- Submit, Reset, Back and
Pause- can be customized. You can either enter your own
text for the button, or you can import an image to use as
the button. If you want to use an image, you must first
create the image outside of Remark Web Survey. You can
also customize the positioning (right, center or left) and
order of these buttons on the page. Details are found in
Section 5.9.

Database Link

Database Link allows you to link a question on a web form
to an external database. You can then lookup one piece of
information and report another piece of information from
the same database. For example, suppose you have a
database of student names and ID numbers. The students
could enter their student ID numbers on the web form they
submit. You could then lookup that student ID number and
output the student‟s name (in addition to the ID number)
when the data are downloaded. Details are found in Section
5.7.5.

Data Export

Once form submissions are downloaded from the web
server, the resulting data file can be exported to over 30
file formats, including Access, Excel, SPSS, ASCII and
others. This feature allows you to analyze your data in most
popular analysis packages. Details are found in Section
10.12.
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Feature

Explanation

Email Client

Remark Web Survey includes an email client that you can
use to send web form invitations and reminders. It includes
the ability to create and save email templates and the
ability to import email addresses (*Professional Version
Only). The email client can work in conjunction with the
Respondent ID feature, which tracks who has completed a
web form (password-protected web forms only). Details are
found in Section 9.8.

Email
Notifications

Email notification allows you to specify an email address or
addresses to which each form submission will be sent. The
email recipient will receive one email per respondent, which
will contain that respondent‟s answers to the questions on
the web form. You can also set up advanced options that
allow you to send emails to the respondent or emails to
specific email addresses based on how questions are
answered. (*Professional Version Only) Details are found in
Section 4.2.

Form
Scheduling

You can schedule a window when a web form will be active.
Respondents will only be able to access the web form
during this timeframe. (*Professional Version Only*) Details
are found in Section 4.2.2.

Headers and
Footers

You can add headers and footers to web form pages. Define
the header and footer once, and then apply them to the
desired web pages. Details are found in Section 5.10.
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LinksProviding Web
Form Access

For each web form that you create in Remark Web
Survey, you must provide your respondents with a link that
they can use to access the form. You may wish to send
respondents an email message with the link, or perhaps
you will put the link on your website for them to click. In
either case, the link you provide has a very specific format:
http://www.example.com/CGI
directory/rws5.pl?FORM=formname. In this example, CGI
directory is the name of your CGI directory (e.g., cgi-bin,
scripts), rws5.pl is the name of the Remark Web Survey
data collection script and formname is the name of the web
form to be submitted (the form name can be found on the
top node of your web form in Remark Web Survey). If you
use the auto publish feature to move web forms to your
website, this link will be provided to you automatically upon
successful publishing. You can copy any web form‟s link by
selecting Copy Web Form URL to clipboard in the Web
Form Details area of the Remark Web Survey designer.
This action will place the link on the Windows clipboard,
which you may then paste to an email, web page, web
browser, etc. Details are found in Sections 9.5 and 9.8.

LinksEmbedded
Passwords

In addition to the information above, you may also embed
the password to access the web form in the link you provide
to a respondent. In this case, use the same syntax as
above, but add the following to the end of the link:
&PWD=password, where “password” is the respondent‟s
password. Example: http://www.example.com/cgibin/rws5.pl?FORM=formname&PWD=password. When the
respondent clicks the link, they will be automatically logged
into the web form. Passwords can also be embedded into
the link that is generated by the built-in email client.
Details are found in Section 9.8.

Mobile Device
Support

Allows you to preview a web form on a mobile device so
that you can ensure browser compatibility. The mobile
device must have a web browser capable of viewing and
submitting web forms. Details are found in Section 3.1.2
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Feature
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Multimedia

Multimedia includes video and audio files that you wish
respondents to view while submitting your web form. For
example, suppose you are conducting a survey about a
possible new product and want to show respondents a
potential advertisement for the new product and then ask
questions about it. Respondents can play the video clip (or
audio clip) directly from the web form. Supported
multimedia formats include: Moving Picture Experts Group
(mpeg, mpg, mp3), Audio Video Interleave (avi),
QuickTime (mov), Waveform (wav), Real Audio (ram, rm).
(*Professional Version Only*) Details are found in Section
5.6

Password
Protection

Password protection allows you to require respondents to
enter a valid password before they can access your web
form. Applying passwords to a web form is accomplished
using a Login page. Passwords can be manually entered
into Remark Web Survey or they can be imported from a
database. You may also use the password list to include
names and email addresses to track which respondents
have submitted a web form. Missing or detected
respondents can be sent to the built-in email client or
exported to a file, which you could then use to contact
those respondents via email (e.g., to send reminders or
thank you notices). Details are found in Section 4.9.

Popup Info
Page

A Popup Info page type can be used to display nonsubmission information. You can link to the popup info page
to show respondents more information about the web
form‟s questions. Details are found in Section 4.5.

Progress Bars

A progress bar shows respondents how much progress they
have made on a multi-page web form and how much is still
left to fill out. (*Professional Version Only*) Details are
found in Section 4.2.
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Query
Parameters

Using Query Parameters allows you to pass hidden
information into a web form. When using hidden textbox
questions, you can associate a Query Parameter with the
textbox. When the URL to the web form is sent out, the
Query Parameter is appended to the URL. When the web
form is submitted, the value for the Query Parameter is
sent down to the data file. (*Professional Version Only*)
Details are found in Section 5.7.5.b.

Random
Answer Order

Random answer order allows you to present the answers to
questions in random order. Each respondent will see the
answers in a different order (on a per question basis). This
feature is especially useful when administering tests to cut
down on the possibility of cheating. (*Professional Version
Only*) Details are found in Section 5.7.6.

Random Page
Order

Random page order allows you to present a multi-page web
form in random order. Each respondent will see the pages
in a different order. This feature is especially useful when
administering tests to cut down on the possibility of
cheating. (*Professional Version Only*) Details are found in
Section 8.3.

Reloading
Pages

Remark Web Survey allows you to use forward and back
options on web forms. You can add a Back button to multipage forms so that respondents can go back and change
their responses. Respondents should not use the browser‟s
back button, as this can cause page sequencing errors. It is
a good practice to place Back buttons on multi-page forms
and advise respondents to use the web form‟s back and
next buttons instead of the browser‟s buttons. Details are
found in Section 5.9.
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Response
Confirmation
Pages

A Response Confirmation page displays all of the
respondent‟s answers to each question on the web form.
The Response Confirmation page appears as the last page
before the respondent submits the web form. It allows the
respondent to review his or her responses and then go back
and make changes if necessary. You can either provide a
Back button on the Response Confirmation page or
respondents can click a link next to any question on the
Response Confirmation page to navigate back to questions
they wish to change. (*Professional Version Only*) Details
are found in Section 4.6.

Respondent
Capping

You can cap the number of respondents who can access a
web form. Once the maximum is reached, respondents will
no longer be able to access the web form. (*Professional
Version Only*) Details are found in Section 4.2.2.

Respondent
Detection

Respondent detection works in conjunction with password
protection. When you enter a list of valid passwords for a
password-protected web form, you can optionally designate
a name field and an email field. When you download the
data for the form, Remark Web Survey can search through
the passwords that were submitted to see who has and has
not filled out the web form. The names and email addresses
of those who have either filled out or not filled out the web
form can then be sent to the built-in email client or
exported to a file. You can then use this file to send email
notifications to those who have not yet submitted the form
reminding them to do so. Details are found in Section 10.8.

Rich Text
Formatting

Rich text formatting gives you greater flexibility in how text
is formatted. Rich text allows you to format the font
attributes of individual characters as opposed to an entire
label or question‟s text. It also allows you to add bullets to
your text. Details are found in Section 7.5.
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Section 508
Compliance

Remark Web Survey can produce Section 508 compliant
forms. Section 508 of the Rehabilitation Act of 1973, as
amended (29 U.S.C. 794d), requires that when Federal
agencies develop, procure, maintain or use electronic and
information technology, Federal employees with disabilities
must have access to and use of information and data that is
comparable to the access and use by Federal employees
who are not individuals with disabilities, unless an undue
burden would be imposed on the agency. Section 508 also
requires that individuals with disabilities who are members
of the public seeking information or services from a Federal
agency have access to and use of information and data that
is comparable to that provided to the public who are not
individuals with disabilities, unless an undue burden would
be imposed on the agency. When creating web forms,
Section 508 requires the use of ALT tags for images in
order to be compliant. Remark Web Survey supports this
ALT tag usage through a property called Alternate Text,
which you will find any time you insert an image. The use of
style sheets also assists with the creation of Section 508
compliant forms.

Sendmail
Support

Remark Web Survey supports the Sendmail email method,
which is an open source mail transfer agent. Details are
found in Section 2.4.9.

Session Pause
Pages

Session Pause pages allow respondents to pause a web
form and then resume where they left off. Session Pause
pages are especially useful for long web forms where
respondents may not have enough time in one sitting to
complete the web form. When respondents pause the form,
they can either receive an email message with a link back
to the web form or bookmark the page in a web browser.
They can then continue the form submission at a later date.
When they resume their submission, they will be at the
same place they left off, with all previous information
already filled in. You can also set the length of time allowed
to complete the web form. Note that you should advise
respondents of this timeframe when you set up your
Session Pause page. (*Professional Version Only*) Details
are found in Section 4.7.
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Session
Timeouts

Session timeouts can be used in conjunction with passwordprotected web forms. If you enable session timeouts, the
respondent is logged out of the web form if idle for a
specified amount of time. Session timeouts coincide with
page submissions. If a session timeout is set to 10 minutes,
the respondent has 10 minutes in between page
submissions to complete the page. For example, if the
respondent submits page 1 of the web form and 10 minutes
go by without submitting page 2, the respondent‟s web
form will timeout. They will be required to login again, at
which time their previously submitted data will be reloaded.
The purpose of a session timeout is to minimize the
possibility of an unauthorized person gaining access to the
web form. (*Professional Version Only*) Details are found
in Section 4.2.2.

SMTP
Authentication

Remark Web Survey supports the MD5, login and plain
forms of SMTP authentication. Details are found in Section
4.2.9.

Spell Checker

The Spell Checker allows you to check an entire web form
for spelling errors. Dictionaries can be customized by
language and you can add your own words to the existing
dictionary. Details are found in Section 6.5.

Styles

Styles allow you to add aesthetic formatting to your web
forms. You can create styles any way you wish. When you
create a style, you set font types, sizes and colors,
background colors, line colors, question table formatting
and more. You can set these attributes for all of the
elements on your forms (text labels, questions, answers,
etc.). Using styles helps you match web forms to the
general format of your website. By saving styles, you can
quickly apply commonly used formatting to web forms.
Details are found in Chapter 7.
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Web Form
Complete
Pages

A Web Form Complete page is a success URL or “thank you”
page that appears when a respondent submits a web form.
It lets respondents know that they have finished filling out
the web form. The web form complete page can contain
images and labels. You can also add hyperlinks to redirect
the respondent to another page on your website or a new
website. Details are found in Section 4.8.
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alternate text

The text that is displayed when the mouse is placed
over an image on a website and while the image is
loading.

CGI

Common Gateway Interface. CGI scripts are programs
that perform pre-defined functions. CGI scripts are
usually run by submitting a form on a website.

checkbox

A small square that can be selected or cleared. When
selected it contains a check mark (). Checkbox style
questions accept more than one response.

click

To quickly press and release the left mouse button.

clipboard

The place where information that is cut or copied is
stored. This intermediary holds the information so that
it can be pasted (multiple times if desired) until you
place something new on the clipboard (by cutting or
copying something else). Other programs also share
the clipboard. Data can be copied from a document of
one program and pasted to a document of another as
long as the data are compatible.

convert template

The process of transforming a Remark Office OMR or
Remark Classic OMR template into a Remark Web
Survey document.

copy

To place the selected text or item on the Windows
clipboard so that you can paste it into another location.

design window

The window that is used to make modifications to a
web form.

double click

To quickly click the left mouse button twice in
succession.

drag

To move the mouse while holding down the left mouse
button.

drop-down box

A box in which pre-defined words can be selected.
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elements

The components of a web form, which include text,
images, lines, questions and answers.

extension

The letters following the period in a file name.

highlighted

Highlighted indicates that an item has been selected.

HTML

Hypertext Markup Language. A language used to
create web documents from plain text.

Internet

A collection of computer networks that connects
computers together from around the world in order to
share and provide information.

intranet

A local collection of computer networks that is used to
provide information to a single group of users.

line

A horizontal bar used to divide areas on a form.

multiple response

A question for which more than one response is
allowed.

node

A form element shown in the tree view (lines, labels,
images, questions and answers are all represented by
nodes in the tree view when designing web forms).

option button

A small circle that can be selected or cleared. When
selected it contains a dot. Option button style
questions allow only one response.

paste

To insert the contents of the clipboard into the current
cursor location.

path

A file location in a directory tree.

post

To place a document or documents on a web server to
be viewed on the Internet or an intranet.

publish

To transform a document into an HTML document
which can then be posted to a website.

RAM

Random Access Memory. RAM is necessary for a
computer to run efficiently.

right click

To click the right mouse button one time to display a
drop-down menu.

script

Program code that is executed by submitting a web
form on a website.

single response

A question for which only one response is allowed.
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source code

The text in an HTML document that creates the web
page.

status bar

The horizontal bar located at the bottom of a window
that displays pertinent information about application
processes or the currently selected item.

template

A file that contains information regarding a form that
allows Remark Office OMR or Remark Classic OMR to
correctly process the form.

text area

A multi-line box that allows the entry of text.

textbox

A single-line box that allows the entry of text.

title bar

The horizontal bar located at the top of a window that
displays the window title.

upload

To place one or more files on a web server.

web browser

A program that is used to connect to the Internet and
view web pages. Browsers open connections to web
servers, collect information and then close the
connection.

web server

A computer that maintains web information and
returns requested files or documents to web browsers.
You must have access to a web server to use Remark
Web Survey. The web server holds the Remark Web
Survey scripts, which are used for web form
administration.

window

The rectangular portion of the screen in which a
program executes. Normal window control allows you
to move, resize, minimize and maximize windows.

WWW

World Wide Web. The place where Internet sites are
located.

URL

Uniform Resource Locator. A URL is the Internet
address used to locate information on the World Wide
Web. It normally starts with a protocol name, followed
by the name of a website, and a suffix that identifies
the type of organization it is (e.g.,
http://nameofyourwebsome.com).
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